
CoolSign Network Manager v5.1 
User’s Guide

HVS-ID-UG-CS-NM-5.1 
Issue 01



.  
Edition Notices

This edition notice provides important information regarding the documentation for version 
5.1 of the CoolSign Network Manager product. Later releases are intended to be 
backwards-compatible, but may introduce new functionality not addressed in this content. 
Likewise, other product documentation may describe functionality not addressed here that 
will become available in later releases. Please consult with Haivision Systems, Inc. or its 
authorized representatives to ensure compatibility.

Copyright

© 2006-2015 Haivision. All rights reserved.

Title: CoolSign Network Manager User’s Guide  
Document Number: HVS-ID-UG-CS-NM 
Version Number: 5.1

This publication and the product it describes contain proprietary and confidential informa-
tion. No part of this document may be copied, photocopied, reproduced, translated or 
reduced to any electronic or machine-readable format without prior written permission of 
Haivision. If this document is distributed with software that includes an end-user agree-
ment, this document and the software described in it, are furnished under license and may 
be used or copied only in accordance with the terms of that license. Except as permitted by 
any such license, no part of this guide may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, 
without the prior written permission of Haivision Systems Inc. Please note that the content 
in this guide is protected under copyright law even if it is not distributed with software that 
includes an end-user license agreement.

IMPORTANT
Network Manager is designed to access/play content which may have copyright restrictions. 
Acquiring licensing and re-distribution rights to restricted content shall be undertaken by the 
purchaser and not by Haivision. Please be sure to obtain any permission required from the 
copyright owner.

Licenses

This product is licensed under the MPEG-4 visual patent portfolio license for the personal 
and non-commercial use of a consumer for (i) encoding video in compliance with the 
MPEG-4 visual standard (“MPEG-4 video”) and/or (ii) decoding MPEG-4 video that was 
encoded by a consumer engaged in a personal and non-commercial activity and/or was 
obtained from a video provider licensed by MPEG LA to provide MPEG-4 video. No 
license is granted or shall be implied for any other use. Additional information including 
that relating to promotional, internal, and commercial uses and licensing may be obtained 
from MPEG LA, LLC. See http://www.mpegla.com.
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.  
Patents

CoolSign is covered by U.S. Patent Number 7,136,906 “System for Electronically Distrib-
uting, Displaying and Controlling the Play Scheduling of Advertising and Other Commu-
nicative Media” and Patent Number 7,228,341 “Method and System for Electronically 
Distributing, Displaying and Controlling Advertising and Other Communicative Media.” 
CoolSign may also be covered by one or more pending United States patent applications.

Trademarks

The Havision logo, Havision, Furnace, Hai1000, Makito, Barracuda, HaiPLAY, Piranha, 
InStream, Stingray, Torpedo, Kraken, Viper, Madra, and KulaByte are trademarks of 
Haivision. CoolSign is a registered trademark licensed to Haivision Systems, Inc. All other 
brand or product names identified in this document are trademarks or registered trademarks 
of their respective companies or organizations. 

Adobe, Flash Media Server, Flash, Flash Lite and Shockwave are trademarks of Adobe 
Systems Incorporated in the United States, other countries, or both. Apple, iPhone, iPad, 
iPod Touch are trademarks of Apple Incorporated in the United States, other countries, or 
both. 

All other brand or product names identified in this document are trademarks or registered 
trademarks of their respective companies or organizations. 

Disclaimer

The information contained in this document is subject to change without notice. Haivision 
assumes no responsibility for any damages arising from the use of this document, including 
but not limited to, lost revenue, lost data, claims by third parties, or other damages.

If you have comments or suggestions, please contact:

Haivision 
ATTN: Information Development 
4445 Garand 
Montréal, Québec, H4R 2H9 Canada

Telephone: 1-514-334-5445

Email: info@haivision.com

While every effort has been made to provide accurate and timely information regarding this 
product and its use, Haivision Systems Inc. shall not be liable for errors or omissions 
contained herein or for incidental or consequential damages in connection with the 
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.  
furnishing, performance, or use of this material. The latest information available can be 
acquired from our web portal at:  http://www.haivision.com/download-center/ 

NOTE
A login is required to access the Haivision Download-Center.
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About This Book
Welcome to the CoolSign™ 5.1 User’s Guide. This document describes how to configure 
and manage the Havision Network Manager software.
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.  
About Haivision™
About Haivision™

Haivision is a global leader in delivering advanced video networking, digital signage, and 
IP video distribution solutions. Haivision offers complete end-to-end technology for video, 
graphics, and metadata to help customers build, manage and distribute their media content 
to users throughout an organization or across the Internet. Haivision has specific expertise 
in the enterprise, education, medical/healthcare, and federal/military markets. 

Haivision acquired the assets of CS Software Holdings, LLC, including the CoolSign 
product technology, in November, 2010. This acquisition brought together Haivision's IP 
video streaming capabilities and CoolSign's feature-rich signage solution, with its sophis-
ticated technology to control, schedule, distribute, display, and monitor digital media.

Haivision is based in Montreal and Chicago, with technical centers in Beaverton, Oregon; 
Austin, Texas; and Hamburg, Germany. 

Audience

This user’s guide is focused towards an end-user, such as a content creator or network 
system administrator, who has a basic knowledge of telecommunications equipment, and 
IP/LAN networking concepts and terminology. 

Related Topics

Reliability of Information on page 13

Reliability of Information

The information contained in this user’s guide has been carefully checked and is believed 
to be entirely reliable. However, as Haivision improves the reliability, function, and design 
of its products, the possibility exists that this user’s guide may not remain current.

If you require updated information, or any other Havision product information, contact:

Haivision 
4445 Garand 
Montréal, Québec, H4R 2H9 Canada

Telephone: 1-514-334-5445 
Email: info@haivision.com

Or visit our website at: https://www.haivision.com.

Related Topics

Obtaining Documentation on page 14
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.  
Obtaining Documentation
Obtaining Documentation

You can download product documentation through the Havision Download Center at 
http://www.haivision.com/download-center/.

NOTE
A login is required to access the Haivision Download Center.

• CoolSign Network Server Quick Start Guide
• CoolSign Stand-Alone Player Quick Start Guide
• CoolSign Personal Demo Server Quick Start Guide
• CoolSign Player Quick Start Guide
• CoolSign Installation Manual
• CoolSign Network Manager User’s Guide
• CoolSign Content Creator User’s Guide
• CoolSign Release Notes
• CoolSign Datasheet (contains hardware specifications)
•
•

Related Topics

Service Support on page 14
Obtaining Documentation on page 14

Service Support

For more information regarding service programs, training courses, or for assistance with 
your support requirements; contact Havision Technical Support using our Support Portal 
at: https://www.haivision.com/support/.

Related Topics

Reliability of Information on page 13
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.  
Document Conventions
Document Conventions

The following conventions are used throughout this document.

Typographic Conventions and Elements

Italics Used for the introduction of new terminology or for words being 
used in a different context, and for placeholder or variable text.

bold Used for strong emphasis.

Monospaced Used for code examples, command names, options, responses, 
error messages, and to indicate text that you enter.

Button Indicates a button or some object that you click.

> In addition to a math symbol, it is used to indicate a submenu. For 
instance, File > New where you would select the New option from 
the File menu.

... Indicates that text is being omitted for brevity.

Admonition Elements

The following admonition elements are used to advise and counsel that special actions 
should be taken.

TIP
Indicates highlights, suggestions, or helpful hints. 

NOTE
Indicates a note containing special instructions or information that 
may apply only in special cases.
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IMPORTANT
Indicates an emphasized note. It provides information that you 
should be particularly aware of in order to complete a task and 
that should not be disregarded. IMPORTANT is typically used to 
prevent loss of data.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, 
may result in damage to data or equipment, or minor to moderate 
injury. It may also be used to alert against unsafe practices.
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1. Introduction

This user’s guide describes the features and functionality available in the CoolSign 
Network Manager software used for managing a CoolSign® digital media network.

Topics Discussed

Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
What’s New . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

Overview

CoolSign is a powerful suite of software applications that enable you to control, distribute, 
and display digital content in public spaces. You can use CoolSign to control a single 
display in your company lobby, or to manage a deployment of hundreds or thousands of 
digital signs across numerous sites at geographically diverse locations. 

What’s New

The latest release of the CoolSign Network Manager software (version 5.1) includes new 
features that can help you manage the challenges posed by large and diverse digital signage 
networks:

• Support for Microsoft Windows Server® 2012 R2

• Support for Microsoft Windows® 8.1
• Support for display control over a serial port using hexadecimal commands

NOTE
As of version 5.1, CoolSign no longer supports Microsoft Windows® XP or Microsoft 
Windows Server® 2003. 



2. Using CoolSign Network Manager

CoolSign Network Manager (CNM) provides easy, customizable access to all the informa-
tion and data you need to manage a digital signage network. With CNM, you can import 
content, create channels and playlists, tune players, and monitor network transfers and 
status.

Topics Discussed

About Manager Pages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
Working with Items in the Data Grid  . . . . . . . . . . . . . . . . . . . . . .  22

Selecting Items in the Data Grid . . . . . . . . . . . . . . . . . . . . . . .  22
Performing Context-Sensitive Actions on an Item . . . . . . . . . . . . .  22

Changing the Data Grid Layout . . . . . . . . . . . . . . . . . . . . . . . . . .  23
Sorting Columns  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23
Grouping Columns  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23
Resizing Columns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24
Changing which Columns are Visible  . . . . . . . . . . . . . . . . . . .  25
Reordering Columns  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Managing Views . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27
Importing and Exporting Views . . . . . . . . . . . . . . . . . . . . . . .  27
Resetting and Restoring Default Views . . . . . . . . . . . . . . . . . . .  28

Searching for Items  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28
Using the QuickBar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

About the QuickSet Panel  . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Using QuickSets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Using QuickSearches . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31
Organizing QuickSets and QuickSearches . . . . . . . . . . . . . . . . .  32

Printing and Exporting Data  . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

CNM is organized into different screens that allow you to view and manage different areas 
of your network:

Home Manager—Provides a high-level dashboard where you can quickly see 
the overall status and health of your network. Important alerts that may require 
your attention or management are displayed in the Alerts grid on the Home 

               Manager, along with a log of all major actions that have been performed with 
               CNM.
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Content Manager—Lets you view the entire repository of content available on 
your CoolSign network. You can import new content, modify numerous content 
properties that affect how the content is played back, retrieve the play history for 

content, and 
               more.

Audio Manager—Similar to the Content Manager, but specialized for managing 
audio content only. You can import MP3 files directly into the Audio Manager 
without needing to run them through Content Wizard.

Data Table Manager—CoolSign uses data tables to provide dynamic data to 
content and scheduling expressions. With the Data Table Manager, you can 
manually create new data tables or input data into existing data tables.

Data Watcher Manager—(Optional) You can install the Data Watcher to 
provide a bridge between a data source and a CoolSign network. The Data Watcher 
can read data from various types of data sources, parse that data, and then import 

it into a CoolSign data table.

Channel Manager—Channels are the master schedules that you tune your 
players to. You can use the Channel Manager to create new channels and schedule 
content or playlists into channels. Once a channel is created, you can then use the 

Player Manager to tune players to your channel so they start playing the scheduled content.

Playlist Manager—Playlists are specialized sub-schedules that you can insert 
into channels. Playlists provide extensive flexibility in how you create your sched-
ules. You can use the Playlist Manager to create, edit, or delete playlists and to 

schedule content within the playlists.

Player Manager—Players are the nodes in your network that play back content 
on a display device. The Player Manager provides functionality to manage your 
players, including the ability to remotely configure players, divide a player into 

multiple regions, tune a player to a channel, and review the play history for a player.

Network Manager—Lets you see every node of your network and manage 
technical properties like software versions, bandwidth control, and configuration. 
Primarily intended for technical users, the Network Manager enables you to trou-

bleshoot network issues and take corrective action when necessary.

To navigate to a manager screen:

• Click the manager’s icon in the navigation bar on the left side of the screen, or
• Choose VIEWS > GO TO > and select the appropriate manager.

About Manager Pages

With the exception of the Home Manager, each of the manager screens share similar 
layouts and functionality. While the type of item that each screen manages differs, each 
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manager provides the ability to customize how your data is displayed and to organize the 
data in ways that make sense to your specific use of the digital media network.

The quickbar gives 
you tools to quickly 
filter or view sets of 
items in the data grid. 

The data grid shows the 
available items for each 
specific manager. 

 You can right-click an 
item to display a con-
text-sensitive popup 
menu of actions for 
the item. 

Change the view of 
the data grid from 
this combobox. 

The status bar tells you how 
many items you have 
selected in the data grid plus 
other useful information.

Provides instant and 
advanced search 
capabilities.

About the Data Grid

The most important element in each manager is the data grid. The data grid displays the 
items available in your network in a grid-like table of rows and columns. The data grid is a 
powerful tool that can be used to organize and customize what information you see about 
each of the objects in your network.

About Local Storage and Silverlight

CoolSign Network Manager uses Microsoft Silverlight, which, by default, is limited to 1 
MB of local storage space. This space is used to cache thumbnail images, such as those 
displayed on the “Now Playing” screen. Silverlight should be configured to enable the use 
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of local storage. To verify this, launch the Microsoft Silverlight Configuration utility and 
make sure “Enable application storage” is set to ON:

The first time you select the Player or Network Manager, you will see a Local Storage Error 
message:

A Silverlight warning will also appear prompting you to allocate an additional 100 MB of 
space for use by Silverlight:

You should make sure that there is enough available space on your startup disk, and then 
click Yes in the Silverlight dialog. 
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Working with Items in the Data Grid

Each manager page’s data grid lists all the available items of the specific type managed by 
that page. You can use the data grid to select one or more items and then perform context-
sensitive actions on them. 

Selecting Items in the Data Grid

Before you can perform an action on an item, you must have selected one or more items in 
the data grid. The selected items in a data grid are highlighted in blue.

To select an item:

Do one of the following:

• Click the item in the data grid.
• Use the up and down arrow keys to change the current selected item.

To select multiple items:

Do one of the following:

• Hold the Shift key down and click an unselected item to select all the items between 
the currently selected item and the clicked item.

• Hold the Ctrl key down and click an unselected item to add that item to the set of 
currently selected items.

To deselect an item:

Do one of the following:

• Hold the Shift key down and click a selected item to unselect all the items between the 
last clicked item and the clicked item.

• Hold the Ctrl key down and click a selected item to remove that item from the set of 
currently selected items.

Performing Context-Sensitive Actions on an Item

Once you have selected an item in the data grid, you can perform context-sensitive actions 
on it. The type of item determines the actions you can perform.

The following describes specific actions you can perform in each manager page.

To perform an action on an item, do one of the following:

• Choose an action from the ACTIONS menu.
• Right-click the item or selected items and choose an action from the Actions popup 

menu.
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Changing the Data Grid Layout

CoolSign provides a number of predefined views for each manager page. Each view defines 
which columns are displayed, how the grid is sorted, and any groupings that are applied to 
the grid.

For more information on managing views and adding new views, see “Managing Views” 
on page 27.

To change the data grid view:

Use the view combobox to select the view you wish to use.

Sorting Columns

You can sort the items visible in the data grid by one or more columns. You can add addi-
tional columns to the current sort by holding down the shift key while sorting.

TIP
The currently sorted columns are saved with the view’s state. 

To sort a column:

To toggle between ascending and descending sort order, click on the header of the column 
you want to sort by. 

Grouping Columns

NOTE
The CNM Player and Network managers no longer use this feature. You must use the 
Quick or Advanced Search functions for grouping (see “Searching for Items” on page 28 
for details).
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You can group the items visible in the data grid by one or more columns. 

This content 
grid is grouped 
by the format 
column.

TIP
The currently grouped columns and the group by box toggle state are saved with a view’s 
state.

To group by a column:

Do one of the following:

• Right-click on the column header and choose GROUP BY THIS COLUMN.
• Drag a column into the Group By Box.

To toggle the group box:

• Right-click on any column header and choose TOGGLE GROUP BY BOX.

To clear all groupings:

• Right-click on any column header and choose CLEAR GROUPINGS.

Resizing Columns

You can resize the visible columns to better fit the data displayed in the column. You can 
also lock the width of a column so that it doesn’t resize when you resize the entire CoolSign 
window.

TIP
Column widths are saved with a view’s state.

To resize a column:

Do one of the following:

• Click and drag on the column border to manually resize the column.
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2. Using CoolSign Network Manager 
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• Right-click on the column header and choose BEST FIT. The column will be resized to 
best fit the data visible in the column.

TIP
To tell the grid to resize all the visible columns to best fit the data, hold down the Ctrl key 
while choosing BEST FIT.

To lock a column width:

Right-click on the column header and choose LOCK COLUMN WIDTH. The column will no 
longer resize automatically when the window is resized.

Changing which Columns are Visible

You can add or remove columns from the data grid if you want to include different pieces 
of information in your view.

TIP
Visible columns are saved with a view’s state.
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To add columns to a data grid:

1. Right-click on any column header and choose CHOOSE COLUMNS to show the Choose 
Columns toolbox.

Lists all the avail-
able columns that 
haven’t been added 
to the data grid.

Click to show the 
internal hidden col-
umns. In most cases 
you will not find 
these columns useful.

Use the move buttons to move 
the selected columns between 
the available and shown lists.

Click this button to 
force all columns to 
resize to best fit the 
visible data.

Click this checkbox to 
shade every even row 
with a light gray color 
for easier viewing.

Use these buttons to 
move a selected column 
up or down in the list.

Lists all the columns that 
are visible in the data grid.

2. Select one or more columns in the AVAILABLE COLUMNS list.

3. Click the right arrow button to move the columns into the SHOW THESE COLUMNS list.

4. Click Close.

To remove columns from a data grid:

• Right-click on the column header and choose REMOVE THIS COLUMN.
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Reordering Columns

You can change the order in which the visible columns are displayed to better organize your 
data.

TIP
Column ordering is saved with a view’s state.

To reorder a column:

Click on the column header and drag the column left or right to reposition it.

Managing Views

In addition to the predefined views that CNM provides for each manager page, you can add 
additional views to further customize how you work with items. The Manage Views dialog 
allows you to create new views, edit and delete existing views, import or export views, and 
reset views to their default state.

To add a new view:

1. Choose VIEWS > MANAGE VIEWS to display the Manage Views dialog.

2. Click New.

3. Enter a name for the view.

4. Choose columns for your view. For details, “Changing which Columns are Visible” 
on page 25.

To rename a view:

1. From the Manage Views dialog, click Rename.

2. Enter a new name for the view.

3. Click OK.

To delete a view:

• From the Manage Views dialog, click Delete.

Importing and Exporting Views

You can export views to a special CoolSign View File format (.cvw) so that you can 
transfer them between different CoolSign networks.
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To export a view to a CoolSign View file:

• From the Manage Views dialog, click Export and enter a name to save your view.

To import a CoolSign View file:

• From the Manage Views dialog, click Import and choose a view file using the open 
file dialog.

Resetting and Restoring Default Views

CoolSign provides predefined default views for each of the manager pages. If you modify 
or delete these views, you can reset or restore them back to their default settings using the 
Manage Views dialog.

To reset a view back to its default settings:

1. From the Manage Views dialog, select the view to reset.

2. Click Reset View.

NOTE
You can only reset predefined default views created by CoolSign. User-created views 
cannot be reset.

To restore deleted default views:

• From the Manage Views dialog, click Restore Default Views.

Searching for Items

The search box at the top of the manager grid can be used to perform instant and advanced 
searches (“About Manager Pages” on page 19). When you type in the Search box, you are 
automatically using the instant search function. The instant search is performed on the first 
column only (usually, the first column is "Name" but it is not always the case.) Especially 
when there are multiple levels of grouping in the grid. For example, in the audio manager 
grid, if it is grouped by Artist, then the first column becomes "Title". As a result, the Instant 
search searches on Title.

The advanced search can be done by clicking the “…” button.
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You can also filter which items are displayed in a data grid by using the Search dialog. 

To search for items:

1. To display the search dialog, do one of the following:
• Choose TOOLS > SEARCH.
• Right-click in the QuickBar and choose NEW SEARCH.
• Type Ctrl-F.

2. Define the search criteria using the Field, Condition and Value controls or click “...” 
in the search box at the top of the manager grid for advanced search capabilities.

3. To create a search expression that contains multiple criteria, check the “Show 
Advanced Search” box.

4. Click Find. The results of your search are displayed in the data grid and a temporary 
Search item is created in the QuickSets panel.

NOTE
Temporary search items are no longer available after you restart CNM. To make the 
results of your search available to subsequent sessions, you can save your temporary 
search as a QuickSearch. For details, “Using QuickSearches” on page 31.

Using the QuickBar

Each manager page (except for the Home page) has a quickbar that contains tools to help 
you organize and filter the items that appear in the data grid. While each manager page can 
have page-specific quickbar features, all the quickbar panels contain the QuickSet panel.
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About the QuickSet Panel

The QuickSet panel is available for every manager page (except for the Home page) and 
lets you create QuickSets, QuickSearches, and Folders to help you organize your data.

This is a QuickSearch.

This is a temporary 
search.

This is a Folder.

This is a QuickSet.

Using QuickSets

QuickSets are user-defined categories that you create and add items to. When you click on 
a QuickSet in the QuickBar panel, the data grid immediately displays only the items that 
you have added to that QuickSet. QuickSets are not exclusive, so you can add an item to 
more than one QuickSet.

IMPORTANT
Only CoolSign administrators using the Network Manager can create QuickSets. 
Content administrators, users who only have access to the web-based interface, can 
only use existing QuickSets; they cannot create QuickSets. 

To create a new QuickSet:

1. Right-click anywhere in the QuickSet panel and choose NEW QUICKSET.

2. In the QuickSet Properties dialog, enter a name for the new QuickSet.

3. Click OK.

To add an item to a QuickSet:

• Select one or more items in the data grid and drag them onto the QuickSet.
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To remove an item from a QuickSet:

• Right-click the item in the data grid and choose REMOVE FROM QUICKSET.

To clear all the items from a QuickSet:

• In the QuickSet panel, right-click the QuickSet and choose CLEAR QUICKSET.

To edit the properties of a QuickSet:

• Right-click the QuickSet and choose EDIT QUICKSET. You can change the QuickSet 
name or modify security settings.

To delete a QuickSet:

• Right-click the QuickSet and choose DELETE QUICKSET.

NOTE
Deleting a QuickSet does not delete the items in the QuickSet, just the QuickSet itself.

Using QuickSearches

QuickSearches are searches on your items that you can save persistently. When you click 
on a QuickSearch in the QuickSet panel, the data grid displays all the items that pass the 
filter expression of that QuickSearch. QuickSearches are “live”; if an item changes, the 
QuickSearch can automatically update to include the modified item.

Before you can create a QuickSearch, you must perform a search on the data grid. See 
“Searching for Items” on page 28. After you define a search, a temporary search item 
named Search (in italics) is created in the QuickSet panel. If you like this search, you can 
save it as a QuickSearch so that it is always available and so that other users can access it.

To convert a temporary search to a QuickSearch:

1. Right-click on the temporary search item and choose SAVE AS QUICKSEARCH.

2. Enter a name for your new QuickSearch.

3. Click OK.
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To edit the filter expression on a QuickSearch:

1. Right-click on the QuickSearch and choose EDIT QUICKSEARCH. 

The QuickSearch Properties dialog appears.

2. Click the Edit button to modify the search criteria.

3. In the Search dialog, define the search criteria, then click Find. For details, see 
“Searching for Items” on page 28.

4. Click OK.

To delete a QuickSearch:

• Right-click on the QuickSearch and choose DELETE QUICKSEARCH.

Organizing QuickSets and QuickSearches

Folders allow you to better organize your QuickSets and QuickSearches. You can create 
folders and then drag QuickSets and QuickSearches into the folder. Clicking on a folder 
will display all the items in every QuickSet in the folder.

NOTE
You can use folders to help organize your QuickSearches, but folders do not aggregate 
the results of the QuickSearches stored in the folder. 

To create a new folder:

1. Right-click anywhere in the QuickSet panel and choose NEW FOLDER.

2. Enter a name for the new folder.

3. Click OK.
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To add QuickSets or QuickSearches to a folder:

• Drag and drop the QuickSet or QuickSearch onto the folder. You can also nest folders 
within folders by dragging a folder onto another folder.

To remove a QuickSet or QuickSearch from a folder:

• Drag the QuickSet or QuickSearch out of the folder into the lower blank area of the 
QuickSet panel.

To rename a folder:

• Right-click the folder and choose RENAME FOLDER. 

To delete a folder:

• Right-click the folder and choose DELETE FOLDER. You will be asked whether to delete 
the folder and its contents or just the folder.

Printing and Exporting Data

You can print or export the items displayed in any data grid. You can export data to 
Microsoft Excel or to a delimited text file.

To print the items displayed in a data grid:

• Right-click in any column header and choose PRINT GRID.

To export items to a file:

1. Right-click in any column header and choose SAVE GRID DATA TO FILE.

2. Choose the file format that will be used to save the data.
• Excel (*.xls)—Saves the data in Microsoft Excel format. There are no additional 

options for this format.
• Text (*.txt)—Saves the data as a delimited text file. You can use the Text export 

properties to set the delimiter character, whether fields should be quoted, and 
whether to pad data with spaces.

3. Select a name and location to save the file onto your hard drive.
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The following information covers the CoolSign web interface (WI) and how to perform 
tasks.

Topics Discussed

Intended Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20
Required Permissions for Users . . . . . . . . . . . . . . . . . . . . . . .  20

Getting Acquainted with the Web-based Interface  . . . . . . . . . . . . . . .  20
Accessing the Web Interface . . . . . . . . . . . . . . . . . . . . . . . . .  20
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Intended Usage

The Web Interface runs on any computer platform, mobile device, or tablet and supports 
the basic functionality of templates and scheduling of content in player regions. 

Designed for content administrators, or entry-level users (such as office admins, charge 
nurses, or other less-technical users), the Web Interface (WI) is an alternative to the full-
featured, robust graphical interface favored by dedicated power users and CoolSign system 
administrators. 

Required Permissions for Users

In order to perform the tasks with the Web Interface (WI), the CoolSign administrator first 
must provide you with a login and password that includes the appropriate permissions for 
a Content administrator or CoolSign administrator.

Getting Acquainted with the Web-based Interface

CoolSign 5.1 introduces the web interface, an intuitive web-based user interface (WI), that 
allows you to manage channels and content through your favorite browser. With a click of 
the mouse, you can switch between tabs for Channels, Library, and Templates to create 
content, generate new content from templates, and assign. While this simplified interface 
is perfect for everyday users, administrators will still want to use the full-featured Network 
Manager rich client to perform their tasks.

Accessing the Web Interface

The Web Interface is bundled with the CoolSign software. Once the Network Controller is 
installed and running, the web interface can be accessed at:  

http://<NC_IPAddress>:<Port>/web/index.html

Example:

http://10.69.12.181:80/web/index.html

Point your internet browser to this address and login to start a session.
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Basic Layout and Elements

The interface groups common tasks into easily-accessible screens. These screens use a 
consistent layout with common screen elements to simplify your experience. 

Figure 4 Interface Screen Elements

Logout Link

Current User

Search

Main Screen 
(Home) link

Navigation 
Tabs

Actions 
Toolbar

Actions
Pane

Access Links

At the top of every screen, are quick access links that you click to return to the main screen 
(home page), determine the currently logged in user, and log out of the system.

Navigation Tabs

The navigation tabs along the top of the screen provide easy access to the Channels, 
Library, and Templates pages from any place in the interface.
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Search Field

The search field allows you to search and sift through the items available in the action pane 
of the current screen.

Actions Toolbar

The actions toolbar is located just above the action pane. The actions toolbar displays 
buttons for the available tasks based upon the current screen and selections. 

Action Pane

The action pane, depending on the current screen, displays the available items. 

A Closer Look at the Web Interface

The navigation tabs located across the top of the interface gives you instant access to the 
main interface screens:

• Channels
• Library
• Templates
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Channels Screen

[Default Screen] Click the Channels tab from anywhere in the interface to access the 
Channels screen. The Channels screen lists the available channels. 

Figure 5 Channels Screen

About Channels and Players

When working with the CoolSign web interface (CWI), keep in mind that the functionality 
provided is a subset of what is usually accomplished using the CoolSign Network Manager 
(CNM) application. In particular, you should understand the difference between channels 
and players.

Channels are the master schedules to which you tune your players. You can use the Channel 
Manager in the CNM to create new channels and schedule content or playlists into 
channels. Once a channel is created, you can then use the Player Manager in the CNM to 
tune players to your channel so they start playing the scheduled content.

Players are the nodes in your network that play back content on a display device. The 
CNM’s Player Manager provides functionality to manage your players, including the 
ability to remotely configure players, divide a player into multiple regions, tune a player to 
a channel, and review the play history for a player. 

The CWI is used to manage the content associated with channels, but not the players them-
selves. The CWI will show you what players are tuned to a given channel, but this associ-
ation can only be changed using the CNM.
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Library Screen

Click the Library tab from anywhere in the interface to access the Library screen. The 
Library screen lists the available content that can be assigned to a player. Recently added 
items are identified with a New banner in the corner.

Figure 6 Library Screen 

Templates Screen

Click the Templates tab from anywhere in the interface to access the Templates screen. 
The Templates screen lists the templates available to assist you in formatting content 
layouts. 
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Figure 7 Templates Screen

Performing Tasks with the Web Interface

The Web Interface (WI) gives you quick access to perform the most popular tasks. The WI 
is also the only tool that you can use to create new content from an existing template. The 
Template workflow relegates certain tasks to specific tools/roles.

Figure 8 Template Workflow Overview

• A content designer uses the Content Creator tool to create a template, bind the editable 
fields to a dynamic data table, and then publishes the template to the CNM. 

• A content administrator uses the Web Interface (WI) to access the template and modify 
the available text/media fields to create new content assets. The content administrator 
then assigns the new content to the appropriate channel(s). 
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• A CoolSign administrator uses the CoolSign Network Manager (CNM) to assign 
players to channels to view the new template-based assets. The CoolSign administrator 
deletes the templates as needed.
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Enabling and Disabling the Web Interface

To enable/disable the web interface:

1. Enter the following URL in your browser window:

Starting and Ending a Web Interface Session

To log into the interface:

1. Enter the following URL in your browser window:
http://<NC_IPAddress>:<Port>/web/index.html

Example:

http://10.69.12.181:80/web/index.html

Where:

• <NC_IPAddress>:<Port> — the Network Controller address and port that you 
specified during installation.

Figure 9 Login Screen

2. At the Login screen, enter your user credentials:
• User ID
• Password

NOTE
Refer to the Important Notices document for your initial credentials. Be sure to change the 
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password and make note of it for future reference.

Once logged in, the Channels screen is displayed.

To log out of a session: 

1. Click the Logout link to exit your session and return the system to the Login screen. 

NOTE
Exiting the interface does not shut down the CoolSign Network Manager.

Logout Link 

Once logged out, the Login screen is displayed.
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Working with Channels

The Channels screen lists all the available channels. To help you manage the channels, the 
actions toolbar provides search, filtering, and sorting capabilities for finding specific 
channels. To view a Channel’s properties, click its icon. The Channel’s Properties screen 
gives you access to individual channel properties such as currently tuned players and their 
regions, as well as playback order. 

Figure 10

Locating a Specific Channel

Before performing a task, you may need to identify the channel(s) on which you want to 
perform the task. The following provides a variety of means to sift through the channels in 
the action pane of the Channels screen to identify the channel(s) you want:

• sort
• filter
• search
• select

To sort channels:

1. Click the Channels tab, if necessary, to access the Channels screen.

2. On the actions toolbar, click the SORT BY drop-down menu and select either 
ALPHABETICAL (A-Z) for ascending or ALPHABETICAL (Z-A) for descending.
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Figure 11

To filter channels:

1. Click the Channels tab, if necessary, to access the Channels screen.

2. On the actions toolbar, click the Search text entry field and enter a unique character 
string that identifies the channel(s) for which you are searching. 

The action pane displays the channel(s) matching your search criteria.

TIP
When naming your channels, consider using a taxonomy or naming scheme that will aid in 
grouping the channels together for common tasks.

To search for a specific channel:

1. Click the Channels tab, if necessary, to access the Channels screen.

2. On the actions toolbar, click the Search text entry field and enter the name of the 
channel for which you are searching.

The action pane displays the channel matching your search criteria.
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To select a channel:

1. Click the Channels tab, if necessary, to access the Channels screen.

2. Locate the channel upon which you want to perform the task.

3. Click the appropriate channel icon.

Any action you perform will be made on the selected channel.

Specifying and Scheduling a Channel’s Content 

The content and playback mode for a channel is defined on the Channel’s Properties screen. 
From the Properties screen you can add content, specify content for playback, and choose 
the type of playback mode (such as shuffle).

Viewing a Channel’s Properties Screen

To view a specific Channel’s Properties screen:

1. Click the Channels tab, if necessary, to access the Channels screen.

2. Locate the channel(s) upon which you want to perform the task (see “Locating a 
Specific Channel” on page 44).
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3. Click the icon of the channel.
Playback Mode 
selector

Channel name

Back button

Action toolbar

Player > Region 
pane listing current 
players subscribed 
to the channel and 
the region where 
the content is 
playing.

Pane Resize handle

Content pane 
showing the 
content that is 
currently assigned 
to the channel.

 

The Channel’s Properties screen opens listing the players tuned to the channel, the 
channel’s content, and the playback mode.

To close the Properties screen:

1. With the Channel’s Properties screen open, do one of the following:
• Click the Back button to the left of the channel name.
• Click the Channels tab.

The Properties screen closes and the Channels screen is displayed. 

Assigning Content Assets to a Channel

You can add content to a channel from the Channel’s Properties screen or from the Library 
screen.

To add content assets from the Channel’s Properties screen:

1. Click the Channels tab, if necessary, to access the Channels screen.

2. Locate the channel upon which you want to perform the task (see “Locating a 
Specific Channel” on page 44).
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3. Click the icon of the channel to open its Properties screen.

4. Click the +Add button from the actions toolbar.

5. In the Add Content dialog window, click the selection checkbox(es) to checkmark the 
content assets you wish to add.

TIP
You can enter text in the Search field to narrow the display of available content or use 
the Resize handle (double arrows) in the lower right of the dialog window to enlarge 
the viewing area as needed.
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6. Click the Add button to close the dialog.

7. When the Tap here to save changes popup appears, click the popup.

8. Confirm that the Success! Changes saved popup appears.

The Properties screen opens listing the new content assets.

9. To add content assets from the Library screen:Click the Library tab, if 
necessary, to access the Library screen.

10.Click the selection checkbox(es) to checkmark the desired content assets. 

Figure 12

TIP
If you want to select all the content currently displayed, click the All selection 
checkbox at the top left corner of the screen.

11.Click the Add to Channel button.
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12.When the Add Content to Channel(s) dialog opens, click the selection checkbox(es) 
to checkmark the appropriate channel(s). 

TIP
You can enter text in the Search field to narrow the display of available content or use 
the Resize handle (double arrows) in the lower right of the dialog window to enlarge 
the viewing area as needed.

13.Click the Add to Channel button.

14.When the Tap here to save changes popup appears, click the popup.

15.Confirm that the Success! Changes saved popup appears.

The selected content is now available on your selected channel(s).

Related Topics

• Specifying and Scheduling a Channel’s Content on page 46 
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Removing Content Assets from a Channel

To remove a channel’s asset(s):

1. Click the Channel tab, if necessary, to access the Channels screen.

2. Locate the channel(s) upon which you want to perform the task (see “Locating a 
Specific Channel” on page 44).

3. Click the icon of the channel.

4. When the Channel’s Properties screen opens, click the selection checkbox(es) to 
checkmark the content assets you want to delete. 

TIP
If you want to select all, click the All selection checkbox at the top left corner of the 
page.

5. Click the Delete button on the actions toolbar.

NOTE

The content is only removed from the channel. It is still available from the Library 
screen and can be reassigned.
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6. When the Tap here to save changes popup appears, click the popup.

7. Confirm that the Success! Changes saved popup appears.

The selected content assets are removed from the Channel’s Properties screen.

Scheduling Content on a Channel via the Playback Mode

To perform basic scheduling functions you use the Web Interface (WI) to specify the 
playback mode:

• Shuffle
• Custom

To shuffle a channel’s content:

1. Click the Channel tab, if necessary, to access the Channel’s screen.

2. Locate the channel upon which you want to perform the task (see “Locating a 
Specific Channel” on page 44).

3. Click the icon of the channel.

4. When the Channel’s Properties screen opens, click the PLAYBACK ORDER drop-down 
window and select SHUFFLE. 
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5. When the Tap here to save changes popup appears, click the popup.

6. Confirm that the Success! Changes saved popup appears.

The selected assets will run on the channel in the Shuffle playback mode. 

To define a custom playback for a channel’s content:

1. Click the Channels tab, if necessary, to access the Channels screen.

2. Locate the channel upon which you want to perform the task (see “Locating a 
Specific Channel” on page 44).

3. Click the icon of the channel.

4. When the Channel’s Properties screen opens, click the PLAYBACK ORDER drop-down 
window and select CUSTOM.

5. Add or drag and drop the content icons into the desired order (playback will occur 
based on the order of the content icons, from left to right, top to bottom). 

6. When finished adding and positioning your content, click the Tap here to save 
changes popup.

7. Confirm that the Success! Changes saved popup appears.

The selected assets will run on the channel in the customized playback mode. 
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Working with the Library

The Library screen lists all the available content assets from which you can choose to run 
on your players. You select content from the Library and add it to your players for 
playback. To help you manage the assets in the Library, the actions toolbar provides import, 
delete, and the means to sort or filter the content. This screen also allows you to assign 
content assets to your player(s). When working with content in the library, you can click an 
asset’s icon to display the content’s properties screen. From the Content’s Properties screen 
you can edit the name, format, duration, and when it activates or expires.

 to the Library

To import content assets: 

1. Click the Library tab to access the Library screen.

2. Click the Import button.

Figure 13

3. When the Import dialog opens, click the +Add File button.
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4. Browse to the location of the content and select the file.

TIP
Use the Resize handle (double arrows) in the lower right corner if you need to resize 
the dialog box to view the filenames.

5. Repeat Steps #3 and #4 until all your items are listed in the Import window, then click 
the Upload button.

The new content assets are displayed in the Library and identified with a New banner.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 55



3. Using the CoolSign Web Interface 
Working with the Library
Removing Content Assets from the Library

To remove content asset(s) from the library:

1. Click the Library tab, if necessary, to access the Library screen.

2. Click the selection checkbox(es) to checkmark the appropriate content assets. 

TIP
If you want to select all, click the All selection checkbox at the top left corner of the 
screen.

3. Click the Delete button.

IMPORTANT
The assets are removed from the Library screen and the network. Deleted content 
cannot be recovered. Be sure that you have a backup of your content outside of the 
system. 
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Modifying Content Properties (such as Name, Format, Duration, and Acti-
vation)

To modify the properties of a content asset:

1. Click the Library tab, if necessary, to access the Library screen.

2. Locate the content item you wish to modify, and then click on its thumbnail.

The Edit Content screen appears.

3. Modify the Format, Duration, Activates and Expires fields as appropriate.

4. Click the Save Changes button.

The changes will be applied to the playback of the modified content item on all channels.

Selecting, Filtering, and Sorting Content Assets in the Library

To select a content asset:

1. If necessary, click the Library tab to access the Library screen.

2. Locate the content asset(s) upon which you want to perform the task.

3. Click the selection checkbox(es) to checkmark the name(s) of the asset(s).

Any subsequent action you perform will be made on the selected asset(s).
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To search for a specific content asset:

1. If necessary, click the Library tab to access the Library screen.

2. Click the Search text entry field and enter the entire name or a unique character 
string that identifies the asset(s) for which you are searching.

The action pane displays the asset(s) matching your search criteria.

To sort content assets in the library:

1. Click the Library tab, if necessary, to access the Library screen.

2. On the actions toolbar, click the SORT BY drop-down menu and select either:
• Alphabetical (A-Z)
• Alphabetical (Z-A)
• Newest
• Oldest

The assets are sorted to appear in the specified order.
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To filter the assets displayed:

1. Click the Library tab, if necessary, to access the Library screen.

2. On the actions toolbar, click the Search text entry field and enter a couple of unique 
letters that identify the asset(s) for which you are searching. 

TIP
When naming your assets, consider using a naming scheme or taxonomy that will aid 
in grouping the assets for typical use scenarios.

Figure 14

With the word “class” 
in the search field, the 
content pane only 
displays assets whose 
name include the text 
string, “class”.

The action pane displays the assets matching your search criteria.

To use QuickSets to filter content assets:

NOTE

QuickSets are created by the CoolSign administrator to simplify commonly-used 
search criteria. If you do not see a QuickSet matching your needs, ask your CoolSign 
administrator to create it.

1. Click the Library tab, if necessary, to access the Library screen.
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2. On the actions toolbar, click the Quickset drop-down menu and select the 
appropriate option. 

TIP
If it is a large QuickSet, you can also filter items displayed. Click the Search text entry 
field and enter the entire name or a unique character string that identifies the asset(s) 
to further filter the results.

The action pane displays the content assets according to the QuickSet criteria.

Working with Templates

Templates are a great way to kick start your content collection. A template allows you to 
produce multiple pieces of content with the same layout quickly. 

You use the web interface (WI) to create an instance, or copy, of the template for editing. 
Then you modify that instance to create a new piece of content. Typically, modifying an 
instance involves updating data fields with new text and graphics. 

NOTE
Templates are created in the Content Creator tool. Refer to the Content Creator 
documentation for more information. 

Creating Content Based Upon a Template

To create new content based on a template, you first create a new instance of the template 
and then modify the content elements (such as text or graphics) — not the layout. For 
example, a basic template might have a headline at the top of the layout with a picture 
beneath it. Each instance of the template could have a different heading and picture, but the 
layout would remain the same with the heading at the top and the picture beneath. Each 
instance, once modified, becomes a new piece of content that can be scheduled and played. 
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To create new content from a template:

1. If necessary, click the Templates tab to open the Templates screen.

2. Click the template that you want to use. An instance of the template is created and its 
associated form opens showing the editable fields. 

3. Specify a name for this new instance and enter appropriate data for the available 
fields. The information you enter replaces the placeholders in the template layout. 

4. If the template design includes placeholders for images or video, click the associated 
Change button and browse to the image or video file you wish to have appear in the 
content item.

5. When you have finished providing text and graphics, click the Create button.

The new template-based content is displayed in the Library and identified with a New 
banner. It can be added to a Channel and scheduled like any other content.

NOTE
Templates are used to create only one piece of content at a time. If you are creating a 
series of ads, you must create multiple instances, modify them, and add them individually 
to the channel.

Related Topics

• “Assigning Content Assets to a Channel” on page 47
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Revising Template-based Content

To edit template-based content:

1. If necessary, click the Library tab to open the Library screen. 

2. Find and click the piece of content that you want to revise. The template instance 
screen appears.

3. Edit the appropriate data fields to make your revisions.

4. When finished, click Save Changes.

The Library screen appears with a message confirming the changes have been saved
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What is CoolSign content? 

Content is perhaps the most important element within a CoolSign Digital Media Network. 
Without content, your screens would be dark. 

CoolSign includes a tool for authoring/converting basic content into digital assets, as well 
as robust tools for managing your digital assets to easily handle the challenges posed by 
large and diverse digital signage networks. 

NOTE
CoolSign Content Creator, a powerful authoring tool for creating digital assets, is available 
separately.

The CoolSign toolset provides extensive support for managing content:

• Supports the most popular standard digital file formats used by today’s content 
creation applications including MPEG-2, H.264, Windows Media 9, Flash, and 
Photoshop bitmaps.

• Converts Microsoft PowerPoint 2003 and 2007 presentations to JPG format, and 
PowerPoint 2010 presentations to WMV format. 

• Integrates seamlessly with Vistar Media, a third-party content provider or ad broker, 
to help you meet the growing demand for relevant content to populate your screens.

• Allows you to stream live content and display web pages. 

Creating CoolSign Content

Text, graphics, and multimedia assets to be used within CoolSign can be authored using any 
of the many available, professional content-authoring tools like Microsoft PowerPoint, 
Adobe After Effects, Adobe Photoshop, Adobe Flash, and Apple FinalCut Pro. Once you 
have created the digital assets for your content, you can convert those assets into CoolSign 
content by using the CoolSign Content Wizard optional CoolSign. You can then use CNM 
to import the CoolSign content into a CoolSign network. 

For more information, please refer to the following documents, available from the 
Haivision Download Center at https://www.haivision.com/download-center:

• Chapter 5, "Using the CoolSign Content Wizard."
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• CoolSign Content Creator User’s Guide

CoolSign Content Wizard 

The CoolSign Content Wizard is included with all CoolSign software and is designed to 
convert supported file formats into CoolSign content. The Content Wizard has a simple 
interface that allows you to import a file; set content properties like name, duration, and 
transition; select a thumbnail frame; and save CoolSign content, all in a few quick steps. 
For installation instructions, see the CoolSign Network Installation Manual.

CoolSign Content Wizard can also be used to convert media files to CoolSign content by 
pointing to one or more media assets. However, when CoolSign Content Wizard creates 
video capture content, it doesn’t have a media file. Instead, it requires specific information 
to convert a media file such as: Input, Standard, Channel, Resolution, etc. This information 
is output to a file called “Control.xml”, which prompts CoolSign players to play the 
specified video capture content. For detailed instructions, see “Creating video capture 
content” on page 71.

CoolSign

CoolSignCoolSignCoolSign

WARNING

Acquiring Content

In addition to authoring your own content, you can acquire content from other sources, such 
as streaming live content, displaying web pages, or subscribing to place-based advertizing. 

Streaming Live Content 

With CoolSign 5.1, you can stream live video content to your CoolSign displays.Video 
streams (including those with FEC or encryption) from the Havision Furnace solution are 
supported, as are HD and SD streams from the Havision Makito encoders. Unencrypted 
video streams from other sources are also supported. For more information, see “Streaming 
Content” on page 112.
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Displaying Web Pages 

Another much requested feature that has been added to CoolSign 5.1 is the ability to include 
internet web pages as content on CoolSign displays. You can schedule and present news, 
weather, sports and other rich web content from any valid URL on your CoolSign network.

Integrating Vistar Media 

Vistar Media (www.vistarmedia.com) operates a marketplace for digital place-based 
advertising. Vistar Media’s platform automates the delivery of ads from buyers to digital 
signage networks. This enables advertisers to connect seamlessly to ad networks to sell 
their ads — Vistar Media effectively acts as a broker between ad sellers and ad buyers. 

The CoolSign Vistar Content feature gives CoolSign administrators the ability to schedule 
ad content purchased through Vistar Media — an increasingly popular solution for filling 
spare capacity in a pipeline.

A CoolSign administrator can schedule a piece of Vistar content, such that individual 
players in the CoolSign network grab ads for specified time slots, play them back, and then 
report the playback to Vistar Media.

Supported File Formats

Assets for CoolSign content can be authored using numerous industry-standard production 
tools available from companies like Adobe, Avid, and others. The remainder of this chapter 
discusses requirements for developing assets for CoolSign.

The following digital formats are supported by CoolSign:

Audio Image Video

MP3 bmp
gif
jpeg
png
psd

WMV
Flash
MPEG-1
MPEG-4

AVI
M2V
MOV
MP4 (H.264 only)
H.264
XVid
DivX

Using Digital Video In CoolSign

Digital video is the most popular format for authoring CoolSign content. Digital video can 
be created in any number of production tools including Adobe After Effects, Avid Media-
Composer, Apple FinalCut Pro, and Adobe Premiere. The preferred formats for encoding 
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and playback of digital video in CoolSign are H.264 or Windows Media 9. Both formats 
are capable of high-quality video playback at both SD and HD resolutions. H.264

H.264 is designed for broadcast-quality digitally-encoded audio and video. It offers good 
image quality and is the standard for DVD video. Most authoring applications do not 
encode directly to H.264 and require a 3rd-party encoding tool or plug-in. 

NOTE
H.264 defines different standards for resolution and bit rate called profiles and levels. In 
order to encode MPEG-2 at greater resolution than NTSC (720x480), you will need an 
encoder that supports High Profile and High-1440 Level. Most hardware H.264 encoders 
do not support the higher profiles and levels.

The following are some applications that can be used to encode H.264:

• Adobe After Effects 6.5 (www.adobe.com)1

• Adobe Premiere Pro (www.adobe.com)

• MainConcept MPEG Encoder (www.mainconcept.com)1

• TMPGEnc Plus 2.5 (www.pegasys-inc.com)
• Discreet Cleaner XL (www.discreet.com)

NOTE
The Discreet Cleaner XL only supports encoding at 720 x 480.

CoolSign supports H.264 program streams (multiplexed video/audio) or video elementary 
stream (video only) at data rates up to 15 Mb/s.

MPEG-1

While CoolSign fully supports MPEG-1 digital video, we recommend that H.264 be used 
for its superior resolution and quality. In most cases, MPEG-1 can be encoded in the same 
way as H.264.

Windows Media 9

Microsoft Windows Media technology is an alternative to H.264 for full-screen, digital 
video playback. Windows Media has certain advantages: more authoring tools natively 
support encoding to WMV and, in many cases, the file size of Windows Media is signifi-
cantly smaller than H.264.

1. Please refer to “Using Flash-based Content” on page 358 for detailed steps on encoding MPEG-2 using 
Adobe After Effects and MainConcept MPEG Encoder.
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The following are some applications that can be used to encode Windows Media 9:

• Adobe After Effects / Adobe Premiere Pro (www.adobe.com)
• Discreet Cleaner XL (www.discreet.com)
• Microsoft Windows Media Encoder 9 (www.microsoft.com)

Windows AVI

Although AVI is a supported technology, it’s enclosed encoding must have a corresponding 
decoder on the player for proper playback.

CoolSign Encrypted Video Format

In cases where security of digital video assets is important, the CoolSign EVF format is 
available to encrypt MPEG-2 video so that only CoolSign can playback the assets. For more 
information, please contact your sales representative.

Using Flash in CoolSign

CoolSign supports Shockwave Flash (SWF) vector animation format created in applica-
tions like Adobe Flash, Adobe LiveMotion and Adobe After Effects. 

SWF files exported as Versions 4–9 are supported.

WARNING
You can only control the volume of SWF files that are version 8 or older. With SWF version 
9 files, it is not possible to control the player volume from CoolSign.

NOTE
SWF files for use with CoolSign should be authored at a playback speed of 30 frames per 
second. Lower frame rates can be used, but playback will appear choppier than movies 
created at full 30 fps. 

Take care to avoid animating complicated vector shapes, large bitmaps, and numerous 
objects simultaneously as this can result in poor playback performance. In these cases, it is 
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recommended that you export into AVI or QuickTime format and then encode to H.264 or 
WMV formats using a standalone encoding application.

NOTE
Refer to “Using Flash-based Content” on page 358 or the CoolSign Tech Note “Creating 
Flash-Based Content for CoolSign” available from the CoolSign Software Download Site 
at: http://support.haivision.com

Using bitmaps in CoolSign

If you don’t require animation in your content, CoolSign supports displaying static bitmap 
assets. Bitmap assets can be authored in any software that supports the following formats:

• Photoshop (*.psd)—Photoshop version 3.0 or higher supported. Layered files will 
be flattened. Only RGB mode is supported. Only the first alpha channel will be used.

• Windows Bitmap (*.bmp)—Windows Bitmap can be saved as either 24-bit or 32-
bit.

• JPEG (*.jpg)—JPEGs should be saved with maximum quality settings to minimize 
compression artifacts.

• Portable Network Graphics (*.png)
• Graphics Interchange Format (*.gif)—GIF animation is not supported.

Assets should be saved at 16-bit, 24-bit, or 32-bit color depth. 1-bit and 8-bit images are not 
supported.

NOTE
CoolSign fully supports 32-bit images. If you are displaying 32-bit bitmap with an alpha 
channel, the transparent regions will be transparent to the black background. If you are 
using overlapping regions, you can use alpha channel transparency to show through from 
one region to the one below. Be sure to delete unwanted alpha channels before importing 
bitmap content as there is no mechanism for “turning off” an alpha channel once 
converted into content.

Using PowerPoint in CoolSign

PowerPoint slides and shows can now be imported through the CoolSign Content Wizard:

• With PowerPoint versions 2003 and 2007, the .jpg format is converted to run slide-to-
slide. 

• With PowerPoint versions 2010, the .wmv format is converted to run slide-to-slide. 
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You can also adjust the duration between slides as well as adjust transitions that are 
between one content item and other content items that are on the same channel.

NOTE
Microsoft PowerPoint has to be installed on the same box as the Content Wizard. 

To adjust the slide duration and adjust the transition between content:

1. Go to the Content Wizard and select Create.

2. Select CHOOSE ASSET (“Convert single asset” is the default).
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3. Click Browse to select a PowerPoint presentation to convert to CoolSign content.

4. Select SET OPTIONS and then select the slide duration as well as the slide transition 
between content.

5. Click Apply Changes so the new settings take effect. Note that PowerPoint version 
2007 is being used.

With PowerPoint 2010, you can import a PowerPoint file and Content Wizard will convert 
it into a .wmv file. Note that PowerPoint versions 2003-2007 do not support .wmv movie 
presentations.

1. If using PowerPoint 2010, these features are available to manipulate your converted 
.wmv content:
• Volume Gain
• Asset Properties
• Content Resize Settings
• Content Activation/Expiration 
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Creating video capture content

To create video capture content:

1. On the CHOOSE ASSET tab, click “Configure video capture”.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 71



4. About Content 
Creating video capture content
2. Select your desired video capture specifics from the drop-down menus and then click 
Next. Video Capture options include:
• Input—Composite, RGB, S-Video, and Tuner
• Standard—NTFC and PAL
• Channel—Channel number
• Resolution—Resolution standard
• Tuner Settings—Mode, Type, and Country/Region

NOTE

If you select Tuner as your input, you’ll need to specify the type of antenna or cable 
along with the country/region.

3. On the SET OPTIONS tab, select the desired video capture settings, and then click Next.
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4. Click SELECT THUMBNAIL, select an external image as the content thumbnail, and then 
click Next.

NOTE

If no image is specified, CoolSign Content Wizard uses the default black thumbnail.
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5. Click the CREATE tab. From this screen you can:
• Select a folder to save your content in
• Import created content into a CoolSign network

6. Click Finish to save your video capture content.
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Using Web Pages as Content

This section provides instructions for displaying internet web pages on a CoolSign Player. 
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To display web page content: 

1. Open the Network Content Manager and click the Content icon in the navigation 
sidebar.

2. From the Actions menu, select the option CREATE WEB CONTENT...
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3. For the Site URL field, enter the internet address (URL) for the site that you want to 
display and click the Apply button.

4. Switch to the General tab and define the content Name and Duration fields.
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5. Click the OK button. At this point, the content can be scheduled into a channel like 
any other CoolSign content. See “Adding Items to a Channel” on page 139.

NOTE
To display web content, you will need to install the Mozilla Firefox browser and 
corresponding Flash plug-in on the Player Node if you want to display web pages that 
contain Flash (for example, YouTube).

Using Streaming Content

There are two ways to acquire streaming content:

• Direct (via Furnace v6.3)
• URL (via Makito)

Streaming Direct 

This section provides instructions for playing a live stream on a CoolSign display. 

NOTE
You can configure the player into multiple reqions if you want to show the live feed in only 
a section of the screen. See “Configuring Multi-Region Players” on page 185.

Furnace Setup

For information on how to set up an output stream, please refer to the Furnace product 
documentation available from the Haivision Download Center (www.haivision.com/down-
load-center).

• Follow the instructions in the Furnace Quick Start Guide to power on the unit and log 
in to the Web Interface.

• Refer to the Furnace User’s Guide or the online help (available from the Web 
Interface) for instructions on how to configure a Furnace Encoder to provide an FEC 
stream to a CoolSign Player.

IMPORTANT
The Furnace device should be on the same subnet as the player.
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Content Acquisition

Once the Furnace Encoder is configured, its output video stream can be displayed on a 
CoolSign Player Node across the LAN or Internet, as determined by the Network Admin-
istrator.

To stream content from a Furnace source: 

1. Open the Network Content Manager and click the Content icon in the navigation 
sidebar.

2. From the Actions menu, select the option CREATE STREAMING CONTENT...
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3. For the Source Type field, verify that the Haivision FURNACE [Default] drop-down 
menu item is selected.
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4. Provide the appropriate Furnace information in the remaining fields on the page and 
then click the Apply button.

NOTE
This field is comprised of the UDP address and port.
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5. Switch to the General tab and define the content Name and Duration fields.

6. Click the OK button. At this point, the content can be scheduled into a channel like 
any other CoolSign content. See “Adding Items to a Channel” on page 139.

Streaming via a URL

This section provides instructions for configuring the Haivision Makito H.264 encoder to 
stream to a CoolSign Player. 

Makito Setup

For information on how to set up an output stream, please refer to the Makito product docu-
mentation available from the Haivision Download Center (www.haivision.com/download-
center).

• Follow the instructions in the Makito Quick Start Guide to power on the unit and log 
in to the Web Interface.
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• Refer to the Makito User’s Guide or the online help (available from the Web Interface) 
for instructions on how to configure a Makito Encoder to provide a stream to a 
CoolSign Player.

Content Acquisition

Once the Makito Encoder is configured, its output video stream can be displayed on a 
CoolSign Player Node across the LAN or Internet, as determined by the Network Admin-
istrator.

To stream content from a Makito source: 

1. Open the Network Content Manager and click the Content icon in the navigation 
sidebar.

2. From the Actions menu, select the option CREATE STREAMING CONTENT...
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 83



4. About Content 
Using Streaming Content
3. For the Source Type field, use the drop-down menu to select URL.
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4. In the next field, provide the Source URL information and click Apply.

NOTE
This field is comprised of the UDP address and port.
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5. Switch to the General tab and define the content Name and Duration fields.

6. Click the OK button. At this point, the content can be scheduled into a channel like 
any other CoolSign content. See “Adding Items to a Channel” on page 139.

Working with Templates

Templates are a great way to kick start your content collection. A template allows you to 
produce multiple pieces of content with the same layout quickly. You use the web-based 
interface (WUI) to create an instance, or copy, of the template for editing. Then you modify 
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that instance to create a new piece of content. Typically, modifying an instance involves 
updating data fields with new text and graphics. 

NOTE
Templates are created in the Content Creator tool. Refer to the Content Creator 
documentation for more information.

Locating Available Templates

NOTE
Once a template is created with the Content Creator, it is available for use. You create an 
instance of the template using the web-based interface so you can modify it to create a 
new piece of content.

To locate a template: 

Using the CNM 

1. Click the Content icon in the navigation sidebar to access the Content Manager. Any 
listing in blue is a template.

2. Click the Content Templates quickset filter to view only the availabel templates.

The templates are 
listed in blue. 
Above the selected 
template, you can 
see an instance of 
that template that 
is listed as a piece 
of content (in 
black).

Using the WI 

Click the Templates tab along the top of the web-based interface.
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Creating a Template Instance

When working with templates, you first create a new instance of the template and then 
modify the content elements (such as text or graphics) — not the layout. For example, a 
basic template might have a headline at the top of the layout with a picture beneath it. Each 
instance of the template could have a different heading and picture, but the layout would 
remain the same with the heading at the top and the picture beneath. Each instance, once 
modified, becomes a new piece of content that can be scheduled and played. 

NOTE
To create an instance from a template, use the web-based user interface (WUI).

To create a piece of content using a template:

Using the WI 

1. Click the Templates tab. 

2. Double-click the template that interests you. 

3. Enter a name for this instance of the template in the Name field.

4. Fill out the available data fields with the text and graphics that you want.

5. Click Create.

The instance is now a piece of content that can be scheduled like any other content.

NOTE
Templates are used to create only one piece of content at a time. You cannot add 
additional rows to the data table. If you are creating a series of ads, you must create 
multiple instances, modify them, and add them individually to the channel.

Editing Content that was Created from a Template

When revising data in a piece of content that you created from a template, use either the 
graphical user interface (GUI) or web-based interface (WUI).

To edit a piece of content that was created using a template:

Using the CNM 

1. Click the Content icon in the navigation sidebar.

2. Double-click the content that you want to revise. 

3. In the Content Properties window, click the Dynamic Data tab.
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4. Click on the appropriate data fields to make your revisions.

5. When finished, click OK.

Using the WI 

1. Click the Library tab. 

2. Double-click the piece of content that you want to revise. 

3. Edit the appropriate data fields to make your revisions.

4. When finished, click Save Changes.

Deleting a Template

NOTE
You use the CoolSign Network Manager graphical user interface (GUI) to delete an 
existing template. It is not possible to delete a template from the web-based user interface 
(WUI). 

To delete a template:

Using the CNM 

1. Click the Content icon in the navigation sidebar to open the Content Manager. 

2. Locate the template that you want to delete. Use the Content Template quickset filter 
to simplify the search if necessary.

3. Right click on the listing you want to remove, and select DELETE from the pop-up 
menu.

4. When prompted to verify, click Yes.
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The CoolSign Content Wizard guides you through a series of steps to convert your digital 
media assets into content that can be played back on a CoolSign Digital Media Network. 
At any point, you can click the Prev button to return to previous steps.

Starting the CoolSign Content Wizard

To start the CoolSign Content Wizard: 

1. Browse to the CoolSign directory and open the Content Wizard folder.

2. Double-click the ContentWizard.exe to open the tool.

Converting Content

Step 1: Choose Asset(s) to Convert

Determine the media assets that you want to create into CoolSign content. You can convert 
a single asset into CoolSign content,configure video capture, or batch convert multiple 
assets.
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To convert a single asset into CoolSign content:

1. Select the CONVERT SINGLE ASSET radio button.

2. Click Browse to locate the asset file you wish to convert. 
If you are converting a Flash asset that needs to load external files (such as images) at 
run time, make sure that the external files are in the same folder as your Flash asset, or 
in one of its subfolders. For example:
ContentFolder\ (root folder) 

ContentFolder\myFlash.swf (the asset that you’re converting) 
ContentFolder\Image\background.jpg 
ContentFolder\Image\banner.jpg

3. Click Finish to complete the content creation process. 
The Content Wizard prompts you as to whether or not you want to include all files in 
the ContentFolder folder and its subfolders (in this example, background.jpg and 
banner.jpg). After you confirm your choice, the two image files are packaged with 
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the Flash asset, resulting in a single piece of CoolSign content.

NOTE

Do not include any unrelated files in the folder that contains your Flash assets. If the 
content folder (or any of its subfolders) contains any unrelated files, they are included 
into your content and eventually imported to the network as well.

NOTE

For this reason, avoid importing Flash content from the desktop. Attempting to do so 
causes the entire contents of your desktop to be imported as well.

To configure video capture:

1. Select the CONFIGURE VIDEO CAPTURE radio button.

2. Click Browse to locate the asset file you wish to convert. 

To batch convert multiple assets into CoolSign content:

1. Select the Batch convert multiple assets radio button.

NOTE

If you select this button, you cannot include external files for a Flash asset, as 
described above.

2. Do one of the following:
• Click Add All Assets in Folder to recursively add all the assets located in a spe-

cific folder and subfolders to the batch list.
• Click Add Asset to add a single asset to the batch list.
• Click Remove Asset to remove a selected asset from the batch list.

3. When you’ve added all the assets you want to batch convert, click Next to proceed to 
the Set Options step.
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Step 2: Set Options

In this step, you can set properties regarding your content and preview how your content 
looks on different types of displays.

Setting Content Properties

You can set the following properties for your content:

Name—Set the name of this content as you wish it to appear in the CoolSign Network 
Manager. The default name is the name of the imported asset.

NOTE
With multi-file Flash assets, be sure to specify a legal folder name, so that multi-file Flash 
content will work properly.

Format—The format is automatically set based on the aspect ratio of the imported asset. 
You can change the format if the auto-detected value is incorrect. Once imported into 
CoolSign Manager, you can only schedule this content into channels with the same format.

Use Legacy Flash Player (enabled only for assets that are Flash 4 or earlier)—When 
checked, provides backward compatibility for SWF files that are Flash 4 or earlier.

Duration—You can adjust the length of time for which the content plays. If the content 
includes video or Flash assets, setting the duration to less than that of the video cuts off the 
video playing. Setting the duration to longer than that of the video asset causes the video to 
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hold on the last frame for the remainder of the content play. If the Set Duration to Asset 
Duration box is checked, the Duration field is greyed out.

Set Duration to Asset Duration—This checkbox is enabled only when digital video or 
Flash assets are being converted. Checking this box automatically sets the duration of the 
content to match the duration of the imported asset.

If the duration is set to within 0.1 of a second, it is rounded off to a the nearest second. For 
example, if the duration is any value between 9.90 and 10.1, it is rounded to 10 seconds. 
This is done to avoid unexpectedly strange values in the duration field.

Volume Gain—You can use volume gain to modify the overall volume level of all video, 
flash, or sound assets used in the content. The value can be between -100 and 100, with 0 
being the normal, unmodified volume level of the assets. You can use volume gain to 
normalize the volume of your content in relation to each other so that no one content item 
is softer or louder than the others.

Transition—You can set a transition effect and duration that is used to transition into the 
CoolSign content when played back.

Setting Asset Properties

Resolution—The horizontal and vertical resolution of your content in pixels.

Pre-rotation—Rotation of the asset in degrees.

Show Transparency (enabled only for Flash assets)—When checked, whatever areas of 
the Flash file were designated to be transparent are rendered with a transparent background. 
Checking this box has no visible effect if the Flash file contains no transparency.

Timeless (enabled only for Flash assets)—When set, CoolSign Player ignores the Flash 
asset's timeline.

Setting Content Resize Settings

Use these settings to define how the content should be displayed on players that are of 
different resolution than the selected content. The preview window automatically updates 
to reflect the content resize settings so you can dynamically preview the options. The 
following options are available:

• Scale Content To Fit—Scales content to fit the resolution of the player the content is 
scheduled on. If the aspect ratio of the player does not match the content’s aspect ratio, 
the content is stretched non-linearly to fill the player unless Preserve Aspect Ratio is 
checked.

• Preserve Aspect Ratio—Forces scaled content to preserve its original aspect ratio 
when played on players with different resolutions and aspect ratios than the content’s. 
The behavior of this checkbox is further defined by the following radio buttons:
• Crop edges of content—When scaling to fit, the content is scaled linearly until the 

smaller of the content’s width or height matches the smaller of the player’s width 
or height. This can result in pixels being cropped off the edge of the player.
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• Letterbox content—When scaling to fit, the content is scaled linearly until the larg-
er of the content’s width or height fits into the player’s width or height. The empty 
area that remains is black.

Setting Content Activation and Expiration

Content can be set to activate and/or expire at a certain date and time.

• Content Activation—Restrict when content is available to start playing. Content can 
be scheduled at any time but if its activation date is set to something other than Now, 
it does not play until the current date and time is past the set date.

• Content Expiration—Automatically delete content after the specified date and time. 
Content that has expired is deleted from a CoolSign network, including any players it 
was scheduled on, and moved to the Content Recycle Bin. All schedule and play 
history is lost when the content expires.

Previewing Content

The Preview content window displays a preview of your content and how it looks on 
different display types. 

Access the Preview Content 
window from the Options 
drop-down menu.

You can select different pre-defined display types or define your own custom resolutions. 
You can adjust the content’s resize properties to make sure you have the correct settings to 
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ensure that your content looks correct across different display types. If you didn’t install 
Direct X, you cannot review content.

NOTE
The Display type and Resolution settings are used for previewing only. They do not affect 
your content settings in any way.

To select a display to preview your content on:

1. Click the OPTIONS menu to open the Preview Options popup menu.

2. Do one of the following:
• Select a pre-defined display type from the Display type pull-down menu. The ap-

propriate resolution is automatically set and the preview window is updated to re-
flect your choice.

• Enter custom x and y resolutions into the Resolution fields. The preview window 
is updated to reflect your values.

3. Use the transport buttons to control playback and looping of the content preview.
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Step 3: Select Thumbnail

In this step, you can select a thumbnail image for your asset.

NOTE
If you are batch-converting multiple assets, a thumbnail for each content is automatically 
selected from a frame a few seconds from the end of the asset.

To select a thumbnail image for your content:

1. Using the content preview transport buttons or the time slider, set the preview to the 
frame of the asset you would like to use as a thumbnail.

2. Click Set thumbnail to current frame and the selected thumbnail image appears in 
the Thumbnail area. 

-or- 
Click Browse to locate an image file that you wish to use as a thumbnail for this asset. 
The image must be in one of the following formats: JPEG (*.jpg), Windows Bitmap 
(*.bmp), or Portable Network Graphics (*.png).

3. Use the Options button to preview how the thumbnail will render on a variety of 
monitor types at various resolutions.
When you’re done, click Next.
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Step 4: Create

In this step, you set the destination folder where your converted CoolSign content should 
be saved, along with some other settings.

Copying or Moving Asset Files

By default, when your content is created, the Content Wizard creates a copy of your 
imported asset and leaves the original file intact. If you are batch-processing a large number 
of assets and the destination folder is on the same hard drive as the original files, you can 
select Move asset file to output folder to force the Wizard to move the original file instead 
of copying it. This makes the batch process much faster.

NOTE
You should always keep a separate backup of your original assets.

Selecting a Folder to Save Your Content In

Before you can finish converting your asset into CoolSign content, you must select a desti-
nation folder in which to save the converted content.

To do so, click Browse to select a desired folder.
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Importing Content into a CoolSign Network

If you want the Content Wizard to import your content directly into the CoolSign network, 
check the Import created content into a CoolSign network box. Using the radio buttons, 
indicate the action to take if there is already content with the same name as the content you 
are importing.

NOTE
To import content directly from the Content Wizard, you must have Write Content 
capability. For details, see 21. "About Security" on page 316 in the 1.

When the CoolSign Manager login dialog appears, enter your user name and password and 
select the CoolSign network where you wish to import the content.

After verifying your login credentials, the Content Wizard imports the content into the 
CoolSign network, then disconnects you from the CoolSign network.

Completing the Content Wizard

After completing each step in the wizard, click Finish to convert the selected asset(s) into 
CoolSign content. The wizard creates your content in the destination folder ready for 
import into a CoolSign network. For more information, see “Managing Content” on 
page 100 of the 1.
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CNM provides a rich set of features to help you organize and manage the content in your 
CoolSign network. You can use CNM to stream, import, or update content; modify content 
properties like duration, transitions, scaling and volume; review play history and sched-
uling statistics; and even preview the content as it will appear on your CoolSign players.

Working with Content

Importing Content

Content in CoolSign must be imported into the system before it can be scheduled or played 
on the CoolSign players connected to your network.

To import content into your CoolSign network:

• From the Content Manager, choose ACTIONS > IMPORT CONTENT and select the content 
folder you wish to import. Note that you can also batch import content by selecting a 
folder that contains multiple content folders.

The Content Import dialog shows the progress of any current and pending content imports.
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If content already exists with the same name as the content you are importing, an alert 
dialog will ask you if you want to replace or rename the imported content. Similarly, if the 
content that is importing contains a data table that is named the same as an existing data 
table, then a warning appears. You can then choose "Replace" or "Keep". 

If you select “Replace”, the old data table is deleted and a new data table is created, which 
means:

1. All the data is lost.

2. Any content currently binding to that data table will no longer have a binding table 
attached to it. Instead, you’ll have to rebind it manually.
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TIP
You can continue working with CNM while the import occurs in the background or you can 
queue up additional imports by repeating these steps.

TIP
You can also import content folders by dragging and dropping them from the Windows 
desktop directly into the Content Manager data grid or onto the Content Manager icon. 
You can drag multiple folders at once or drag new folders one at a time.

Using Template-Based Content

Templates are a new feature in CoolSign 5.1. Templates can only be created using the 
Content Creator tool (see the Content Creator User’s Guide for more information). Several 
default templates are provided by default. 
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 102



6. Managing Content 
Working with Content
To use a template to create new content, you use the Web Interface (WI). See “Creating 
Content Based Upon a Template” on page 68.

Locating Available Templates

Once a template is created with the Content Creator, it is available for use. You create an 
instance of the template using the web-based interface so you can modify it to create a new 
piece of content.

To locate a template: 

1. Click the Content icon in the navigation sidebar to access the Content Manager. Any 
listing in blue is a template.

2. Click the Content Templates QuickSet filter to view only the available templates.

Templates are listed in blue. Above a selected template, you can see an instance of that 
template that is listed as a piece of content (in black).

Deleting a Template

You use the CoolSign Network Manager (CNM) to delete an existing template. It is not 
possible to delete a template from the web-based user interface (WI). 

To delete a template using CNM:

1. Click the Content icon in the navigation sidebar to open the Content Manager. 

2. Locate the template that you want to delete. Use the Content Template QuickSet 
filter to simplify the search if necessary.

3. Right click on the listing you want to remove, and select DELETE from the pop-up 
menu.
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4. When prompted to verify, click Yes.

Using Web-Page Content

You can display internet web pages on a CoolSign player.

To display web page content: 

1. Open the Network Content Manager and click the Content icon in the navigation 
sidebar to open the Content screen.

2. From the Actions menu, select the option CREATE WEB CONTENT...

3. For the Site URL field, enter the internet address (URL) for the site that you want to 
display and click the Apply button.
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4. Switch to the General tab and define the content Name and Duration fields.

5. Click the OK button. The web site content will appear in the Content pane.
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6. At this point, the content can be scheduled into a channel like any other CoolSign 
content. See “Adding Items to a Channel” on page 145.

Streaming Content

There are two ways to acquire streaming content:

• Direct (via Furnace v6.3)
• URL (via Makito)

Streaming Direct in CoolSign from a Furnace Device

Before you can stream content from your Furnace device, you must configure it. Refer to 
C. "Configuring Devices to Stream Content", on page 375. Make sure to make note of the 
following information regarding your Furnace device:

• Furnace Server URL (comprised of the UDP address and port)
• User name (with admin privileges) 
• Password
• Furnace Consumer Key
• Furnace Consumer Secret

Once the Furnace Encoder is configured, its output video stream can be displayed on a 
CoolSign player node across the LAN or Internet, as determined by the Network Adminis-
trator.

To stream content from a Furnace source: 

1. Open the CoolSign Network Manager (CNM) and click the Content icon in the 
navigation sidebar to open the Content screen.

2. From the Actions menu, select the option CREATE STREAMING CONTENT...
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3. For the Source Type field, verify that the Haivision FURNACE [Default] drop-down 
menu item is selected.

4. Provide the appropriate Furnace information in the remaining fields on the page (see 
C. "Configuring Devices to Stream Content", on page 375) and then click the Apply 
button. 
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5. Switch to the General tab and define the content Name and Duration fields.

6. Click the OK button. 

At this point, the content can be scheduled in a channel like any other CoolSign content. 

Streaming a URL in CoolSign from a Makito Device

Before you can stream content from your Makito device, you must configure it. Refer to C. 
"Configuring Devices to Stream Content", on page 375. Make sure to make note of the 
following information regarding your Furnace device:

• Makito Source URL (comprised of the UDP address and port)

To stream content from a URL source:

1. Open the CoolSign Network Manager (CNM) and click the Content icon in the 
navigation sidebar to open the Content screen.
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2. From the Actions menu, select the option CREATE STREAMING CONTENT...

3. In the Content Properties dialog window, click the Source Type drop-down menu and 
select the URL menu item.

4. Enter the Source URL data to which the Makito is streaming and click the Apply 
button.
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5. Switch to the General tab and define the content Name and Duration fields.

6. Click the OK button. 

At this point, the content can be scheduled in a channel like any other CoolSign content. 

Updating Content

Once imported, the assets within your content are locked down and can no longer be 
modified from within the system. If you modify either the content script or the assets within 
your content, you must re-import to update the existing content. If the content you are 
updating has been scheduled, CoolSign will automatically update the content on those 
players where it has been scheduled, including transferring any required files.

Exporting Content

You can export content that has been imported into CNM if you need to modify the content 
externally or transfer it to another network. 
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To export content from your CoolSign network:

1. In the Content Manager data grid, select one or more content items that you wish to 
export.

2. Choose ACTIONS > EXPORT CONTENT.

3. Select a destination folder from the Browse for Folder dialog.

4. Click OK. A content export progress dialog will appear.

NOTE
You should always back up your content externally from CoolSign in case you experience 
any issues that result in loss of data or corruption.

Duplicating Content

You can duplicate content that has been imported into CNM.

To duplicate content from your CoolSign network:

1. In the Content Manager data grid, select one or more content items that you want to 
duplicate.

2. Choose ACTIONS > DUPLICATE CONTENT or right-click and choose DUPLICATE 
CONTENT.

3. Enter a name for the duplicated content. If you are duplicating multiple content items, 
a default name, Copy of [content name], is used.

Deleting Content

If you no longer plan to use a content item, you may choose to delete it from the network. 
Deleted content is immediately removed from any channels or playlists and ceases 
playback on all players where it is scheduled. 

WARNING
Previous versions of CNM provided a recycle bin from which you could recover 
deleted content. This functionality is no longer available in CNM. Deleted content 
cannot be recovered. Be sure that you have a backup of your content outside of the 
system. If you want to export your content from the system before deleting, refer to 
the above section on Exporting Content.
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To delete content:

1. In the Content Manager data grid, select the content you want to delete. You can 
select multiple items.

2. Do one of the following:
• Choose EDIT > DELETE.
• Right-click and choose DELETE.
• Press the Delete key on your keyboard.

Using the Content Properties Dialog

The Content Properties dialog allows you to modify certain properties of selected content 
and to view useful information about how your content is scheduled and how many times 
it has played.

To display the Content Properties dialog:

Do one of the following:

• Select the content item in the Content screen and choose ACTIONS > EDIT CONTENT 
Properties.

• Double-click the content item.
• Right-click on the content item and choose EDIT CONTENT PROPERTIES.

Editing Content Properties

After importing, you may find it necessary to modify one or more properties of your 
content. Rather than having to change the content externally and reimport, you can adjust 
many of the content’s properties directly from the Content Properties dialog. 

NOTE
You can only modify properties of the content item itself. You cannot edit or change the 
individual assets used within the content. If you want to modify an asset (for example, 
change a bitmap or edit an MPEG-2 video), you must re-import the entire content item to 
replace the existing item in CoolSign.
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To edit the properties of a content item:

1. From the Content Properties dialog, change one or more of the content properties.

2. Click OK or Apply Changes. Changes are immediately applied to the selected content 
and on any players where the content is scheduled.

NOTE
Content is only updated on players that are currently online. If a player is offline, it will 
automatically receive any updates to modified content as soon as it comes back online.
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In the Content Properties dialog, the General tab allows you to view and/or modify the 
following properties of the selected content:

Name—The content’s name is used wherever the content is referred to, including 
playlogs and scheduled items.
Version—Each time the content is modified or updated, the version number is incre-
mented. 
Format—Displays the player format that this content was authored for. Content can 
only be scheduled in regions that match their format. This value cannot be modified.
Resolution—Displays the pixel height and width at which the content was authored. 
Size—Displays the total size of the content including all its assets.
Duration—Use this property to adjust the length of time for which the content plays. 
If the content includes video or flash assets, setting the duration to less than the video’s 
duration will cut off the video playing. Setting the duration to longer than a video as-
set’s duration will cause the video to hold on the last frame for the remainder of the 
content play.
When the content contains a data panel and is set to Auto-fit duration, the duration can-
not be adjusted and will display "Dynamic duration". The duration is determined by 
the number of rows of its binding data table.
Volume Gain—Use volume gain to modify the overall volume level of all video, 
flash, or sound assets used in the content. The value can be between -100 and 100 with 
0 being the normal, unmodified volume level of the assets. 

NOTE
You can adjust the overall volume of player from the Player Properties dialog. You only 
need to adjust the volume gain if you want to “normalize” the volume of a content item 
relative to the other content.

WARNING
You can only control the volume of SWF files that are version 8 or older. With SWF version 
9 files, it is not possible to control the player volume from CoolSign. 

Transition—Allows you to set the effect that is used to transition from the previously 
playing content into the selected content. In general, transitions first change to the tran-
sition color and then into the next content item. (If the transition type is FadeToBG, 
Cut, or CrossFade, the color property is ignored.)
Transition Length—Use to set the number of seconds in which the transition will oc-
cur (defaults to one second).
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Setting Content Resize Settings

In the Content Properties dialog, you use the Content Resize settings to define how the 
content should be displayed on players. The options are as follows:

Scale content to fit—Scales content to fit the resolution of the player the content is 
scheduled on. If the aspect ratio of the player does not match the content’s aspect ratio, 
the content is stretched non-linearly to fill the player unless Preserve Aspect Ratio is 
checked.
Preserve aspect ratio—Forces scaled content to preserve its original aspect ratio 
when played on players with different resolutions and aspect ratios than that of the con-
tent. The behavior of this checkbox is further defined by the following radio buttons:

Crop edges of content—When scaling to fit, the content is scaled linearly 
until the smaller of the content’s width or height matches the smaller of the 
player’s width or height. This may result in pixels being cropped off the edge 
of the player.
Letterbox content—When scaling to fit, the content is scaled linearly until 
the larger of the content’s width or height fits into the player’s width or height. 
The empty area that remains will be black. 
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The following images show how a 320x240 MPEG-1 on a 848x480 display screen would 
appear with the different available content resize settings:

TIP
As a general rule, you should turn on Scale content to fit display and turn off 
Preserve aspect ratio. This ensures that the content always fills the screen regardless 
of the resolution and aspect ratio of the display device you are using.
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Setting Content Activation and Expiration

You can use the content activation and expiration properties to globally control when 
content is enabled to play across all of your channels and players. 

Content Activation

You can use content activation to set a date and time when the content should be enabled 
to start playing.

TIP
You can use content activation if you want to schedule some content immediately so it is 
transferred to your players but you don’t want it to start playing until a specific date and 
time. Content activation allows you to control the activation date globally across all 
channels and playlists, instead of within each individual schedule.

To set the activation date of content:

1. Click the Activates At radio button.

2. Click the Activation Date Editor to edit the activation date at which the content can 
start playing.

To set content to be active now:

• Click the Activates Now radio button.

Content Expiration

You can use content expiration to set a global date and time for your content to stop playing 
everywhere regardless of its scheduling properties. When content expires it is automatically 
removed from all channels and playlists across your network. 

To set the expiration date of content:

1. Click the Expires At radio button.

2. Click the Expiration Date Editor to edit the expiration date at which the content 
should stop playing.
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To set content to never expire:

• Click the Expires Never radio button.

WARNING
In CoolSign 4, expired content is not automatically deleted but is displayed in the Content 
Manager in red to indicate that it is expired. If you want to remove the expired content, you 
must manually delete it.

Previewing Content

You can preview your content as it will play back in a CoolSign player directly from the 
Content Properties dialog. 

To preview content:

In the Content Properties dialog, click the Preview Content button.

NOTE
When you first preview a content item, the asset files required for that content are 
transferred from the CoolSign Network Controller and cached in a temporary folder in your 
CNM installation directory. When you preview a portion of dynamic content binding to a 
data table, that contains more than 20 rows, you can only preview the first 20 rows.

WARNING
Content preview is only supported on PCs that meet the minimum requirements for a 
CoolSign player. Older PCs or unsupported video cards may not be capable of content 
previewing.

Setting the Thumbnail Image for Content

You can set the thumbnail image displayed in the Content Manager grid and in the Content 
Properties dialog when you are previewing the content.

To set the thumbnail for content:

1. In the Content Properties dialog, click the Preview Content button.

2. Use the preview content transport controls to pause the preview on the frame you 
want to use for your thumbnail. You can use the frame advance and rewind buttons to 
fine-tune the frame to use.

3. Click the Set Thumbnail to Current Frame button.
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Adding Comments to Content

You can add comments to any content item if you want to track additional information 
about the content. When you add a comment, the user who entered the comment and a 
timestamp is automatically added.

To add a comment:

Click the Add button beneath the comments grid and enter your comment into the field 
provided.

To remove a comment:

Select the comment in the comments grid and click the Remove button.

Viewing Information About Content

You can use the Content Properties dialog to view information about your content. For 
example, you can review where your content is scheduled, any issues that the content may 
be having, and retrieve play history reports for the content.

Viewing the Assets Used Within Content

You can view the names of the asset files that are part of a content item from the Assets 
tab of the Content Properties dialog.

To view the assets used within a content item:

From the Content Properties dialog, select the ASSETS tab.

To edit the control script for a content item:

1. In the Assets tab of the Content Properties dialog, click the Edit Control Script 
button.

2. In the Edit Control Script dialog, make any desired changes to the control script 
XML.

3. Click OK to close the dialog.

4. Click OK or Apply Changes to save your changes.

NOTE
You should only attempt to edit the control script of content if you are familiar with hand-
editing content scripts. Invalid content scripts will result in content errors and will prevent 
your content from being played.CoolSign
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Viewing Where Content is Scheduled

You can quickly view all the channels and players where a selected piece of content is 
scheduled from the Schedule Info tab of the Content Properties dialog.

Retrieving Play History for Content

You can retrieve the play history of one or more selected content items from the Play 
History tab of the Content Properties dialog. Play history provides a summary of the 
number of times a piece of content has played on each player it is scheduled over a period 
of time.
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To retrieve the play history for content:

1. From the Play History tab of the Content Properties dialog, select the View Range for 
which you wish to retrieve the content’s play history. Alternatively, you can manually 
enter the From and To dates, using the date and time editors.

2. Set one or more of the following options:

• To include daily play summaries, check Include day by day breakdown.
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• To only show plays that occurred while the site was open, check Only show logs 
from during site business hours. This option can also significantly increase the 
amount of time required to retrieve the logs.

TIP
For more information on sites and defining site business hours, see “Setting the 
Hours for a Site” on page 204.

• To show all the players on your network, including those on which the content 
didn’t even play, check “Show 0-play Players”.

3. Click the Retrieve Logs button.

NOTE
Retrieving playlogs for view ranges of over a week or for large networks can sometimes 
take a few minutes to complete. 

To export the play history logs to a file:

1. Right-click on the column header of the Play History grid and choose SAVE GRID 
DATA TO FILE...

2. In the Export to File settings dialog, select the File format you would like to export to 
and set any available options.

3. Click OK.

To print the play history logs:

Right-click on the column header of the Play History grid and choose PRINT GRID...
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Using the Attributes Tab

You can define your own custom attributes for content if you want to track specific infor-
mation with each content item. For example, you may want to add a Client field so you can 
track the name of the client within a media advertising network. Attribute fields can be 
displayed within your views in the Content Manager and used within searches or Quick-
Searches.

Using Enabling Expressions

Enabling expressions can be used to dynamically control when a player’s content plays or 
doesn’t play, in other words, determine when or if content plays. You can use enabling 
expressions to tie into dynamic Data Tables, Player Attributes (formerly Node Attributes), 
Content Attributes and Site Properties to create complex behaviors not only from a player 
node level but also from a site-level. The following sources and data tables can be used to 
create these behaviors:

NOTE
Attributes can only be used to help organize and manage content within CNM. You cannot 
access the attributes as dynamic data or to display within content playback.
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To add an Attribute to content:

1. From the Content Properties dialog, click the ATTRIBUTES tab.

2. From the ATTRIBUTES tab on any Content Properties dialog, click the Define 
Attributes button.
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3. In the subsequent Attributes dialog, click the Add button to open a blank Attribute 
Properties dialog.

4. Type a name for the new Attribute.

5. Set one or more of the following options:
• If you want to restrict the options available for input, click the Use picklist check-

box.
• Enter one or more lines of text into the PickList box. Each line of text will appear 

as an option in the picklist when editing a user field.

6. If you want to let users enter their own data in addition to being able to choose from 
the options in your picklist, click the Allow user to enter custom values 
checkbox.Click OK. The new Attribute will be added to all existing and new content.

To attach a player Attribute:

If you want an attribute on your content to match the schema of an attribute on your player, 
you can attach the existing player attributes instead of re-defining it as a new content attri-
bute. This is helpful if you are comparing the values of both attributes in an enabling 
expression, for example, and you want to make sure the schema for both attributes always 
matches.

To edit the value of a custom Attribute for content:

1. From the ATTRIBUTES tab of the Content Properties dialog, edit one or more of the 
Attributes.
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2. Click OK or Apply Changes to save your changes.

Working with Dynamic Content

Dynamic content is content that is defined with one or more placeholder fields that can be 
filled with data from a CoolSign data table when the content is played back. You can use 
dynamic content to update information or assets within content without needing to modify 
the original content assets or script. For example, you can create dynamic content that 
displays the current weather and updates instantly when weather conditions change. Or you 
can create dynamic content that displays product descriptions, prices, and even pictures.

Display dynamic data 
pulled from fields in a 
CoolSign data table.

Use content expressions to 
control asset properties like 
visibility, position, and color.

Dynamically display media 
assets from a data table 
including images, video or 
flash.

Use attributes to localize con-
tent to display information 
specific to the player on 
which the content is playing.

Sample dynamic content

CoolSignCoolSignCoolSign

For more information on dynamic data, see “About Dynamic Data” on page 207.

About the Dynamic Data tab

When you are editing the properties of dynamic content, the Content Properties dialog 
includes a Dynamic Data tab in which you can view the current data table binding for 
dynamic content. You can use the Dynamic Data tab to change data table bindings, edit 
static bindings, and modify advanced data slot properties like enabling data slot logging.

Binding Dynamic Content to a Data Table

Content that references the data in a data table is said to be “bound” to the data table. 
Binding content to a data table lets CoolSign know that the data table is required wherever 
that content is scheduled.
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Select a data table to 
bind content to from 
this data table pull-

You can directly edit the data 
in a data table here instead 
of from the Data table tab.

Click here to edit 
advanced properties of 
the content bindings. Click here to edit the pre-

script expression for this 
content.

To bind dynamic content to a data table:

1. From the Content Properties dialog for your content, select the DYNAMIC DATA tab.

2. Choose the data table you want to bind your content to from the “Set data table” pull-
down menu. 

NOTE

The pull-down menu only lists data tables that match the field structure defined within 
the content. If you want to bind the content to a data table that doesn’t appear in the 
list, hold down the Ctrl key while clicking on the pull-down menu to list all the data 
tables in your network.

WARNING

Binding content to a data table that doesn’t contain fields required by the content will 
most likely result in a content error when trying to play back the content.

3. Click OK or Apply Changes.
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You can override data table bindings when you schedule so that the same piece of content 
could be bound to different data tables depending on where it is scheduled. For more infor-
mation on overriding data table bindings at schedule time, see “Overriding Dynamic Data 
Settings” on page 181.

Enabling Data Slot Logging

CoolSign content uses data slots to internally connect data fields to fields within a bound 
data table. Normally, you don’t need to worry about the properties of a data slot, because 
CNM  complexity from you. However, there is one option for the properties of a data slot 
that can be useful to enable under certain conditions: data slot logging. By default, the 
detailed play logs for a player only include when and why content played. For dynamic 
content, you can also track the value of one or more of the dynamic data fields used in the 
content. With this feature enabled, you can retrieve a full audit history for your dynamic 
content including the actual values of any data at the time of each play.

For more information on retrieving detailed play logs, see “Viewing Detailed Play Logs for 
a Player” on page 177.

To enable data slot logging:

1. From the DYNAMIC DATA tab, click Edit Advanced Properties.

2. For each data slot that you want to log data, check Log Data.

3. Click OK.

NOTE
Logging data slot values can dramatically increase the size of your play history logs. You 
should only enable data slot logging if you need an audit history for the dynamic content.
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In addition to the Content page, CNM includes a specialized manager page for working 
with audio-only content. If you plan to use CoolSign to drive an audio-only player or create 
a special audio region on a player, you can use the Audio page to import and manage audio 
content. The Audio page lets you organize your audio content using the more intuitive cate-
gories of Artist, Title, and Album instead of a single content name.

Creating Audio Content 

Unlike standard visual content, you can create the audio content by importing supported 
audio files directly into the CNM Audio page without needing to run them through the 
CoolSign Content Wizard or other tools. When importing an audio file, CNM reads the 
MP3 ID3 tags embedded in the file and uses them to create the audio content in CoolSign.

NOTE
The Audio manager currently only supports MP3 files with ID3v1 tags. Certain applications 
(notably iTunes) only apply IDv2 tags, requiring you to use a third-party application to set 
the ID3v1 on the file. 
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To create audio content:

1. Choose ACTIONS > IMPORT AUDIO.

2. Select an MP3 file using the file browser dialog.

3. Click OK to import the MP3 and create audio content.

TIP
You can also directly import MP3 files by dragging and dropping them from the desktop 
into the Audio page grid.

Editing Audio Content Properties

You can edit the properties of audio content on the Audio Properties dialog.
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To edit the properties of audio content:

1. To display the Audio Properties dialog, do one of the following:
• Select the Audio content in the Audio page and choose ACTIONS > EDIT AUDIO 

PROPERTIES.
• Double-click the Audio content in the Audio grid.
• Right-click the Audio content and choose EDIT AUDIO PROPERTIES.

2. Review or change any of the following properties:
Filename—Displays the original audio filename imported into CNM. You cannot 
modify the filename.
Artist, Title, Album, Year—These properties are read from the ID3v1 tags embed-
ded into the MP3 file at import. You can modify these properties as desired.
Duration—The amount of time that the audio content plays for. Entering a duration 
that is less than the actual length of the imported MP3 will truncate playback. Extend-
ing the duration beyond the length of the MP3 will play silence.
File Size—The disk space used by the imported MP3 file.
Volume Gain—Use volume gain to modify the overall volume level of all video, 
flash, or sound assets used in the content. The value can be between -100 and 100, with 
0 being the normal, unmodified volume level of the assets. 

NOTE
You can adjust the overall volume of the player from the player properties dialog. You only 
need to adjust the volume gain if you want to “normalize” the volume of a content item 
relative to the other content.

WARNING
You can only control the volume of SWF files that are version 8 or older. With SWF version 
9 files, it is not possible to control the player volume from CoolSign.

Activation/Expiration Date—You can use the activation and expiration date to set 
when your audio content is able to play back in any channels or playlists. For more in-
formation, see “Setting Content Activation and Expiration” on page 117.

3. Click OK or Apply Changes.

 Viewing Information about Audio Content

You can use the QuickSets, Schedule Info, and Play History tabs to view or retrieve addi-
tional information about how your audio content is organized, scheduled, and how often it 
has played. The use of these tabs is identical to the Content Properties dialog.
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• For more information on managing QuickSets, see “Using QuickSets” on page 30.
• For more information on viewing content schedule info, see “Viewing Where Content 

is Scheduled” on page 120.
• For more information on retrieving content play history, see “Retrieving Play History 

for Content” on page 120.

Scheduling and Playing Audio Content

CoolSign doesn’t treat audio content any differently than standard content in how it can be 
scheduled, transferred or played back other than the fact that audio content does not display 
anything visually when played. 

All audio content is automatically created with the Audio format. You cannot modify the 
format of audio content. 

You can only schedule audio content into channels created with the Audio format and can 
only play back on players or regions set to the Audio format.

Batch Import Audio

1. Right click the grid and then select BATCH IMPORT AUDIO.

2. Import all audio files inside the selected folder.

3. The Select QuickSet dialog appears. From there you can:
• Create a QuickSet.
• Select from an existing QuickSet.
• Don't use a QuickSet.

4. The audio files are imported and are put/or not (depending the selection of step 3) into 
a specified QuickSet.

Make a Playlist

1. Right click a QuickSet and then select MAKE PLAYLIST.

2. The playlist dialog appears with all items inside the quick set. The default name is the 
same as the name of the QuickSet.
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CNM provides great flexibility in how you can schedule your content to appear on your 
CoolSign players. By using CoolSign channels and playlists, you can easily create 
schedules ranging from simple in-order playback. For CNM you can also do complicated 
nested schedules with weighted frequency and dynamic enabling expressions.

About Channels

Channels are the primary tool for scheduling how content will play back on your players. 
Channels are programmed with schedule items that define when and how content will be 
played back. You can schedule individual content items to play in your channel or, for more 
complicated scheduling, you can add playlists, which are sub-schedules of content. Once 
your channel is programmed, you can “tune” as many players as desired to the channel and 
all the necessary content will automatically be downloaded to the player before the channel 
starts playing.

A great advantage of channels is that if you need to change what is playing on your players, 
you can just edit the channel once and all players tuned to that channel will automatically 
be updated. There is no limit to the number of channels that you can create.
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Channels are managed from the Channels page of CNM. For details, see “Managing 
Channels” on page 135.

About Playlists

Playlists are similar to channels except that they are limited to in-rotation items and players 
cannot be tuned directly to them. You can use playlists within channels to provide more 
flexible scheduling than you could otherwise accomplish with just a flat schedule. For 
example, you can use playlists to ensure that multiple content items always play back-to-
back or to cycle through a set of content one at a time.

You can also use playlists to help manage regional or local schedules across large numbers 
of players and sites. For example, you might decide to create a “National” playlist and 
schedule it in all your channels across your CoolSign network. You can then update the 
“National” playlist once and all players in your network would be updated automatically as 
well. Playlists can be nested within other playlists for even more scheduling flexibility.

Playlists are managed from the Playlists page of CNM.
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Channels are the primary tool for scheduling how content will play back on your players. 
Channels allow you to centrally manage all the schedules for a player from one convenient 
page. Rather than scheduling content directly onto a player, you use channels to program 
how content should play and then tune a player to the channel. Multiple players can all be 
tuned to the same channel. If at any point you modify a channel by adding, editing, or 
removing scheduled items, any players that are tuned to that channel will automatically be 
updated with the changes. 

For more information on tuning players to channels, see “Tuning a Player to a Channel” on 
page 172.

Working with Channels

You can use the Channels page of CNM to create new channels, edit or delete existing 
channels, and to program content or playlists within channel.

To navigate to the Channels page:

• Click the Channels icon  in the navigation bar.

To create a new channel:

1. From the Channels page, do one of the following:
•  Choose ACTIONS > NEW CHANNEL.

•  Right-click on the Channels Manager grid and choose NEW CHANNEL.

The Channel Properties dialog appears.

2. Enter a name for your new channel in the Name field.

3. Choose a format for your new channel from the Format combobox. 
If you select either of the Portrait or Landscape format options, only content with the 
same format can be scheduled into the channel, and only players with the same format 
can tune to the channel. For example, you can only schedule portrait content into a por-
trait channel and only portrait players can be tuned to portrait channels.
If you select the ANY option, content and playlists can contain both Portrait and Land-
scape formats.
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NOTE

Once you add items to a channel, you will no longer be able to modify its format. If 
you need to change the format of a channel, delete any scheduled items first.

4. Add content items and/or playlists to the channel. See “Adding Items to a Channel” 
on page 139.

5. Click OK.

To edit an existing channel:

1. From the Channels page, do one of the following:
•  Select the channel and choose ACTIONS > EDIT CHANNEL PROPERTIES.
•  Right-click the channel and choose EDIT CHANNEL PROPERTIES.
•  Double-click on the channel.

2. Change any available properties or add, edit, or remove scheduled items in the 
channel. See “Adding Items to a Channel” on page 139.
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3. Click OK or Apply Changes. Any players tuned to this channel will automatically 
update to reflect changes made to the channel.

To delete a channel:

1. From the Channels page, do one of the following:
• Select the channel and choose EDIT > DELETE. 
• Right-click the channel and choose Delete.

You will be warned before attempting to delete any channels that are currently in use by a 
player.

To create an ANY format channel:

In previous CNM releases, a player’s orientation was set as portrait and landscape. Conse-
quently, players with a certain orientation could only play channels with a matching format. 
For example, a portrait player could only use a channel using portrait format. With this 
release, a new channel format named “ANY” is available to enable you to schedule both 
portrait and landscape content within a channel. Players can be tuned to an ANY channel 
to avoid a format mismatch.

1. Create a new channel.

2. Define the format orientation (in this case ANY).

3. Add content as normal.

4. If you select landscape, the CNM automatically filters out any portrait content. 
Similarly, if you select portrait, all landscape content is filtered out.

Selecting ANY gets you both landscape and portrait content from the content Picker 
window.

NOTE
An “ANY” format channel is designated with angle brackets, for example, <New Channel>.
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About the Channel Properties Dialog

You can use the Channel Properties dialog to modify the properties of a channel and to 
manage the scheduled items programmed to play when a player is tuned to that channel. 
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The Channel Properties dialog contains a collapsible schedule grid that lets you organize 
how your scheduled item will play and visualize the schedule. 

Adding Items to a Channel

When you add content or playlists to a channel, you can set properties that define how the 
scheduled item will play back in the channel including daypart scheduling, activation/expi-
ration dates, and enabling expressions.

To add a scheduled item to a channel:

1. To add content to the channel, select a content item to add. You can select multiple 
items if you want to add more than one item at once with the same scheduled item 
settings.
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2. To add a playlist to the channel, click the PLAYLISTS tab and select one or more 
playlists to add.

3. Click OK to close the Content Chooser dialog and open the Scheduled Items 
Properties dialog.

4. Set any scheduled items properties and the daypart schedule to define how the content 
or playlist will play within your channel. For more information, “About Scheduled 
Items” on page 141.

5. Click OK.

To add non-in-rotation schedule items (recurring, timed, or triggered):

1. Add any desired in-rotation content. See “Adding and Editing an In-Rotation 
Schedule Item” on page 142. for details.

2. Edit the in-rotation item and then change the schedule type from the content 
properties window.

To change an in-rotation schedule item:

1. Select a schedule item and then press Edit. 

2. From the Schedule Item Properties window, set the desired schedule type from the 
pull-down menu. 
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About Scheduled Items

You can use the Scheduled Item Properties dialog to define how an item will be played back 
in a channel. Set advanced properties including activation/expiration date and enabling 
expression, and to override dynamic data bindings for that scheduled instance.

There are five ways that scheduled items can be played within a channel:

In-rotation (“Adding and Editing an In-Rotation Schedule Item” on page 142)—This 
is the most common way to schedule content or playlists in a channel. A channel repeatedly 
plays its in-rotation items unless one of the specialized schedule items described below 
takes precedence. You can choose the order in which in-rotation items are played back by 
setting the channel or playlist picker type. The in-rotation picker can be set to play back 
items in order, shuffled or randomly using a weighted frequency. Each in-rotation item can 
additionally be set with a daypart schedule that enables or disables the item during specific 
hours or days of the week and activation/expiration dates that define when the item should 
start and stop playing. 

. Recurring (“Adding a Recurring Scheduled Item” on page 145)—You can use this 
schedule type to schedule content to play at regular repeated intervals, for example, every 
15 minutes or every hour. A recurring item can be set to either interrupt playing content 
when it’s time for it to play or to wait politely for the playing content to end before starting. 
Like In-rotation items, you can set a daypart schedule to only enable the recurring item 
during specific hours of the day.
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Timed (“Adding a Timed Scheduled Item” on page 147)—When you want content to 
play once at a specific time on a specific date or day of week, you can use this schedule 
type. Like recurring items, timed items can be set to interrupt playing content at the play 
time if desired. 

Triggered (“Adding a Triggered Scheduled Item” on page 148)—Content that is 
scheduled using the triggered type only plays when triggered via the CNM trigger manager 
or an external data source.

Merged (Playlists only) (“Adding a Merged Scheduled Item” on page 149)—Merged 
playlists treat the scheduled items of a playlist as if they were directly added to the channel. 
This enables you to take advantage of the organizational advantages of using playlists while 
retaining full flexibility for scheduling. The “Merged” schedule-type does not appear in the 
Scheduled-Type drop-down list of the Scheduled Item Properties dialog unless Playlist 
content is added.

Adding and Editing an In-Rotation Schedule Item

In-rotation scheduled items are the most common way to add items to a channel. You can 
set a daypart schedule for in-rotation items. For CNM you can also set a frequency setting 
if the channel is using the Weighted Frequency picker (“Setting the In-Rotation Playback 
Order” on page 144).

You can add in-rotation scheduled items to a channel. For example, a day-part schedule for 
in-rotation items as well as a frequency setting if the channel is using the Weighted 
Frequency picker. (See “Setting the In-Rotation Playback Order” on page 144.)

To add an in-rotation scheduled item:

1. Click the Add in-rotation item button.

2. Select a content item.

3. An item is added to the channel with default values, such as frequency and 
activation/expiration settings, etc.

4. Select Edit item to edit any in-rotation properties.
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To set schedule item properties:

1. The default setting is to use the Weighted Frequency picker. You can set the relative 
frequency of the in-rotation item from 1 to 10. For more information on pickers, 
“Setting the In-Rotation Playback Order” on page 144.

2. Define the times and days for which the scheduled item should be played. The blue 
cells of the schedule grid indicate that the item will be played in rotation with any 
other active scheduled items. The white cells indicate that the item will not play. For 
more information, “Using Schedule Grids” on page 306. 

3. Set any activation or expiration dates for the scheduled item. For more information, 
“Setting Advanced Properties” on page 150.

NOTE

The "Use local time" or "Use UTC time" selected above doesn't affect the activation 
and expiration dates.
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4. If you have selected dynamic content and want to override the data bindings for this 
scheduled item only, click the DYNAMIC DATA tab. For more information, see 
“Overriding Dynamic Data Settings” on page 181. 

5. Click OK to add the scheduled item to the channel.

Setting the In-Rotation Playback Order

To determine the order in which in-rotation scheduled items should play back within a 
channel, you can choose one of the following playback algorithms:

Weighted Frequency—The default picker that uses a frequency value assigned to each 
scheduled item to determine which item should play next. Items with higher frequency play 
more often than items with a lower frequency. The frequency value for a scheduled item 
represents its relative frequency when compared with other items in the channel.

In Order—Any active in-rotation items are played back in the order they appear in the 
Channel grid.

NOTE
You can reorder scheduled items in the channel grid by clicking and dragging the item to a 
new position.

Shuffled—Randomly shuffles all the in-rotation scheduled items and plays them back in 
the random order. All the items play back before the list is shuffled again. This algorithm 
ensures that the same scheduled item never plays back-to-back. Note that if there is only 
one item, then it has to play back-to-back.

In addition, you can either allow or not allow back-to-back playback when using the 
Weighted Frequency option. These options are set through the CNM (CHANNEL DIALOG > 
ADVANCED TAB). See “Advanced Playback Settings” on page 167. 

When set to "do not allow back-to-back", the weighted frequency option cannot be 
completed. For example, if there are two In-rotation items, item 1 has frequency as 1 and 
item 2 has frequency as 10. Normally, item 2 should play 10 times when item 1 plays only 
once. But if you set "do not allow back-to-back", then the result is that item 1 and item 2 
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plays alternatively, which means their actual frequency numbers are the same in order to 
avoid back to back play.

TIP
 Due to the randomness inherent in the weighted frequency picker, it is impossible to 
predict exactly how often an item will play, but you can view an approximate estimate on 
the Scheduled Items Properties dialog.

NOTE
 When fewer than seven items are scheduled using the Weighted Frequency picker, the 
picker allows items with higher frequencies to play back to back to preserve the relative 
frequency ratios.

To select the in-rotation playback order:

• Select the playback order type in the In-Rotation Items area of the Channel Properties 
dialog (“About the Channel Properties Dialog” on page 138).

Adding a Recurring Scheduled Item

Recurring scheduled items can be set to play back content on a repeating interval. You can 
set properties related to the recurring interval as well as a schedule of the times and days of 
the week for which the item is active.

To add a recurring scheduled item:

1. Follow the steps to add an new scheduled item to the channel. See “Adding Items to a 
Channel” on page 139. for details.

2. In the Scheduled Item Properties dialog, expand RECURRING and then right click to 
add an item from the Scheduled Type box.
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3. Once selected, define how often you want the scheduled item to repeat by setting the 
hours and minutes values.

NOTE

A recurring item will play after each repeat interval starting at midnight. If you want to 
offset when the recurring item plays, use the schedule grid to change the time when 
the item becomes active. For example, if you want an item to play every hour on the 
half hour, you would set the repeat interval to 1 hour and modify the schedule so that 
the item becomes active at 12:30am.

4. If you want the scheduled item to play exactly at the defined recurring interval, even 
if that would require interrupting content that is currently playing, check “Interrupt 
playing content”. Non-interrupting scheduled items will be queued to play 
immediately after the currently playing content.

5. Define the times and days for which the scheduled item should be played. The blue 
cells of the schedule grid indicate that the item is active and the white cells indicate 
that the item will not play. See “Using Schedule Grids” on page 306.

6. Set any advanced properties for the scheduled item. For more information, “Setting 
Advanced Properties” on page 150.

7. If you have selected dynamic content and want to override the data bindings for this 
scheduled item only, click the DYNAMIC DATA tab. For more information, see 
“Overriding Dynamic Data Settings” on page 187.

8. Click OK to add the scheduled item to the channel.
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Adding a Timed Scheduled Item

Timed scheduled items play back once at each timed interval. You can set timed items to 
play back every day or on specific days at a defined time or once on a certain date and time. 
Because timed scheduled items inherently define when they play, you cannot set a daypart 
schedule for them.

To add a timed scheduled item:

1. Follow the steps to add an new scheduled item to the channel. See “Adding Items to a 
Channel” on page 139. 

2. In the Scheduled Item Properties dialog, select Timed from the Scheduled Type box. 

3. Click Add to define a time when the timed item should play. You can specify days of 
the week when the timed item should play or set an exact date and time when the 
timed item should play one time only. 

NOTE

To add multiple times for a schedule item, click the Add button again.
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4. If you want the scheduled item to play exactly at the defined time(s), even if that 
would require interrupting content that is currently playing, check “Interrupt playing 
content”. Non-interrupting scheduled items will be queued to play immediately after 
the currently playing content. Note that you can choose to use either local time or 
UTC time. By default, the time specified here uses UTC time.

5. Set the activation date and expiration date for the scheduled item. For more 
information, “Setting Advanced Properties” on page 150.

NOTE

“Use local time” or "Use UTC time" if either was previously selected, doesn't affect 
the activation and expiration dates.

6. If you have selected dynamic content and want to override the data bindings for this 
scheduled item only, click the DYNAMIC DATA tab. For more information, see 
“Overriding Dynamic Data Settings” on page 187.

7. Click OK to add the scheduled item to the channel.

Adding a Triggered Scheduled Item

Triggered scheduled items are played whenever the assigned trigger is fired via an external 
application or manually from the Manage Triggers dialog. You can select a trigger for the 
schedule item, along with specific times and days of the week when the item is active.

To add a triggered scheduled item:

1. Follow the steps to add a new scheduled item to the channel. See “Adding Items to a 
Channel” on page 139. for details.

2. In the Scheduled Item Properties dialog, select Triggered from the Scheduled Type 
box. 

3. Select a trigger in the Trigger combobox or click Create New Trigger. For more 
information on triggers, see 20. "Managing Triggers", on page 316

4. If you want the scheduled item to play immediately when it is triggered, even if that 
would require interrupting content that is currently playing, check Interrupt playing 
content. Non-interrupting scheduled items will be queued to play immediately after 
the currently playing content.

5. Define the times and days for which the scheduled item can be triggered. The blue 
cells of the schedule grid indicate that the item is active and the white cells indicate 
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that the item will not play. For more information, see 19. "Using Schedule Grids", on 
page 312.

6. Set the activation and expiration date for the scheduled item. For more information, 
“Setting Advanced Properties” on page 150.

7. If you have selected dynamic content and want to override the data bindings for this 
scheduled item only, click the Dynamic Data tab. For more information, see 
“Overriding Dynamic Data Settings” on page 187. 

8. Click OK to add the scheduled item to the channel.

Adding a Merged Scheduled Item

Merged scheduled items are a special type of scheduled item that can only be used with 
playlists. A merged playlist schedule item treats the items in a playlist as if they had been 
added directly to the channel.

For example, you could create a “National” playlist and schedule it as merged within all of 
your channels. The items in the “National” playlist would play back as if scheduled directly 
within each channel except that you could update items centrally from within the playlist 
without having to edit each channel. 

For more information on playlists and scheduling strategies, 10. "Managing Playlists", on 
page 169.

To add a merged scheduled item:

1. Follow the steps to add a new scheduled item to the channel remembering to select 
from the Playlists tab rather than the default Content tab of the Content Chooser. See 
“Adding Items to a Channel” on page 139. for details.

2. In the Scheduled Item Properties dialog, select Merged from the Scheduled Type 
box. 

NOTE

Merged is only available as an option when you are adding a playlist to the channel. 
You cannot set the Merged scheduled type for content or audio.

3. Set any activation or expiration dates for the scheduled item. For more information, 
“Setting Advanced Properties” on page 150.

4. Click OK to add the scheduled item to the channel.
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To merge playlists playback constraints:

1. The playback order of a merged playlist must match the parent schedule.

2. Once a schedule (channel or playlist) contains a merged playlist, you cannot change 
the schedule’s playback order.

Setting Advanced Properties

You can set activation and expiration dates for scheduled items from the Advanced Prop-
erties dialog.

Setting Scheduled Item Activation and Expiration Dates

If you want a scheduled item to start or stop playing at some future date and time, you can 
set the activation date and expiration date for the item. Items will not become active until 
their activation date and will be indicated with a Pending status. Items set with an expiration 
date will immediately stop playing at their expiration date and time. 

NOTE
Activation and expiration dates are evaluated based on the local time zone of the player. 
For this reason, expired scheduled items are not automatically deleted from a channel 
until 24 hours after the expiration date to ensure that the content continues to play in all 
time zones until the local expiration date is passed.

TIP
Activation and expiration dates for scheduled items are applied to the current channel 
only. If you want to globally activate or expire content everywhere that it is scheduled, you 
can set Content Activation and Expiration dates from the Content Properties dialog.

To set the activation date of a scheduled item:

1. Click the Activates At radio button.

2. Click the ACTIVATION DATE EDITOR drop-down to edit the activation date at which the 
item can start playing.
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To set a scheduled item to be active now:

• Click the Activates Now radio button.

To set the expiration date of a scheduled item:

1. Click the Expires At radio button.

2. Click the Expiration Date Editor drop-down to edit the expiration date at which the 
item should stop playing.

To set a scheduled item to never expire:

• Click the Expires Never radio button.

Setting Enabling Expressions

Enabling expressions can be used to dynamically control when a player’s content plays and 
under what conditions it plays. With this release, you can now use enabling expressions to 
tie into dynamic Data Tables, Player Attributes (formerly Node Attributes), Content Attri-
butes and Site Properties to create complex behaviors not only from a player node level but 
also from a site-level. The following sources and data tables can be used to create these 
behaviors:

Player Attributes—(formerly called Node Attributes) Can be displayed within your views 
in the Content Manager and used within searches or QuickSearches. For more details, see 
“About Node Attributes” on page 298.

Content Attributes—Users create their own content attributes in user fields such as 
language, company regions, store departments, etc. These attributes are tied to a player’s 
content at the “site level” and can be used to track additional data about each site that is 
relevant to your business.

Site Properties—Contains geographic information (locations, addresses, etc.) For more 
details, see “Creating a New Site” on page 207.

Data Tables—Mini-databases with a structure that is flexible enough to allow you to store 
anything from a single piece of information to a complex table with dozens of fields and 
hundreds of records. For more details, see “About Data Tables” on page 213.

Source Attributes are 
enclosed with [ ].
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NOTE
The enabling expression is evaluated each time a scheduled item is “supposed” to play. If 
it evaluates to true, the scheduled item plays back as scheduled; otherwise, the item does 
not play. For example, if you have a data table that contains the local weather for a player, 
you could use an enabling expression to play back content for umbrellas only in case of 
rain.

Enabling expressions can only be used to enable/disable an item from playing back as it is 
scheduled. You can’t use enabling expressions to force items to play. To force items to play 
based on external data, 20. "Managing Triggers", on page 316.

To add or edit an enabling expression:

1. Double click an item in a channel and open the Schedule Item Properties dialog.

2. Click the Enabling Expression tab.

Following is a basic enabling expression that you can set up to evaluate against "Rain" 
being in the "Condition" field of the data table "Weather." The intent is for the umbrella 
advertisement to play each time it rains.
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“Rain” appears in the 
Value box.

Select the Condition 
“Equals”

Select Data Table 
“Weather”

A more complex enabling expression can be setup as follows. In this case, a Player attribute 
“Language” is compared to a Content attribute “Language”. The intent is for an “English” 
player to play its content each time these two attributes match.

Select the Condition 
“Equals”

Player Attri-
bute “Lan-
guage”

Content Attri-
bute “Lan-
guage”

A simpler enabling expression for “Language” can also be setup. In this case, a Player 
attribute “Language” can be setup.
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Player Attribute 
“Language”

Note that in this case the “Picklist” values 
have been automatically populated.

Two things to remember when setting up Player attributes and Content attributes:

• Player attributes defined at the player node level will always override Site-level at-
tributes when used in enabling expressions.

• If a Player Attribute is undefined at the Player Node level, it inherits values defined 
at the Site level.

If desired, check “Use advanced editor” if you want to review the actual JavaScript used 
for the enabling expression or if you want to hand-edit the expression to add additional 
logic to the expression. For more information on accessing dynamic data through JavaS-
cript expressions, see the Content Scripting technical documentation provided with your 
software.

To clear an enabling expression:

• Click the Clear Expression on the Enabling Expression tab.
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Determining when a Channel Can Start Playing

When you tune a player to a new channel, CoolSign automatically starts transferring the 
content required by the channel down to the player. Depending on the speed of your 
network and the number and size of the content files required for the channel, this can take 
anywhere from a few seconds to hours. For each channel, you can decide if you want the 
player to start playing items in the channel as soon as they are available or if you want the 
player to continue playing the current channel (or black if there is no channel) until all the 
items have transferred.

To mark a channel to wait for all items before playing:

• On the Channel Properties dialog, check “Wait for all items before playing”. 

TIP
You can review the transfer status of the items in a channel to a player from the Player 
Properties dialog or the Transfers tab of the Node Properties dialog for the player node.

Working with the Channel Grid

The channel grid on the Channel Properties dialog displays all of the items scheduled in the 
channel. For organization purposes, each type of a scheduled item is listed in its own 
collapsible area so you can easily view all types of items or just focus on the items in which 
you are interested in. The channel grid displays the most common properties of each 
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scheduled item as well as a graphical timeline of the item’s schedule. 

Using Scheduled Item Collapsible Areas

Each type of scheduled item has its own collapsible area in the channel grid. You can 
expand or collapse each area to view or hide the scheduled items. When you first open a 
Channel Properties dialog, only the collapsible areas with one or more scheduled items are 
expanded. The other areas are collapsed.

To expand a collapsed scheduled item type area:

• Click to expand a collapse area.

TIP
To automatically collapse any other open areas, hold down the Ctrl key while expanding 
an area.
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To resize an open area:

1. Move the mouse to the area between the two areas you want to resize.

2. When the cursor changes to , click and drag vertically to resize the areas.

Understanding the Channel Grid

To help you quickly identify the properties of scheduled items, the channel grid provides 
visual feedback in the form of icons, colors, and the graphical timeline. Depending on the 
properties of your scheduled items, you might see one of more of the following icons:

Active content items scheduled in the channel.

Active playlists scheduled in the channel.

Content that becomes active in the future due to a scheduled item or content activation 
date being set.

Content that has expired due to a scheduled item or content expiration date being set.

Content that has been disabled by checking the Disable this scheduled item from 
playing on the Scheduled Item Properties dialog.

Indicates a scheduled item for which an enabling expression has been set.

Setting Activation and Expiration Dates from the Channel Grid

You can set the activation and expiration date for a scheduled item without opening its 
Scheduled Item Properties dialog. To do so, the date directly in the grid.

To edit a scheduled item’s activation or expiration date:

1. Click the activation (Starts) or expiration (Stops) date from the Channels grid.

2. Select a new date and time to use for activation or expiration or click Activates Now 
or Expires Never to remove the activation or expiration date.

NOTE
If the scheduled content has an activation or expiration date set from the Content 
Properties dialog, the activation and expiration dates will appear in red. A content item’s 
activation and expiration dates always take precedent over a scheduled item’s. You 
cannot set the scheduled item’s activation or expiration date outside the range defined by 
the content, but you can set it later or earlier.
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Editing Content Properties

You can open the Content Properties dialog for any content scheduled in your channel if 
you want to quickly view or edit settings for the content.

To edit content properties for a scheduled content item:

• Right-click on the scheduled item and choose EDIT CONTENT PROPERTIES.

Showing Content Thumbnails

You can view the thumbnails for content in your channel.

To display content thumbnails in the channel grid:

• Right-click in any column header and choose SHOW THUMBNAILS.

Working with the Timeline View

The graphical timeline in the channel grid visually displays when a scheduled item is active 
across a span of weeks. You can configure the timeline to show from one to eight weeks 
and to calculate the total loop duration of scheduled content. You can also directly modify 
a scheduled item’s activation and expiration dates by clicking and dragging within the 
timeline.

Understanding the Timeline

The timeline indicates the active state of the content during the current week and for two to 
eight weeks into the future.  

Use these arrow buttons to move 
to the previous or next week.

Right-click the date to directly 
select a week to display.

Click the Options menu 
to set additional options 
to configure the timeline.

The checkerboard pattern indicates 
that the content is not active or has 
expired on these days.

Indicates that this 
week has an overrid-
den daypart schedule.

You can drag the han-
dles to change the 
activation/expiration 
dates for an item.

This pattern rep-
resents the day-
part schedule for 
the item.

The following colors and patterns are used to indicate the active state of an item:
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Solid blue—Indicates that the schedule item is active during the displayed days for the 
entire day.

White—Indicates that the item is not active on this day due to an activation or expiration 
date on the item.

Blue/gray pattern—Represents the daypart schedule for an item.

Checkerboard—Indicates that a content item is not active on this day because activation 
or expiration dates were set on the item itself.

Yellow—Weeks for which a scheduled item’s daypart schedule has been overridden.

Selecting the Displayed Weeks

By default, the timeline view displays the current week along with the number of future 
weeks set in the View options menu. You can select other weeks to view the timeline.

To change the visible week:

1. Right-click the week label to open the Week Selector Calendar. 

2. Select a day in the week you want to display in the timeline.

To navigate to the next or previous week:

• Click the left or right arrows to navigate to the previous or next week.
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To change the number of displayed weeks:

1. Click Options to open the VIEW OPTIONS menu. 

2. Set the number of visible weeks from 1 to 8.

Showing Timelines

This option is for loading channel dialog quickly for very complex schedules. Uncheck 
“Show timeline” if you don’t want the timeline section displayed. Note that if “Show 
timeline” is unchecked, the remaining view options are disabled.

Viewing the Loop Duration

If you are interested in managing the total duration of the In-Rotation items scheduled in a 
channel, you can use the Loop Duration panel. You can check the total duration of all 
content scheduled in-rotation by day. You can also set a minimum and maximum loop 
duration to receive visual indication of when the duration of your loop exceeds or is under 
your settings. 

Click to open 
the Loop menu.

Yellow indicates that the 
total loop length is less 
than the minimum set in 
the loop menu.

Blue indicates that the 
total loop length is 
within the min and max 
set in the loop menu.

Red indicates that the 
total loop length is longer 
than the maximum set in 
the loop menu.

To display the Loop Duration panel:

1. Click Options to open the VIEW OPTIONS menu.

2. Check Show Loop Duration.
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To set the Max Loop and Min Loop settings:

1. Click Loop Duration to open the LOOP menu.

2. Set the minimum duration in seconds that you want your loop to play. If your loop 
length is less than this value, the Loop Duration panel will display a yellow warning 
color.

3. Set the maximum duration in seconds that you want your loop to play. If your loop 
length is greater than this value, the Loop Duration panel will display a red warning 
color.

Cutting, Copying, and Pasting a Channel’s Scheduled Items

You can cut, copy, and paste scheduled items to different channels or you can copy just the 
schedule properties from a scheduled item and apply it to another scheduled item. When 
you copy and paste a scheduled item, you are duplicating the entire scheduled item 
including the content or playlist that is scheduled. When you just copy an item’s schedule 
properties, you are only copying the settings for the scheduled item and can then apply 
those settings to another scheduled item without changing the content or playlist that is 
scheduled.

To cut or copy a channel’s schedule item(s) to another channel:

1. Open the source Channel Properties dialog.

2. Select the scheduled items to be copied using:
• Ctrl-C to copy or Ctrl-X to cut.
• Right-click and choose CUT or COPY.

To paste a channel’s schedule item(s) to another channel:

1. Open the target Channel Properties dialog.

2. Paste on the scheduled items grid by:
• Enter Ctrl-V or right-click.
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Overriding Playlist Scheduled Items

You can override the properties of the items within a playlist scheduled within a channel. 
Playlist overrides are applied only for the channel in which you create the override and not 
anywhere else the playlist is used.

For more information on overriding scheduled items, “Overriding Channels” on page 184.

Reviewing where a Channel is Used

You can quickly view which players have been tuned to a channel from the Players tab of 
the Channel Properties dialog.

For details, “Tuning a Player to a Channel” on page 178.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 162



10. Managing Playlists

Playlists add additional flexibility when programming your channels by providing the 
capability to create “sub-schedules” within the channel’s schedule. You can also use 
playlists to help in “localizing” your schedules across multiple sites and players. Playlists 
are similar to channels with the following differences:

• You can only add In-Rotation scheduled items to a playlist.
• You can’t tune a player to a playlist. You must schedule a playlist within a channel.
• Playlists can be scheduled within other playlists.

Working with Playlists

You can manage the playlists in your network from the Playlists manager page of CNM. 
From the Playlists page, you can create new playlists, edit or delete existing playlists, and 
program content within your playlists.

To navigate to the Playlists page:

Click the Playlists icon in the navigation bar.

To create a new playlist:

1. From the Playlists page, do one of the following:
• Choose ACTIONS > CREATE NEW PLAYLIST.
• Right-click on the PlayList Manager grid and choose CREATE NEW PLAYLIST.
• In content or audio manager, right click on a quickset and then select MAKE PLAY-

LIST.
• On the Channel and Playlist dialogs, select one or more schedule items and then 

select "Make Playlist from selected items".
The Playlist Properties dialog appears.

2. In the Name field, enter a name for your new playlist.
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3. Choose a format for your new playlist from the Format combobox. Only content with 
the same format can be scheduled into the playlist, and only channels with the same 
format can schedule the playlist. 

NOTE

Once you add items to a playlist, you can no longer modify its format. If you need to 
change the format of a playlist, delete any scheduled items first.

4. Add content items and/or other playlists to the playlist. See “About the Playlist 
Properties Dialog” on page 165. 

5. Click OK.

To edit an existing Playlist:

1. From the PlayList page, do one of the following to display the PlayList Properties dia-
log:
• Select the channel and choose ACTIONS > EDIT PLAYLIST PROPERTIES.
• Right-click the channel and choose EDIT PLAYLIST PROPERTIES.
• Double-click on the playlist.

2. In the Playlist Properties dialog, change any available properties or add, edit, or 
remove scheduled items in the channel. See “About the Playlist Properties Dialog” on 
page 165. 

3. Click OK or Apply Changes. Any channels using this playlist will automatically 
update to reflect the changes.

To delete a playlist:

• Select the playlist and choose EDIT > DELETE or right click to select a playlist and then 
select Delete. 
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About the Playlist Properties Dialog

You can use the Playlist Properties dialog to set or modify the properties of a playlist, add 
scheduled items to the playlist, and review which channels currently use the playlist. The 
Playlist Properties dialog is very similar to the Channel Properties dialog.

Adding Items to a Playlist

The process for adding items to a playlist is identical to adding items to a channel except 
that you can only add In-Rotation scheduled items.

For more information on adding items to a channel, see “Adding Items to a Channel” on 
page 139.

Scheduling a Playlist in a Channel

Playlists can be scheduled into a channel (or other playlists) with all the same properties as 
a piece of content. You can schedule a playlist as In-rotation, Recurring, Timed, or Trig-
gered. Playlists can have daypart schedules, activation/expiration dates, and enabling 
expressions just like content. However, when it comes time for a playlist to “play”, the 
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channel lets the playlist pick which content or playlist should play, based on the items 
scheduled within the playlist and its own playback order settings.

Determining how a Playlist Plays

Just as with a channel, you can set the playback order for a playlist using the Playback order 
combobox. For more information on setting playback order, see “Setting the In-Rotation 
Playback Order” on page 144.

Additionally, you can define whether the playlist should just play one item or all the items 
each time it is picked to play by its parent channel. 

Play One Item—When a playlist is set to Play One Item, it will play one item picked from 
its scheduled items. After playing the one item, it will return control to the parent channel 
or playlist.
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Play All Items—When a playlist is set to Play All Items, it will play all of its scheduled 
items before returning control to the parent channel or playlist.

About Merged Playlists

In addition to the four standard types of scheduled items, you can also schedule a playlist 
as merged within a channel. When a playlist is merged with a channel, the items within the 
playlist are treated just as if they were added directly to the parent channel. The parent 
channel selects scheduled items to play using both the scheduled item added directly to the 
channel and the items within the merged playlist. This feature allows you to manage sub-
sections of a channel separately and share them across multiple channels. 

NOTE
The playback order settings for a playlist are ignored when the playlist is scheduled as 
merged.

Advanced Playback Settings

You can use the Playlist Properties dialog to evaluate channels that contain multiple 
instances of a dynamic content item. Two evaluations are available via the Advanced tab 
in the Playlist Properties dialog.

Data Context Sharing—The default for this setting is to have the “next” data row used 
each time it plays so the context of “where are you in the list” is maintained for the entire 
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channel. Alternately, if unchecked, the dynamic content maintains “independent” contexts 
and as such plays the same row from within the data table.

Picker Context Sharing—The default for this setting is to have the “next” playlist item 
used each time it plays so the context of “where are you in the list” is maintained for the 
entire channel. Alternately, if unchecked, the playlists maintain “independent” contexts and 
as such plays the same item from within the playlist (if they’re reset to in-order).

Localizing Schedules

If your network contains a large number of sites or players, you may find that, while each 
player or site has some unique content playing on it, there is also a large amount of content 
that should be played across all the sites as well. You can use playlists to optimize your 
schedules so you can manage a large number of channels across a large number of players 
but still easily add content to the entire set or a subset of channels. 

For example, if you are using CoolSign for a national advertising network, you may have 
national content that needs to play across your entire network, regional content that only 
plays on the West Coast, and specific content that plays at each site. By using merged play-
lists, you can build up channels for each player or site that can contain both the player-
specific content items as well as a National and/or Regional merged playlist you have 
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defined. By scheduling the National playlist into every channel used by every player, you 
can now quickly add or remove scheduled items from every player by just editing the 
National Playlist once. 
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The Players page of the CoolSign Network Manager (CNM) lets you view all the CoolSign 
players connected to your network. You can do any of the following on the Players page:

• Tune a player to a channel.
• Review both detailed and rollup play history for a player.
• Set a schedule for the volume level of a player.
• Remotely configure the player, including defining multiple regions and display 

control.
• View the current status of both the player and any displays connected to the player.
• View the current content that is now playing on the player.
• Organize the players by geographic distribution, using the Sites panel.
• Create QuickSets and QuickSearches to filter which players are visible in the grid.
• Force content to play immediately on the player.

About Players and Channels

The CNM uses a channel metaphor for scheduling content to play back on your players. 
You create channels and then program content and playlists within each channel. Once your 
channels are designed, you can then tune players to that channel. 

Once you tune a player to a channel, the CNM automatically takes care of everything 
required to distribute the content, playlists, and data tables to the player. The CNM checks 
to see which files need to be transferred and immediately starts sending them across your 
network to each player. Depending on the settings of the channel, items in the channel can 
start playing as soon as they are available, or the player can wait for all the items in the 
channel to be available before switching to the channel.

If you modify a channel by adding new scheduled items, editing existing scheduled items, 
or removing items, those changes are automatically distributed to any players tuned to that 
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channel. If a player happens to be offline when the changes are made, the CNM distributes 
the changes as soon as the player reconnects to the network.

NOTE
While each player can only be tuned to a single channel at a time, any number of players 
can be tuned to the same channel. This enables you to update a single channel and have 
those changes automatically applied to all the players tuned to that channel.

For more information on working with channels, see “Managing Channels” on page 135 for 
details.

About the Player Properties Dialog

You can use the Player Properties dialog to tune a player to a channel, review play history, 
and schedule volume control.

To edit the properties of a player:

Do one of the following:

• Double-click on the player in the grid.
• Select one or more players and choose Actions > Edit Player Properties or right-click 

and choose Edit Player Properties.
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Tuning a Player to a Channel

You can use the Player Properties dialog to tune a player to the channel it should use to play 
back content. The Player Properties dialog displays the currently tuned channel, using the 
same grid as appears on the Channel Properties dialog. 

For more information on working with channels and the channel schedule grid, 8. "About 
Scheduling", on page 133.

To tune a player to a channel:

1. Select a new channel from the Tune to channel drop-down menu (“To edit the proper-
ties of a player:” on page 171). The channel grid is updated to reflect the new channel.

2. Click OK or Apply Changes. Any needed files will immediately begin transferring to 
the player.

NOTE
To tune multiple players to the same channel at the same time, select multiple players 
before opening the Player Properties dialog. If you set the player to tune to a channel 
behind a firewall, you must open up a port corresponding to the streaming route.
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Reviewing a Channel Before Tuning

Before you commit to tuning a player to a channel, you can see what the channel contains 
as well as which content items in the channel will need to be transferred to the player before 
they can play.

The status of each item in the proposed schedule can be either of the following:

 Available—The content item is already available on the local player hard disk 
and will not require any transfer to play.

Transfer required—The content must be transferred to the 
player before this item can be played. If the channel is marked as “Wait for all items before 
playing”, the player will not switch to the new channel until all needed content has been 
transferred to the player.

NOTE
All content in a tuned channel will be transferred to a player regardless whether it is 
currently active or pending activation due to the setting of a future activation date on the 
content or schedule item. This feature allows you to “stage” content on the player at the 
time you tune it so that you can be assured that the content is available when it comes 
time for it to play.

Viewing Transfer Status of Items to a Player

When you tune a player to a channel, all of the content, playlists, data tables, and files 
required to play that channel will automatically start transferring to the player. If, at any 
point, you modify either the channel or any content or playlists included in the channel, any 
changes will also be automatically transferred to the player for you. 

The status of each transferring item can be any of the following:

Checking—Either a transfer has not yet started and the system is checking 
to see if it is necessary to transfer content to the player or CNM is still waiting for the server 
to send an updated transfer status report.

The transfer bar displays the current progress of a transfer to a player. 

An all-green transfer bar indicates that all necessary files for the content 
have been transferred to the player but that the content has not been loaded yet. You may 
see this status temporarily when the channel is marked to “Wait for all items to transfer 
before playing” or when there are additional files required for the content to play, for 
example, data tables with imported media files that have not yet completed transfer.

During the transfer, the Player Properties dialog shows the progress of the entire transfer 
required for the player:
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Viewing the Status of Scheduled Items on a Player

Once all the necessary files required to play back content have been transferred to the 
player, the content will be loaded and should start playing back as scheduled. There are a 
number of reasons why content that has been scheduled and transferred to a player might 
not be actively playing. Once a content item has been transferred to the player and loaded, 
you can review its current status in the status column of the Player Properties dialog.

The status of each loaded item can be any of the following:

Ok—The content is loaded and should be playing back as scheduled.

Ok (Pending)—The content is loaded but is pending a future activation 
date, either set in the schedule item or the content.

Ok (Expired)—The content is loaded but has expired due to a past expiration 
date set in the schedule item or content. Expired items are automatically deleted from a 
channel after 24 hours.

Inactive—The schedule item has been disabled from the Schedule Item Prop-
erties dialog.

Error—A problem occurred while the content was playing back. The status 
includes additional information about the type of error and the version of the content which 
is playing. For more information on content errors, see “Troubleshooting display errors” on 
page 386.

TIP
If the status column is not wide enough to see the entire error status message, you can 
hover the mouse over the column to see a tool tip, which displays the full contents of the 
field.

Offline—The entire player is currently offline.

Quick Tuning a Player to a Channel

You can quick tune a player (or players) directly to a channel without using the Edit Player 
Properties dialog. When using this feature, all players (or nodes) that are currently high-
lighted are automatically tuned to the desired channel(s). 
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To quick tune a player or player node:

1. From the Player Manager, select QUICK TUNE...

2. From the Quick Channel Tuner dialog, select a channel (or channels) to which you 
want to tune the selected players.

NOTE
Channels that have angled brackets are in “ANY” format.
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3. Click OK.

Jump to Node

If you have multiple player nodes, you can use the Jump to Node feature to display the node 
for a specific player in the CoolSign Network Manager. Once selected, this node appears 
in the Network Manager along with the filter that was created in the Quicksets dialog.

To filter on a specific player node:

1. From the Players Manager, highlight the desired player node and select Jump to Node 
(see “Quick Tuning a Player to a Channel” on page 174 for details).

2. From the Network Manager, configure the player node as desired.

Modifying channels

While you will usually create and edit channels from the Channels page, the Player Prop-
erties dialog provides some shortcuts to help you manage the available channels.

Creating a New Channel

You can create a new blank channel directly from the Player Properties dialog and tune the 
player to it in one step. 

To create a new channel:

1. Click New Channel to open a new Channel Properties dialog (“To edit the properties 
of a player:” on page 171).

2. Enter a name for the new channel and add schedule items as desired. For more 
information on working with channels, see 19. "Using Schedule Grids", on page 306.

3. Click OK. 

Editing the Currently Tuned Channel

If you want to make changes to the currently tuned channel, you can do so directly from the 
Player Properties dialog without having to close the dialog and navigate to the Channels 
page.

NOTE
Changes you make to a channel will be applied to every player that is tuned to that 
channel. If you want to make changes to a channel for the current player only, refer to 
“Overriding Channels” on page 178.
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To edit the current channel:

1. Click Edit Channel to open a Channel Properties dialog for the currently tuned chan-
nel (see “To edit the properties of a player:” on page 171).

2. Make any desired changes to the channel.

3. Click OK. Any changes made to the channel will automatically start transferring to 
the player.

Viewing Play Logs

You can retrieve the play history for a specific piece of content from the Content Properties 
dialog (see “Retrieving Play History for Content” on page 126) but if you want to review 
all of the content that played on a player, you can use the Play logs tab of the Player Prop-
erties dialog.

Viewing Play Summaries for a Player

You can retrieve rolled-up summaries of all the content that has played on a player or set 
of players across any time range. Each content item that has played during the defined view 
range will be displayed with the total number of times it has played and the percentage of 
total plays of all played content.

To view the play log summary:

1. Click Play logs in the Player Properties dialog.

2. In the Play Logs tab, select the View Range for which you would like to retrieve 
playlogs or manually enter a From and To date (“To edit the properties of a player:” 
on page 171).

3. Click Retrieve Logs.

Viewing Detailed Play Logs for a Player

In certain situations, you may want to retrieve the detailed logs for each player to review 
the exact time and reason that each piece of content played. If the content is enabled to log 
data slots, you can even view the state of any dynamic data fields at each time the content 
played.

For more information on enabling content to log dynamic data, see “Enabling Data Slot 
Logging” on page 134.

To view the detailed play logs:

1. Select the View Range for which you want to retrieve detailed playlogs or manually 
enter a From and To date (“To edit the properties of a player:” on page 171).

2. Check the Show detailed logs checkbox.
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3. Click Retrieve Logs.

Exporting Logs

Once you have retrieved play logs for a player, you can export the logs to a file.

To export play logs:

• Right-click on any column header and choose EXPORT DATA....

TIP
For more information on working with grids, see “About the Data Grid” on page 25. 

Overriding Channels

Overriding a channel is an advanced feature that provides added flexibility when sched-
uling content to play back on a player. Normally, tuning multiple players to the same 
channel will result in each player playing back the channel as it was programmed in the 
Channel Properties dialog. However, in some cases, you may want to make a small change 
to a channel on a specific player without creating an entirely new channel. For this situation, 
you can override certain properties of the scheduled items in a channel and apply them to a 
single player only.

NOTE
Overridden items are indicated in blue italic type in the channel grid.

WARNING
Channel overriding should be used sparingly, as it can cause confusion in troubleshooting 
player issues and unexpected results when editing a channel that has been overridden in 
one or more players. In most cases, you should be able to achieve your scheduling goals 
using other mechanisms available like playlists or enabling expressions.

To override the properties of a scheduled item:

1. On the Channel tab, do one of the following:
• Right-click on the scheduled item and choose OVERRIDE ITEM.
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• Double-click on the scheduled item.

2. On the Override Schedule Item Properties dialog, override any changes to the base 
schedule item. You can override the following:
• The daypart schedule for the item.
• The enabling expression for the item.
• Disable the item from playing.

You cannot change the base scheduled type of an item or change the activation or ex-
piration dates.

3. Click OK.

To clear an override:

• Right-click the overridden item and choose CLEAR OVERRIDE.
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Controlling Player Volume

You can use the Sound Control tab of the Player Properties dialog to directly set or schedule 
the overall volume of a player. The player volume settings are applied globally to all 
content that plays. If you want to adjust an individual content item’s volume relative to 
other content being played, see “Using the Content Properties Dialog” on page 118.

WARNING
You can only control the volume of SWF files that are version 8 or older. With SWF version 
9 files, it is not possible to control the player volume.

To directly set the volume of a player:

1. Click the Set Volume radio button.

2. Enter a volume for the player from 0 to 100, with 0 being no audio and 100 being the 
maximum volume.

NOTE

Setting the volume on a player volume is equivalent to setting the Master Volume in 
the Windows Mixer. The Wave Volume in the Windows Mixer will always be set to the 
maximum.

To schedule volume on a player:

1. Click the Set Volume according to Schedule radio button.

2. Do one of the following:
• Click or drag a range of cells to toggle the volume on and off for the selected time.
• Right-click on a cell or range of cells to set a specific volume level for the selected 

time.
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For more information on using schedule grids, see 19. "Using Schedule Grids", on 
page 312.

Overriding Dynamic Data Settings

Normally, when you schedule dynamic content into a channel, the content will play back 
using whatever data table bindings set during import of the content or from the Content 
Properties dialog. If you want to change which dynamic data table a content item uses for 
a specific player or channel without needing to duplicate the entire content item, you can 
override the bindings from the Scheduled Item Properties dialog.

To override data bindings at schedule time:

1. Do one of the following:
• Right-click on the scheduled item and choose OVERRIDE ITEM.
• Double-click on the scheduled item.

2. From the Scheduled Item Properties dialog, click to display the Dynamic Data tab.

3. If you want to override a binding, select a new data table to use for this scheduled 
item only. 

4. The Dynamic Data tab allows you to edit the data in a data table directly from the 
dialog. You can add or delete rows and edit data as needed.

NOTE

Edits to a data table are applied globally to the data table everywhere that it is used. 
You cannot override the values in a data table for a scheduled item—you can only 
override which data table is used. For more information on localizing data, see 
“Localizing Data” on page 217.
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5. If you want to override the master expression prescript, click Edit Prescript 
Expression.

6. Click OK.

For more information on dynamic data and content binding, see 14. "About Dynamic 
Data", on page 213.

Playing Content On-Demand (Play Content Now)

You can direct the CNM to play content on demand, even if that would require interrupting 
content that is currently playing. You can also direct the CNM to play from a playlist on 
demand.

To play content on demand:

1. In the Players page, select the player/region where you want to run the content.

2. Right-click PLAY CONTENT NOW.

3. In the Content dialog, select the content that you want to play immediately.
• If content is listed in black, it is available to play immediately.
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• If content is listed in red, it is not currently available on the Player node, and begins 
playing after the content has been transferred to the Player.

Clicking Play Next or Play Now causes the selected content to be transferred 
to the Player node.

4. Click Play Now.

The new content begins to play immediately in the selected player/region.
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CNM provides tools to allow you to remotely configure many settings on your players and 
control devices so that you don’t need to physically access them once they are deployed. 
You can use these configuration features to:

• Manage the displays that are serial-controlled by the player.
• Set or schedule the display input for controlled displays.
• Change the video card settings including resolution, refresh rate and bit depth.
• Configure multiple regions for a player including layout and other properties.

About the Configure Player Dialog

You can access the Configure Player dialog from either the Players page or the Network 
page. When selecting multiple players, only the device settings tab is available. The Player 
Setup tab’s features are disabled for multi-selected players.

To configure a player:

Do one of the following:

• Right-click on the player and choose Configure Player.
• Choose Actions > Configure Player.

About Multi-Region Players

CoolSign enables you to define multiple independent regions for a player. However, it is 
recommended that no more than eight independent regions for a player be used. Each player 
region can be tuned to its own channel and plays back its content loop independently of any 
other regions. Player regions can be positioned anywhere within the video output for a 
player and can even overlap.

You can use the CoolSign multi-region features to create headline news style content 
layouts, overlay bugs or tickers on other channels, or other special layout effects. Each 
region is effectively a full-fledged CoolSign player; there are no restrictions (other than PC 
performance) that limit what type of content you can play in a region. Regions fully support 
dynamic content, live video, progressive meters, and all other available content function-
ality.
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Configuring Multi-Region Players

You can configure video card settings and define multiple region players from the Player 
Setup tab of the Configure Players dialog.

Use the Region Layout 
Window to drag to 
position or resize 
regions.

Configure video output 
settings for the video 
card(s) installed in the 
player PC.

Use this grid to man-
age player regions 
and numerically set 
layout values.

Use these controls to apply saved 
multi-region layouts to the current 

Add, edit or
delete region

Configuring Video Outputs

Each CoolSign player contains one or more video cards. If you want to remotely recon-
figure a player video card to a different resolution, refresh rate, bit depth or orientation, you 
can do this from the Player Setup tab of the Configure Player dialog.

To configure the video output of a player:

1. In the Player Setup tab, select the video output in the Video outputs grid.

2. Change one or more video output properties. You can change the following 
properties:
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Name—Changes the name of the video output.
Resolution—The resolution that the video card uses. The Resolution editor displays 
a list of commonly used resolutions, or you can type in a new resolution by using the 
format WidthxHeight (i.e., 1200x300 or 830x30).
Refresh Rate—The refresh rate. Select from a list of commonly used refresh rates or 
type in a new rate.
Depth—The bit depth of the video card: 32 or 16.

NOTE
The Configure Player dialog does not currently check to ensure that you enter or select 
properties valid for the video card. Setting the resolution, refresh rate, or depth to values 
not supported by the video card will result in a player error and prevent content playback.

Orientation—The orientation of any displays connected to this video output. Set the 
orientation so that content is positioned correctly. 

3. Click OK or Apply Changes.

Managing Player Regions

CoolSign players can support up to eight simultaneous player regions independently 
playing back content. You can use the Configure Player dialog to add new regions and edit 
or remove existing regions.

WARNING
Multi-region playback performance is highly dependent on the resolution and type of 
content in each channel as well as CPU processor speed, RAM, and video card. If your 
desired multi-region layout is resulting in playback hitching, you may need to upgrade the 
PC components or lower the content performance requirements.

To add a new region:

• Click Add Region.

To edit an existing region:

1. Select the region in the Player Regions grid.

2. Do one of the following:
• Directly edit the Format, Width, Height, OffsetX, and OffsetY properties in the 

grid.
• Click Edit Region to display the Region Properties dialog to edit all properties in-

cluded advanced properties.

3. Click OK or Apply Changes.
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You can edit any of the following Player Region properties:

Format—The type of channels and content that can be scheduled on the player. For 
more information on format and orientation, see “Understanding Orientation and For-
mat” on page 189.
Width and Height—The size in pixels of the player region as it will appear on the 
screen.
OffsetX and OffsetY—The position of the player region relative to the upper-left 
hand corner of the screen.

You additionally can edit any of the following advanced properties from the Region Prop-
erties dialog:

Layer—The z-order layer of the region. You can also manage the ordering of regions 
with the Bring to Front and Send to Back buttons.
Transition Color—The color used by any content transitions during playback. This 
color can be overridden by setting the transition color directly on the content via the 
Content Properties dialog.
Gap Time—The number of milliseconds that the player will wait between each con-
tent. 

NOTE
Setting the Gap Time to 0 will cause the player to attempt to play content back-to-back but 
there still may be a flash of black.

Script Setup Time—The amount of time, in milliseconds, to give the media player to 
get the next ad ready.
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Working with Regions

You can use the Configure Player dialog to position, size, and layer the regions on a player. 
You can either directly input numeric values for the position and size of a region or you can 
directly drag on the region in the Region Layout window. You can also right-click on a 
region to perform additional actions on the region.

To resize a region in the Region Layout window:

• Click and drag on the edge of the region you want to resize. By default, edges will snap 
to the edges of other regions. To turn off edge snapping, hold down the CTRL key 
while dragging.

To reposition a region:

• Click and drag on the center of the region you want to reposition. You cannot 
reposition a region so that any part of it is outside the screen area.

To maximize the size of a region:

• Right-click on the region and choose MAXIMIZE WIDTH or MAXIMIZE HEIGHT. The region 
will be resized to fit the appropriate dimension of the player.

To split a single region into two regions:

• Right-click on the region and choose SPLIT HORIZONTALLY or SPLIT VERTICALLY. The 
region will be split into two equally sized regions.

Layering Regions

Regions are allowed to overlap with each other. You can use overlapping regions when you 
want one region to play on top of another region. Any visible background area in your 
content will be transparent for overlapping regions. You can set the order in which regions 
are layered.

To change the layer order of a region, do one of the following:

• Select the region and click BRING TO FRONT or SEND TO BACK.
• Right-click the region and choose MOVE TO FRONT or MOVE TO BACK.
• Select the region and click EDIT REGION to directly edit the region’s Layer property.

Saving Layouts

Once you have laid out the regions for a player, you can save that layout so that you can 
easily apply it to other players. 
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To save the current layout:

1. Click Save Current Layout.

2. Enter a name for the saved layout.

To apply a saved layout to the current player:

• Select a saved layout from the Predefined Layouts pull-down menu.

NOTE
Layouts are saved with exact positioning and sizes for each region. Applying a region 
created for a player with a different video resolution can result in regions being positioned 
off-screen. You may want to label each saved layout with the resolution it was created for 
(i.e., MyLayout 1024x768, etc.).

To delete a saved layout:

1. Select the saved layout from the Predefined Layouts combobox.

2. Click the  button to delete the layout.

Understanding Orientation and Format

The difference between a video output orientation and a player format can be confusing 
because both use values named Landscape and Portrait. This section summarizes the differ-
ences between these properties.

Orientation

Orientation is the setting on a video output that indicates the physical orientation of the 
display devices connected to a player. The values can be:

Landscape (0°)—The display is in its normal TV orientation where the top of the 
screen is the top.
Portrait (-90°)—The display is rotated 90 degrees to the left so that the right-side of 
the screen is now the top.
PortraitCW (+90°)—The display is rotated 90 degrees to the right so that the right-
side of the screen is now the bottom.
UpsideDown (180°)—The display is rotated upside down.

Orientation is used by the CoolSign software to correctly position your content on the 
screen. You should always set the orientation to match the physical orientation of the 
display device. 
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Format 

The format of a player indicates which channels are permitted to be scheduled on that 
player. You can only tune players to channels of the same format which can, in turn, only 
include content of the same format. In a default CoolSign network, the available formats 
can be:

Landscape—Indicates standard 4:3 or 16:9 content (although can be used to refer to 
any content which is wider than tall).
Portrait—Usually indicates 9:16 content (although can be used to refer to any content 
which is taller than wide).
Audio—Indicates MP3 audio-only content which is managed from the Audio page.

Format is an arbitrary tag assigned to content that makes it easy to manage a combination 
of Landscape, Portrait, and Audio players without worrying about scheduling the wrong 
content for the physical orientation of the display.

For most cases, set the format of your player to match the orientation of the display (i.e., 
Landscape/UpsideDown orientation and Landscape format or Portrait/PortraitCW with 
Portrait format). For special display needs, you can, however, use different combinations. 
For example, you can use the region sizing and positioning settings to position a Portrait 
format player so it correctly displays on a Landscape-oriented video output.

Configuring Display Control Devices

You can connect supported display devices to a CoolSign player via a serial cable and use 
CoolSign to remotely monitor and control the display device. Display control devices 
enable you to set or schedule which input a display device should use and turn the display 
device on or off.

NOTE
The Custom Display Control Editor can be used to configure any display capable of being 
controlled via an RS-232 port. As of CoolSign 5.1, this includes monitors that support 
hexadecimal commands. See Chapter 24. "Using the Custom Display Control Editor", on 
page 350

In the Configure Player dialog, the top half of the Devices tab includes a list of all devices 
that this player recognizes. For example:
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View the status 
of any 

Use these buttons to add, 
edit, or remove devices.

By default, this device list includes the following columns: name, type, status, connection 
type, and node.

NOTE
For details on how to display additional columns in the device list, see “Changing which 
Columns are Visible” on page 25. 

When you select a display in the device list, the lower half of the tab includes a display 
control:

Directly control a display 
input here.

Use this 
grid to 
schedule 
display 
input and 
on/off 
settings.

• For details on manually setting the display control, see “Setting Display Control” on 
page 195.

• For details on using the schedule grid, see “Setting Display Control” on page 195.
• You can simultaneously select two or more displays in the device list. For details, see 

“To configure multiple displays:” on page 197.

You can configure control of the display on the Devices tab of the Configure Player dialog.
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View the status of 
any displays in this 
area.

Directly control a 
display input here.

Use these buttons to add, 
edit, and remove devices.

Use this grid to 
schedule display 
input and on/off 
settings.

To add a new display device:

NOTE
You should only add a display (using the Configure Player dialog) after you have 
physically connected the display to the player PC with a serial cable. Adding a display 
before physically connecting will raise a display status error until the display is actually 
connected.

1. Click the Add button.

2. Select DIRECT DISPLAY from the pop-up.
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3. In the Display Properties dialog, enter a name for the new display.

4. Select the Brand and Model of the display you have connected from the Brand and 
Model drop-downs.

WARNING
The brand and model must exactly match the display connected to the player. Otherwise, 
the display control will most likely not work and report an error status.

5. Set the COM port the player PC will use to communicate with the display.

6. Set the DisplayID if your display device supports daisy-chaining multiple devices.

7. Enter a name for any available inputs that you intend to use. You must keep one input 
labeled as CoolSign.

8. If the display supports disabling the control buttons, you can check Disable panel 
checkbox.
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9. If the display supports auto-calibration, you can set the auto-calibration properties.

10. Add any comments that might be of benefit to your administration of the device and 
your   network.

11. Click OK to close the Devices dialog.

12. Click OK or Apply Changes to add the new display.

To edit a display:

1. Select the display in the Devices grid of the Devices tab.

2. Click the Edit button. 

3. In the Display Properties dialog, change any properties of the display.

4. Click OK to close the Display Properties dialog.

5. Click either the OK or Apply Changes button to effect your display changes.

To remove a display:

1. Select the display in the Devices grid.

2. Click the Remove button.

3. Click either the OK or Apply Changes button to remove the display.

About the CoolSign Null Display

For players that are connected to a display device that is not controllable via serial, or for 
which CoolSign does not provide serial control support, you can add the CoolSign Null 
display. The CoolSign Null display acts as a placeholder for an actual physical display 
device, so that you can still use display control to schedule when the player should turn on 
and off even without a serial-controlled display. 

NOTE
The CoolSign Null display does not raise any status conditions or provide any feedback to 
determine if the actual display is working or not.
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To add a CoolSign null display:

1. On the Devices tab of the Configure Player dialog, click the Add button.

2. Click the Direct Display radio button.

3. Select “CoolSign” from the Brand combo box.

4. Select “NULL” from the Model combo box.

5. Click OK.

Setting Display Control

By default, each display added to a player is set to use the input labeled as CoolSign on its 
Display Properties dialog. If you want to directly control a device, you can manually set the 
display to use any of the inputs labeled on the Display Properties dialog or you can turn off 
the display.

To manually set display control:

1. Click the “Set Display to” radio button.

2. In the Display Control combo box, select an input or Off.

3. Click OK or Apply Changes.

Scheduling Display Control

If you want a display to turn on and off on a schedule or switch to a different input, you can 
schedule the display control using the Display Control schedule grid.
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To schedule display control:

1. Click the “Set display according to schedule” radio button.

2. Set a schedule using the Display Control schedule grid. Click or drag a range of cells 
to toggle the display from OFF to CoolSign during that time, or right-click on a cell or 
selection of cells to select an input for the display at that time.
For more information on using schedule grids, see 19. "Using Schedule Grids", on 
page 306.

3. Click OK or Apply Changes.

Adding Multiple Displays

CoolSign supports controlling multiple displays serially. If your display devices support 
daisy-chaining multiple devices on a single serial port, you can set the appropriate Display 
ID property for each display from the Display Properties dialog.

If your display devices do not support daisy-chaining, you must connect each display to its 
own serial COM port and set the appropriate COM port in each Display Properties dialog. 
You can only connect a single device to each COM port and will be warned if you attempt 
to configure a display on a COM port that is already assigned to another display.

TIP
You can use a third-party serial port extender to add additional serial COM ports to a 
Windows PC.
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By default, when you configure multiple displays on a player, they will all use the same 
display control settings as defined in the Display Control settings box.

To configure multiple displays:

When you select multiple displays in the list at the top of the Devices tab (“To add a new 
display device:” on page 192), you can view and set the values for all displays simultane-
ously. The following conditions apply:

• If you are controlling the displays manually (see “Setting Display Control” on 
page 195), the Display Control combo-box is empty if the selected displays are 
configured with different inputs. If all selected displays do not have the same model, 
the display control choices are limited to “CoolSign” and “Off”.

• If you are using the schedule grid for display control (see “Scheduling Display 
Control” on page 195), the grid displays “Mixed Schedule” if all selected displays do 
not have the same schedule.

• When you click Apply Changes or OK, any values that are in Mixed mode are 
unchanged; that is, the value for each individual display is preserved.
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CoolSign is designed to support everything from a single standalone player to a large 
network of players located around the world. When you begin to deploy CoolSign players 
to multiple locations, it becomes useful to start thinking in terms of the sites where your 
players are installed—especially when each site may have multiple players and possibly a 
transfer node.

To help you organize the way you view your players and nodes, CNM lets you define 
virtual sites that represent the physical locations where your players are deployed.

Using CNM, you can easily create new sites, assign metadata to a site, and organize your 
players and nodes into sites that are viewable in a geographic tree hierarchy or flat view.

About Sites

Sites are a tool to help you represent the geographic organization of the players in your 
network. A site does not represent an actual CoolSign player or transfer node but, rather, 
the location where one or more nodes are deployed. While it may be tempting to think of a 
transfer node as an equivalent to a site since, in most common network topologies, a single 
transfer node is located at each site, this is not always the case. For example, if your site 
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only has a single player deployed at a site, it wouldn’t be necessary to also have a transfer 
node, but you would still want to represent the site for that player. Furthermore, transfer 
nodes are often used to improve scalability in the NOC or regional locations and, therefore, 
don’t always represent a physical site.

Sites are actually very similar to QuickSets with the following differences:

• Sites are only available for players and network nodes.
• Each node in a network can only belong to a single site.
• You can assign metadata to a site so that you can track business-related information.
• Sites can be viewed in a special geographic tree view.

Working with Players and Sites

Sites are available to help you organize how you view the players in your CoolSign 
network. You can organize your players into different sites and then use the site’s quickbar 
to quickly view all the players within a site or geographic region.

To view the sites quickbar for players:

1. Open the Players page by clicking the Players icon in the navigation bar.

2. By default, the sites quickbar should be visible at the left of the players grid. 
If the quickbar is not visible, choose VIEWS > QUICKBAR to make it visible. If the sites 
panel is not visible, click the sites button in the quickbar.
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Viewing all the Players within a Site

When you click on a site node in the sites panel, the data grid displays only the players 
located in that site or geographic location. Clicking on a city, state, or country node shows 
you all of the players in all of the sites located underneath that node. This makes it easy to 
quickly filter your view of players from anywhere within a site — up to all the players in a 
specific city, state, or country.

Clicking a site node in the sites panel also displays a site info panel above the data grid, 
with specific information about any Attributes you have defined.
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Changing the Sites Panel View

By default, the sites panel shows a geographic tree view of your sites with levels for the 
country, state, and city. You can also choose to view your sites in a flat view without the 
geographic hierarchy. 

To change the sites panel view:

1. Click the Options button at the bottom of the sites panel.

2. Select Geo View for the default geographic tree view or Flat View to display just the 
site nodes.

Creating a New Site

When installing CoolSign software to a new PC, you have the option to set the default site 
name for that player. When the player first connects to a CoolSign network, it adds itself to 
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a site (if it already exists); otherwise, the player creates a new site with that name automat-
ically. 

NOTE
You can edit the properties of the player-created site to add geographic information (such 
as longitude and latitude that is required for Vistar content) or other metadata. See 
“Editing Site Properties” on page 203.

You can create new sites as needed to reorganize your players.

To create a new site:

1. Right-click anywhere in the site panel to display the sites popup menu.

2. Choose CREATE SITE. A new Site Properties dialog appears. If you right-clicked on a 
country, state, or city node in the sites panel, the new site is automatically set to that 
geographic region.

3. Enter a site name.

4. Enter the address information for the site into the fields provided.
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5. Click OK. A new empty site will be created in the site treelist.

Assigning a Player to a Site

Players can be assigned to a site when originally configured during installation. If your 
player was assigned during install to an incorrect site or was left to the “Default” site, you 
can easily reassign the player to a different site. 

WARNING
Reassigning a player’s site does not change the physical topology of your network. You 
cannot point a player to a different transfer node just by changing its site. Sites are virtual 
organizations only.

To reassign a player to a different site:

• Select the player and drag/drop it onto a site in the site treelist. The player is reassigned 
to the new site.

NOTE
You can only drop a player onto a site icon. You can’t drag onto the country, state, or city 
nodes in the site tree.

You can also reassign a player’s site from the Node Properties dialog on the Network page. 
For more information, see “Editing Node Properties” on page 286.

Editing Site Properties

Sites that are created automatically for new players do not contain any information other 
than the site’s name. 

NOTE
Some content requires that additional information is defined for a site. For example, Vistar 
requires that longitude and latitude are defined for a site. 

You can edit the site to set geographic information, define the hours that the site is open, 
and add any attributes you desire. 

To edit a site’s properties:

• Right-click on the site’s node in the site treelist and choose EDIT SITE.
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Setting the Hours for a Site

If your site represents a business or other commercial location, you can define the hours for 
which the site is open.

NOTE
Players within a site will continue to play their schedules even if a site is scheduled to be 
closed at a certain time. If you want to schedule a player to start and stop playing at 
specific times, you can use the player’s display control schedule.

For more information on retrieving playlogs, see “Retrieving Play History for Content” on 
page 120.

To set the open hours for a site:

1. From the Site Properties dialog, click the Site Hours tab.

2. Using the site hours scheduling grid, set the schedule for which the site is open.

For more information on using scheduling grids, see 19. "Using Schedule Grids", on 
page 306.

Add Attributes to a Site

With the Attributes tab, you can add your own custom Attribute to a site if you’d like to 
track additional data about each site that is relevant to your business.
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To add an Attribute to a site:

1. From the Site Properties dialog, click the Attributes tab.

Click directly into the value 
column of a user field to edit.

2. Click Define Attributes to open the Site Attributes dialog.

3. Click Add to open a new Attribute Properties dialog.

Enter the name of the new 
Attribute here.

Click the Use picklist check 
box to show a combobox 
with the values entered in the 
picklist area. Default Value: 
Enter a default value for the 
attribute (if applicable). 

Check this box to let the user 
enter custom values into the 
combobox.

4. Enter a name for the site Attribute and add the appropriate values for the fields.
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5. Click OK.

Deleting a Site

If you have an empty site, you can delete it so that it no longer appears in the sites panel. 
You can only delete sites that no longer contain any player nodes, transfer nodes, or the 
network controller. When you delete the only remaining site for a city, state, or country, the 
site treelist will refresh to remove any geographic nodes that no longer contain any sites.

NOTE
 If transfer nodes or the network controller are assigned to the site you are trying to delete, 
you must use the Networks page to reassign those nodes to another site first.

To delete a site:

• Right-click on the site node in the site treelist and choose DELETE SITE.
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One of the most powerful features of CoolSign is its ability to use external data to control 
and update content and/or schedules.

You can use CoolSign's dynamic data features to:

• Dynamically update text displayed in your content.
• Dynamically update images or movies played back within your content.
• Dynamically show or hide assets within your content based on logic that references the 

values of your data.
• Display multiple rows of data in a tabular layout.
• Create flexible tickers and scrolling lists of your data.
• Dynamically enable or disable active items in a schedule, using Enabling Expressions.
• Pass dynamic payloads to triggered content. 

About Data Tables

All dynamic data in CoolSign is stored in objects called data tables. Data tables are mini-
databases. The data table structure is flexible to allow you store anything from a single 
piece of information to hundreds of records with dozens of fields. A data table can be visu-
alized as a table where each row represents a record and each column represents a field in 
that record. Each field in a data table can store text, dates, numbers, yes/no (Boolean 
values), or media files (such as images, flash, and video).

Each horizontal row 
represents a record 
of the data table.

Each vertical column 
represents a field in 
the record.

You can think of a data table as a container for your data. Whether you enter data manually 
via the Data Tables page of the CNM or import it through the CoolSign Data Watcher, that 
data is stored in a data table.
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You can manage the data tables in your CoolSign network from the Data Tables tab of 
CNM. From the Data Tables tab you can manually edit the data or create, duplicate, and 
delete data tables. 

For more information on managing data tables, see Chapter 16, "Managing Data Tables."

Auto-Created Data Tables

While you can manually create new data tables with the Data Tables tab of CNM, most of 
the time your data tables will be automatically created for you.

The following actions can automatically create data tables:

• Importing dynamic content generated using the CoolSign Content Creator.
• Adding a new data watcher configuration to the CoolSign Data Watcher.
• Running a custom data interface application programmed using the CoolSign API.

Auto-created data tables appear on the Data Tables tab and can be managed the same as 
manually created data tables.

NOTE
Modifying the structure or deleting an auto-created data table can cause content that uses 
that data table to stop playing and raise a content error.

Using Data Tables in your Content

You can create dynamic content that will display the data stored in a data table when the 
content is played back. Any time the data in the table is modified (either manually or via an 
external tool like the Data Watcher), the content is automatically updated to reflect the new 
data.

You can create dynamic content with the CoolSign Content Creator, which is available as 
a separate product. For detailed information on authoring dynamic content, refer to the 
CoolSign Content Creator User’s Guide.

Binding Dynamic Content to a Data Table

Content that references the data in a data table is said to be “bound” to the data table. 
Binding content to a data table lets CoolSign know that the data table is required wherever 
that content is scheduled.

When you import content created using CoolSign Content Creator, an empty data table for 
the content will be created if it doesn’t already exist, and the content will be automatically 
bound to the data table. 

In CNM, you can use the Content Properties dialog to bind the content to a different data 
table.
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To bind dynamic content to a data table:

1. From the Content page, open the Content Properties dialog by right-clicking the 
desired item or clicking ACTIONS > EDIT CONTENT PROPERTIES, or simply double-click 
the item’s name in the list.

2. From the Content Properties dialog for your content, select the Dynamic Data tab.

Select a data table to 
bind content to from 
this combobox.

You can directly edit the data 
in a data table here instead 
of from the Data Table tab.

 

3. Choose the data table you wish to bind your content to from the WATCH DATABASE 
pull-down menu. 

NOTE

The pull-down menu only lists data tables that match the field structure defined within 
the content. If you want to bind the content to a data table that doesn’t appear in the 
list, click the Show All Data Tables checkbox to list all the data tables in your 
network.

WARNING
Binding content to a data table that doesn’t contain fields required by the content usually 
results in a content error when trying to play back the content.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 209



14. About Dynamic Data 
Getting Data into Data Tables
4. Click OK or Apply Changes.

NOTE
You can override data table bindings when you schedule so that the same piece of content 
can be bound to different data tables depending on where it is scheduled. For more 
information on overriding data table bindings at schedule time, see “Overriding Dynamic 
Data Settings” on page 181.

Getting Data into Data Tables

Ultimately, data tables are only useful if they contain data. You can get data into your data 
tables in any of the following ways:

• Manually input data using the Data Tables tab of CNM.
• Use the CoolSign Data Watcher to read data from an external data source and 

automatically import it into a CoolSign data table.
• Run a custom data integration application programmed using the CoolSign API.

Manually Inputting Data

You can use the Data Tables tab of CNM to edit the data within your data tables.

Click the ... button 
in a media field to 
import a media 
asset into the data 

Right-click in any col-
umn header to show 
a popup menu with 
additional options.

Click within a text 
field to directly edit 
the value of the field.

Click to add or delete 
rows from the data table.

 

While manually editing data you can:

• Add and remove rows of data.
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• Input text, numbers, and dates into fields.
• Import images and movies into media fields.
• Set the activation and expiration date for each individual row.
• Import or export the data to a comma-delimited file.
• Print the data.

For more information on how to edit data in a data table, see “Editing Data in a Data Table” 
on page 279.

Localizing Data

In many cases, you will want to use different data depending on the player’s physical 
location or some other property of the player. For example, if you are showing content that 
dynamically displays the current weather, you would obviously want to show only the 
weather for the city in which the player is located. CoolSign provides tools to help you 
localize your data so you can control which dynamic data appears on which player in your 
network.

It might seem like you could implement data localizing by creating a unique data table for 
each locale that requires a unique row or rows of data, and then scheduling content bound 
to that data table for each player. However, this would quickly become difficult to manage 
for a large number of sites and players. CoolSign can use a combination of data row 
filtering and node attributes to define an expression that does localizing all from a single 
data table.

How does localizing work?

Dynamic content created using the CoolSign Content Creator can be filtered so that certain 
records (rows) of a bound data table are available to be displayed. The filter expression 
checks the value of a designated field in each record with the specified comparison criteria. 
The filter expression may evaluate to many records, one unique record, or even no records 
at all, depending on the available records and the filter criteria. For localizing, you can use 
the filter expression to compare a field in each record against an attribute of the player. This 
results in only the records being used that match the criteria for the current player. For 
example, if your data table has a field named ZipCode and your player has an attribute 
named ZipCode, you could create a filter expression that would only use the records in a 
data table where the ZipCode field matched the player’s ZipCode attribute.

NOTE
You can localize enabling expressions using the same methods. For more information on 
enabling expressions, see “Using Enabling Expressions” on page 123.

For more information on defining and setting attributes, see “About Node Attributes” on 
page 292.
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About CoolSign Data Watcher

The CoolSign Data Watcher is designed to act as a bridge between some external data 
source and your CoolSign network. You can configure instances of the Data Watcher to 
read data from one or more data sources, parse that data into records and fields, and then 
insert it into a data table on your network. The data source can be a structured text file 
(comma-delimited file, etc.) or an XML document, and can be located on any local or 
network hard drive, ftp site, or http address. The Data Watcher can also be used to execute 
custom scripts that gather data from data sources with programmatic interfaces such as SQL 
databases or web services.

For detailed information on using and configuring the Data Watcher, see Chapter 15, 
"Using the Data Watcher Manager."
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The CoolSign Data Watcher allows you to bring dynamic data from external data sources 
into your CoolSign network. 

As described in Chapter 14, "About Dynamic Data." CoolSign can use dynamic data in a 
number of different ways. The most common way is to display the data within a piece of 
content. For example, you might create a piece of content that displays the current tempera-
ture, the name and price of a product, or a news headline. With dynamic content, when the 
underlying data changes, the content is automatically updated to display the new values. 
Displaying dynamic data is not limited to text information and can also include embedded 
bitmaps, videos, or Flash assets. 

What does the Data Watcher do?

The Data Watcher acts as a bridge between a data source and a CoolSign network. The Data 
Watcher can read data from various types of data sources (for example, a file on your hard 
drive or a website), parse that data using a configurable data parser, and then import it into 
a CoolSign data table. The Data Watcher continues to run and automatically update its 
CoolSign data tables whenever there is a change to the original data source, to referenced 
assets, or to the Data Watcher configuration.

The Data Watcher Manager

As with other CNM pages, the Data Watcher Manager has two panels: a nodes panel and a 
grid view. 

The nodes panel shows all of the nodes on which an instance of the Data Watcher service 
is running and indicates each node’s overall status.
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Click to show all of the Data 
Watchers running on the net-
work, including the Network 
Controller.If applicable, indi-

cates that this trans-
fer node is currently 

Click a node in this pane 
to show all of the Data 
Watchers running on it 
in the grid.

The grid view displays each Data Watcher’s full name (including the name of the node) and 
status:

Initial status of a new or newly 
modified Data Watcher.

The Data Watcher service can’t 
process the Data Watcher configu-
ration.

To open the Data Watcher Editor dialog:

Select the Data Watcher in the data grid, then do one of the following:

• Right-click and choose EDIT DATA WATCHER PROPERTIES. 
• Choose ACTIONS > EDIT DATA WATCHER PROPERTIES.
• Double-click on the Data Watcher in the data grid.

Configuring a Data Watcher

You can define multiple Data Watcher configurations—each one tied to its own data source 
and imported into a specified data table. This brief section summarizes the process of 
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configuring a Data Watcher configuration (DWC) file. Subsequent sections describe each 
of the steps in detail.

NOTE
Do not confuse this process with the Data Watcher service configuration (see “Step 6: 
Test the Data Watcher configuration” on page 237). A DWC file defines the 
configuration for an individual Data Watcher; the Data Watcher service configuration 
contains settings for the Data Watcher service itself. 

To configure a Data Watcher:

1. In the Data Watcher nodes panel, select a Data Watcher node.
Right-click and choose CREATE NEW DATA WATCHER.

2. In the Data Watcher Editor’s Scope tab (see “Step 1: Define the scope” on 
page 217), specify whether the data should be available to the entire network or 
restricted to the node on which the Data Watcher is running (and all of that node’s 
children).

3. In the Data Watcher Editor’s Data Source tab (see “Step 2: Set up the data 
source” on page 217), select and configure the source from which your Data 
Watcher will read data.

4. In the Data Parser tab (see “Step 3: Set up the data parser” on page 222), 
choose the data parser that will be used to parse the data into fields that will be 
imported into a CoolSign data table. 
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5. In the Field Mapping tab (see “Step 4: Map data source fields to CoolSign 
data tables” on page 229), define how the selected data parser should parse each 
field from the data source and map it into the field of a CoolSign data table. 

6. In the Data Table tab (see “Step 5: Set data table properties” on page 234), 
specify the frequency and method with which the Data Watcher will update the 
CoolSign data table.

7. When you’ve finished configuring properties, click Test Configuration (see “Step 6: 
Test the Data Watcher configuration” on page 237) to verify your settings. 

NOTE
There are special considerations that apply when editing configurations locally with the 
standalone version of the Data Watcher Editor. For details, see “To remove an existing 
Data Watcher configuration:” on page 239. 

Importing and Exporting Configurations

You can import or export Data Watcher configurations to move them to and from other 
Data Watchers.

To export a Data Watcher configuration:

1. Choose the Data Watcher you want to export.

2. Choose CONFIGURATIONS > EXPORT DATA WATCHER.

3. Enter a name for the saved Data Watcher configuration.

To import a Data Watcher configuration:

NOTE
The following must be performed from the Network Controller or Transfer Node.

1. Choose CONFIGURATIONS > IMPORT DATA WATCHER.

2. Using the file browser, select the Data Watcher Configuration (DWC file) that you 
want to import.
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Step 1: Define the scope

In the Data Watcher Editor, you determine the scope of this Data Watcher. 

• Central Data Watcher—Data obtained by this Data Watcher is stored on the Network 
Controller, and is available on all nodes throughout the network.

• Local Data Watcher—Data obtained by this Data Watcher is available only on the 
node where the Data Watcher is running, and on all of its children (as shown in the 
Node Preview area). 
In the Local Options area, select the data table that you want to override. Indicate 
whether you want to replace all central data with local data, or merge local data with 
the existing data:
• Local Data Only—Replace all central data with local data.
• Local Data + Central Data—Merge local data with central data. If the same key 

is associated with different values in the central and local data, the local value will 
be used in the local version of the data table.

Step 2: Set up the data source

In the Data Watcher Editor, you use the TYPE pull-down menu to select the data source type 
for your configuration: 
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• File—Select this source when reading your data from a file located somewhere on 
your local hard drive or shared network drive. For details, see “Configuring a File Data 
Source” on page 218.

• URL—Select this source when reading data from a website or other http addressable 
location. For details, see “Configuring a URL Data Source” on page 219.

• FTP—The dynamic data is located on an FTP site. For details, see “Configuring an 
FTP Data Source” on page 220.

• External Command—Use this data source when the Data Watcher doesn’t support 
the type of data source you want to parse and you can write an external script or 
program to gather that data. For details, see “Configuring an External Command Data 
Source” on page 220.

• Database – SQL Server—Use this data source when reading from a SQL Server 
database. For details, see “Configuring an SQL Server Data Source” on page 221.

• Database – ODBC—Use this data source when connecting to an ODBC-supported 
database. For details, see “Configuring an ODBC Data Source” on page 222.

Configuring a File Data Source
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You can define the following properties for a File data source:

FilePath—Enter a full path to a local or networked file. To select a file using a standard 
file browser dialog, click the ellipses button on the right side of the textbox. Note that this 
option only applies to the stand-alone version.

NOTE

The Data Watcher is a service, you cannot use mapped drives to specify the file path. 

Delete file after reading—Check this box if you want the Data Watcher to delete the file 
after each time it is read and parsed.

Configuring a URL Data Source

You can define the following properties for a URL data source:

URL—Enter the full http URL to the file that should be read by the Data Watcher.

Allow Caching—When this box is unchecked, a no-cache HTTP header is attached to all 
requests.

HTTP Authentication—You can specify a user name and password for HTTP authenti-
cation, so that the Data Watcher can automatically log you in and obtain data from the 
specified site. 

NOTE

If you want to use a domain account, you must preface your user name with a 
domain name – for example, Domain_name\user_name.

Proxy Server Properties — If your network requires a proxy to access the URL, you 
can enter it here. Supply a user name and password, if required by the proxy server.
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Configuring an FTP Data Source 

You can define the following properties for an FTP data source:

FTP Server—The name of the FTP site that the Data Watcher will connect to.

User name—A valid user name that can be used to log in to the FTP site.

Password—The password for the user account.

File Path—The relative path to the file to be read from the default login directory of the 
FTP site.

Proxy Server Properties—If you are using a proxy server to cache FTP requests, you 
may also need to supply login credentials.

NOTE
If the proxy server is configured to cache FTP requests, the Data Watcher may receive 
expired data. Unlike HTTP, there is no known method for disabling FTP caching of Data 
Watcher requests without changing the configuration of the proxy server.

NOTE
The Media List parser is not supported for FTP data sources if you are also using a proxy 
server. 

Configuring an External Command Data Source

The External Command data source is used whenever you want to execute an external 
script or program to gather the data that should be parsed. This might include connecting to 
a SQL database, scraping a website, or interfacing with a custom data source. The executed 
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script must write out a file that can be read back in and parsed by the Data Watcher using 
one of the supported Data Parser types (see “Step 3: Set up the data parser” on 
page 222). 

You can define the following properties for an External Command data source:

Command Path—The full path to the executable that should be used to generate your 
data.

Arguments—Any arguments that should be provided to the executable.

Output Path—The full path where the executable writes its data. This file is read and 
parsed by the Data Watcher when the command has finished.

Timeout—How long the Data Watcher should wait for the command to execute. If the 
command takes longer than the timeout, the Data Watcher logs an error.

Delete output file after reading—Check this box if you want the output file to be 
deleted each time the Data Watcher reads and parses it. This ensures that the data source is 
not stale if the external command fails to execute.

Configuring an SQL Server Data Source

You can define the following properties for an SQL Server data source:

Server Name—The network address of the server to connect to.

User Name—A valid user name that can be used to log in to the SQL Server.

Password—The password for the user account.

Database—The name of the database to use.

Query—The SQL query. Only select those fields that will be used for parsing. Disallowed 
fields (such as binary or text) can cause errors, even if they are not used in the data table.
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Configuring an ODBC Data Source

You can define the following properties for an ODBC data source:

DSN—The name of the ODBC data source to connect to. This name is set up in Windows 
via the ODBC Data Source Administrator.

User Name—(May not be required for all databases) A valid user name that can be used 
to log in to the ODBC database.

Password—(May not be required for all databases) The password for the user account.

Query—The SQL query. Only select those fields that will be used for parsing. Disallowed 
fields (such as binary or text) can cause errors, even if they are not used in the data table.

Step 3: Set up the data parser

The Data Parser defines how the data read from each type of data source will be parsed into 
fields that will be imported into a CoolSign data table. You should select the appropriate 
data parser based on how the data in your data source is organized.

Use the Parser pull-down menu to select one of the following data parsers:

NOTE
Parser options vary depending on the selected Data Source.

• XML (see “Configuring an XML Data Parser” on page 223).
• Delimited Field (see “Configuring a Delimited Field Data Parser” on page 225).
• Fixed-Length Field (see “Configuring a Fixed-Length Field Data Parser” on 

page 227).
• Media List (see “Configuring a Media List Data Parser” on page 227).
• Database (see “Configuring a Database Data Parser” on page 228).
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• Regular Expression (see “Configuring a Regular Expression Data Parser” on 
page 228).

Configuring the Data Parser: General Properties 

In addition to specific properties for each type of data parser, the following settings apply 
to all data parsers.

Maximum # of Rows to Parse—You can limit how many rows (such as records) of data 
are parsed from the data source. Any rows beyond this maximum are discarded.

 Trim WhiteSpace—Check this box to trim any leading or trailing white space from a 
parsed field. 

 Trim from start/Trim from end—Enter any string that should be trimmed from the 
start and end of each parsed field. For example, if you want to trim quotes from fields, you 
would enter a quote character in both the Trim from start text box and the Trim from 
end text box.

 Strip HTML tags from data—CoolSign does not support formatting dynamic text 
with HTML tags (such as <b> and <i>). If these tags are present in your data source, they 
will appear in your dynamic text as well. Checking this box strips the HTML tags from any 
imported data.

Configuring an XML Data Parser

If your data source is an XML file, you can use the XML data parser to parse it.
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This is an example of what the contents of a XML file might look like:

<DataCall-DLM-Data-Micro>

<born-on-this-date>

<headline>English statesman and writer

Thomas More in 1478</headline>

</born-on-this-date>

<born-on-this-date>

<headline>Farm equipment manufacturer

John Deere in 1804</headline>

</born-on-this-date>

<born-on-this-date>

<headline>English novelist Charles Dickens 

in 1812</headline>

</born-on-this-date>

</DataCall-DLM-Data-Micro>

In addition to the properties that apply to all parser types (see “Configuring the Data Parser: 
General Properties” on page 223), you can define the following properties for an XML data 
parser:
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 224



15. Using the Data Watcher Manager 
Configuring a Data Watcher
Record Path—Enter the xml path to the node in your xml that should be treated as a 
record. For example, if you were parsing an XML file that contained the following:

<IRXML>

<StockQuotes>

<Stock Name="MSFT">

<Price>32.50</Price>

</Stock>

<Stock Name="AAPL">

<Price>45</Price>

</Stock>

.

.

.

</StockQuotes>

<IRXML>

the record path would be "IRXML/StockQuotes/Stock." This would create one record in 
your data table for each <Stock> node in the XML.

NOTE
This is an XPath to the main record path. Namespaces are currently combined, and 
should not be used in specifying the XML path. For more information, refer to the XPath 
specification (http://www.w3.org/TR/xpath).

TIP
If you don’t know the record path, you can click Suggest Default Record Path to 
analyze your XML file and suggest a possible record path. For RSS and Atom data feeds, 
the suggested path is appropriate for the feed type.

Configuring a Delimited Field Data Parser

If your data source contains data that is in a delimited field format, you can use the 
Delimited Field data parser to parse it. A delimited field data source is one that contains a 
specific character or set of characters that delimit each field within a record of data, and a 
different character or string that delimits each record of data. Most commonly, commas or 
tabs are used as field delimiters and returns are used as record delimiters.
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This is an example of what the contents of a delimited field file might look like:

"John Doe","Vice President","johndoe@anywhere.com","37"

"Mary Smith","Vice President","marysmith@anywhere.com","42"

"Peter Jones","Manager","peterjones@anywhere.com","42"

NOTE
If the fields in your data source are quoted, you can use the Trim from start and Trim 
from end properties to trim the quotes from the parsed fields.

In addition to the properties that apply to all parser types (see “Configuring the Data Parser: 
General Properties” on page 223), you can define the following properties for a Delimited 
Field data parser:

Skip # of Lines at Start—Enter the number of lines you want to skip at the start of 
the parsing. This is useful if there is header information in the file (for example, the 
names of the fields) that you don’t want to parse.
Row Delimiter—Select the predefined delimiter character or string that should be 
used to delimit each record in the data source. You can also type in a custom delimiter 
string. 

NOTE

You can use the RETURN delimiter for the Carriage Return/Line Feed combination 
and the LINE FEED delimiter for just Line Feed delimiters.

Field Delimiter—Select the predefined delimiter that separates the fields in your data 
source. If the correct field delimiter is not available, you can type in your own character 
or string of characters.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 226



15. Using the Data Watcher Manager 
Configuring a Data Watcher
Configuring a Fixed-Length Field Data Parser

If your data source contains data that is in a fixed-length field format, you can use the Fixed-
Length Field data parser to parse it. A fixed-length field data source is one where each field 
in a record is a predefined fixed number of characters. If the contents of the field are shorter 
than the defined length, the field is padded with spaces.

This is an example of what the contents of a fixed-length field file might look like:

 John Doe      Vice President   johndoe@anywhere.com      37

 Mary Smith    Vice President   marysmith@anywhere.com    42

 Peter Jones   Manager          peterjones@anywhere.com   42

 

In addition to the properties that apply to all parser types (see “Configuring the Data Parser: 
General Properties” on page 223), you can define the following properties for a Fixed-
Length Field data parser:

Skip # of Lines at Start—Enter the number of lines you want to skip at the start of 
the parsing. This is useful if there is header information in the file (for example, the 
names of the fields) that you don’t want to parse.
Row Delimiter—Select the predefined delimiter character or string that should be 
used to delimit each record in the data source. You can also type in a custom delimiter 
string. 

NOTE

You can use the RETURN delimiter for the Carriage Return/Line Feed combination 
and the LINE FEED delimiter for just Line Feed delimiters.

Configuring a Media List Data Parser

The Media List data parser is a special parser that you can use to import a directory of 
images, videos, or flash files into a data table without requiring a parsable text file to 
reference the media paths. The Media List parser simply imports all the files located in the 
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data source path into the data table. The Media List parser is available with the File, 
External Command, and FTP data sources.

NOTE

The Media List parser is not supported for FTP data sources if you are also using a 
proxy server. 

NOTE

You must still define an appropriate field in the Data Watcher’s field mappings to 
contain the imported media. The Media List data parser only works correctly when all 
of the media in a location is of the same type. You cannot mix file types (that is, 
pictures, videos, or flash). 

Configuring a Database Data Parser

The Database data parser is a special parser that you use to parse content from an SQL 
Server or ODBC-supported database. The Database parser is only available with the SQL 
Server and ODBC data sources.

Configuring a Regular Expression Data Parser

The Regular Expression data parser allows you to extract data from many non-standard data 
formats, for which other data parsers do not apply. A regular expression is a string that 
determines how to extract text from a larger body of text.  

In addition to the properties that apply to all parser types (see “Configuring the Data Parser: 
General Properties” on page 223), you can define the following properties for a Regular 
Expression data parser:

Row Expression—Enter the expression that is to be parsed. Each group in the expression 
automatically becomes a separate Data Watcher field—for example, a text field that 
contains names and phone numbers, with each person on a separate line. 
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After using the data parser, you can subsequently use field mapping (see “Configuring 
Field Mappings” on page 232) to perform pattern matching within the text of each group. 
This can be useful when extracting data from an HTML file, or when reading from a custom 
external system (not CSV or tab-delimited) in which there are control characters that you 
need to ignore.

Step 4: Map data source fields to CoolSign data tables

In the Field Mapping tab, you define how the selected data parser should parse each field 
from the data source and map it into the field of a CoolSign data table. You should add a 
field mapping for every field you expect to ultimately see in your CoolSign data table. 

NOTE

When the Data Watcher connects to your CoolSign network, it automatically creates 
a data table matching the structure defined in the Field Mapping tab.

NOTE

On a local Data Watcher (see “Step 1: Define the scope” on page 217), you can 
only edit existing fields. You cannot add or remove data source fields on a local Data 
Watcher.
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To add a field mapping:

1. Click Add Field.

2. In the Configure Field Mapping dialog (see “Configuring Field Mappings” on 
page 232), enter a name for the field, select the type of data stored in the field, and 
configure any other available properties for the field mapping depending on the type 
of data parser selected.

3. Click OK.

To edit an existing field mapping:

1. Select the field in the grid.

2. Click Edit Field.
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To delete an existing field mapping:

1. Select the field you want to delete.

2. Click Remove Field.

Auto-Populating Field Mappings

Because of the self-describing nature of XML data, if your data source is parsed by the 
XML or Database data parser, you can choose to quickly auto-populate your field mappings 
rather than entering them manually. 

NOTE
This feature is only available with the standalone version of the Data Watcher Editor, and 
only when you are using the XML or Database data parser. 

NOTE
This feature is only available on a central Data Watcher (see “Step 1: Define the 
scope” on page 217), not on local Data Watchers.

To automatically populate field mappings:

• In the Field Mapping tab, click Populate Fields (see “Step 4: Map data source 
fields to CoolSign data tables” on page 229).
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Configuring Field Mappings

In the Configure Field Mapping dialog, you can configure the following properties for each 
field mapping:

Name—The name of the field as it will appear in your CoolSign data table.
Type—The type of data that will be stored in the CoolSign data table. For more infor-
mation on the available field data types, see “Adding Fields to a Data Table” on 
page 281.

This is a key field—Key fields are used to synchronize imported records with ex-
isting data already present in a data table. If you intend to use the Synchronize with 
existing rows method (page 236) for updating your data table, you must select at least 
one field as a key field in your field mappings. This field should contain data that is 
unique to a specific record in your data source so that the record can be matched with 
an existing record.

NOTE

You can mark multiple fields as key fields. In this case, the synchronize update 
attempts to match existing records based on the logical ANDing of all key fields.
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Depending on which data parser you have selected, you can set the following field mapping 
properties:

• XML data parser—You must define the XML Path for each field. You can use the 
name of an XML node or the @ sign to indicate an XML attribute. The path should be 
relative to the record path defined in the data parser (see “Configuring an XML Data 
Parser” on page 223).

NOTE

This is an XPath to the main record path. Namespaces are currently combined, and 
should not be used in specifying the XML path. For more information, refer to the 
XPath specification (http://www.w3.org/TR/xpath).

NOTE

When dealing with an XML file that uses attributes to store data, you need to use the 
@ sign so that the Data Watcher can retrieve that data.

• Delimited Field data parser—You must set the index of the source field in the data 
source that should be used for the mapping.

• Fixed-Length Field data parser—You must set the start character index of the 
field as well as the fixed length of the field used for the mapping.

• Database data parser—You must enter the Database Field Names, which refer to 
specific field names returned by the data source’s SQL statement.

• Regular Expression data parser—You can specify a new regular expression on 
the row text to extract the data for this field. Alternatively, to break the row into named 
or numbered groups, choose Select group from row regex.

Setting Value Mappings

You can use value mappings to map the data in a data source to new values. For example, 
if your data source contains abbreviations for states in a state field, you can use value 
mapping to map each state abbreviation to its full name.
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To add a value mapping:

1. In the Configure Field Mapping dialog, click Add Mapping. The Set Value Mapping 
dialog appears.

2. Enter the value you want to map from into the Source value field.

3. Enter the value you want to map to into the Map to field.

4. Click OK.

To set a default mapping:

In the Default mapping field, enter the default mapping. The Data Watcher uses this default 
mapping whenever a value doesn’t match one of your predefined value mappings.

Step 5: Set data table properties

In the Data Table tab, you can define the frequency and method with which the Data 
Watcher will update the CoolSign data table.
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Setting the Update Frequency

By default, the Data Watcher updates its CoolSign data table every 10 minutes. You can 
change this interval to anything you want. Additionally, with the File data source, you can 
trigger an update whenever the data source file changes instead of on a set interval.

To set the update frequency to a set interval:

1. Choose the Every X minutes radio button.

2. Set the number of minutes and seconds between each data table update.

To set the update to occur only when the data source file has been modified:

• Choose the Whenever data source changes radio button. 

NOTE

To ensure that the file is not still being modified, the Data Watcher waits 500 
milliseconds before reading the file after detecting that it has been modified. You can 
change this delay if necessary.
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Setting the Update Method

You can select the method by which the Data Watcher replaces data that is already present 
in a CoolSign data table when new data becomes available in your data source. 

The following options are available:

Replace all rows—Each time the Data Watcher updates, it deletes all existing 
rows in the CoolSign data table and imports all newly parsed rows. 

Synchronize with existing rows—The Data Watcher uses any field mappings 
defined as key fields to synchronize the new data with the existing data. The following 
logic is applied to each row of data being imported:

• If a row of data in the CoolSign data table has matching key fields, that row is 
updated to match the imported data.

• If there are no rows in the CoolSign data table with matching key fields, a new 
row is created in the data table with the imported data.

• Any old rows in the existing data table that were not updated or added are de-
leted. 

Append rows—This method is similar to the Synchronize method, except that old 
data is not deleted from the CoolSign data table. All imported data is either used to up-
date existing rows or added to the data table—no rows are ever deleted from the data 
table. If you want to allow duplicate appended rows of data instead of synchronizing, 
you can check  Allow duplicate rows.

NOTE

We strongly recommend that you set the row expiration time when using the Append 
rows method. Without row expiration, a data table can easily grow indefinitely 
because old data is never deleted.

Setting Row Expiration

You can choose to have imported rows expire after a set amount of time. This is useful to 
ensure that data doesn’t get stale in your data table. For example, if you are importing 
weather data and you expect that data to be valid for about 30 minutes, you can set the row 
expiration to 30 minutes. If, for some reason, you experience network problems or your 
data source becomes unavailable, the weather data will expire after 30 minutes instead of 
continually displaying outdated information.
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To set row expiration:

1. Check the  Expire new data box.

2. Enter the number of minutes, hours, or days after which the data should expire.

Firing Triggers Automatically

You can set up the Data Watcher to fire triggers automatically, based on updates to the 
CoolSign data table. For example, you might use the Data Watcher to watch for an XML 
file from an alert system, or an RSS feed from a central service that issues amber alerts. 

After you have enabled the trigger, the Data Watcher fires the trigger when your data 
sources change (and the file is not empty). Note that with a local Data Watcher, triggers are 
only fired locally.

• For a discussion of how to define and set up triggers, see “Managing Triggers” on 
page 316.

To set up triggers to fire automatically:

1. Check the box  Fire a trigger if the table is not empty. 

2. Click the link (here, “TRIGGERED EVENTS 2”), then select the trigger that you want to 
fire. 
 

3. You can optionally designate an expiration time for the trigger. 

Step 6: Test the Data Watcher configuration

As a final step, you’ll verify the settings that you’ve configured for the new Data Watcher.
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1. In the Data Watcher Editor, click Test Configuration.

2. When the Configuration Tester window appears, verify that all fields are present and 
that data appears to be parsed correctly.

3. Close the Configuration Tester.

4. Click Save to save the configuration. 

TIP
You can use the Data Watcher service configuration (see “Step 6: Test the Data 
Watcher configuration” on page 237) to determine which folder is currently being 
watched.

Managing Data Watcher Configurations 

This section tells how to edit, delete, export, and import Data Watcher configuration 
(DWC) files.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 238



15. Using the Data Watcher Manager 
Managing Data Watcher Configurations 
To reconfigure a Data Watcher:

1. In the Data Watcher nodes panel, right-click on the node where the configuration is 
located.

2. In the data grid, double-click to select the Data Watcher.

3. Edit the configuration as needed. For details, see the following sections:

• Data Source (see “Step 2: Set up the data source” on page 217).

• Data Parser (see “Step 3: Set up the data parser” on page 222).

• Field Mapping (see “Step 4: Map data source fields to CoolSign data ta-
bles” on page 229).

• Data Table (see “Step 5: Set data table properties” on page 234).

4. When you’re done, click Test Configuration to verify your settings (see see “Step 6: 
Test the Data Watcher configuration” on page 237).

5. Click Save to save the Data Watcher configuration file. 
• To overwrite the previous configuration, save the new configuration to the same 

location.
• If you need to retain the previous configuration file, you can either rename the file 

or save it to a new location. 

To remove an existing Data Watcher configuration:

1. In the Data Watcher nodes panel, do one of the following:
• Click Show All Items.
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• Click on the node where the configuration is located.

2. In the data grid, select the Data Watcher.

3. Right-click and choose DELETE.

TIP
To temporarily remove a configuration, you can move the DWC file to a subfolder. 
Subfolders are not watched.

To import a Data Watcher configuration:

You can perform these steps to add a configuration from a DWC file that was created with 
a standalone Data Watcher Editor.

1. In the Data Watcher nodes panel, select the node where you want to add the configu-
ration.

2. Right-click and choose IMPORT DATA WATCHER.

3. Select the configuration file that you want to import.

To export a Data Watcher configuration:

These steps allow you to back up a Data Watcher configuration, move it to another node, 
or load it via the standalone Data Watcher Editor.

1. In the Data Watcher nodes panel, do one of the following:
• Click Show All Items.
• Click on the node where the configuration is located.

2. In the data grid, select the Data Watcher.

3. Right-click and choose EXPORT DATA WATCHER.

4. Select the location in which you want to save the configuration.

To delete a Data Watcher node:

• Select the node in the Data Watcher nodes panel, then right-click and choose Delete 
Data Watcher Node.
This action deletes the selected node and all Data Watchers on it from the Data Watch-
er Manager. The node is still accessible in the network manager as a normal transfer 
node.
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Editing the Data Watcher Service Configuration 

When you installed the Data Watcher service (“Installing the Data Watcher service” on 
page 52 of the CoolSign Network Manager Installation Manual), a configuration file was 
created with default settings. This section tells how to edit these configuration settings.

NOTE
Do not confuse these settings with Data Watcher configuration (DWC) files (see “To open 
the Data Watcher Editor dialog:” on page 214). These settings affect the Data Watcher 
service; the DWC files contain settings for individual Data Watchers. 

To edit the Data Watcher service configuration:

1. Select the node in the Data Watcher nodes panel, then right-click and choose EDIT 
SERVICE CONFIGURATION. 

2. The Configure Advanced dialog appears, with the Software Configuration tab 
selected.

NOTE

To change any of the Data Watcher configuration settings, you MUST also update the 
DateModified field.
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WARNING

The Configure Advanced dialog provides direct access to a number of properties and 
commands that can cause a node to lose connectivity or otherwise stop working. Do 
not attempt to use this dialog unless you are very familiar with the CoolSign software 
and your network infrastructure. Incorrect settings can result in loss of network 
connectivity or software failures that require physical access to the PC to repair.

3. Edit the parameter values as needed. 

4. When you’re done, click OK.

Importing Media Assets into Data Tables

This section describes additional considerations that apply when using the Data Watcher to 
import media assets (pictures, videos, and Flash content) into a data table. The most signif-
icant difference is that media files are imported indirectly: instead of directly handing the 
asset to the Data Watcher, you provide the asset’s location—for example, 
C:\Pictures\Sunset.jpg.

1. Set up the data source (see “Step 2: Set up the data source” on page 217).

Although any type of data source may contain the path to an asset, the actual asset file 
itself must be located on a file source, URL source, or FTP source. (A database source 
may contain a path to an asset, but the actual asset may not be located in the database).
The data source does not have to be located on the same source type as the asset. For 
example, you can define an FTP source, which is an XML file with the following con-
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tents:
<?xml version="1.0" encoding="utf-8" ?>

<images>

<source>ftp://username:password@ftp.CoolSign.com/myFolder/Hous
ePicture.jpg</source>

<source>http://www.google.com/intl/en_ALL/images/logo.gif</source
>

<source>C:\MyPictures\Sunset.jpg</source>

</images>

If you don’t provide the full path, the Data Watcher uses a path relative to the main 
data source. For example, if your source file was located on the site 
ftp://ftp.coolsign.com/ with a path of myFolder/xmlFile.xml, then a row with only 
the file name HousePicture.jpg would be resolved to 
ftp://ftp.coolsign.com/myFolder/HousePicture.jpg.

2. Set up the data parser (see “Step 3: Set up the data parser” on page 222).

All parser types are supported for importing media assets. For example, you 
can obtain a file name from an xml file, a delimited list, a fixed length field parser, a 
media list, or a database.

3. Set up the field mappings (see “Step 4: Map data source fields to CoolSign 
data tables” on page 229).

In this xml example, if you map a field to the <source> tag, your data table will con-
tain three rows (assuming that the data table update method is set to replace or synchro-
nize). If the field type is set to text, only the path will be set in the data table. In order 
to import the actual asset, you must select the appropriate field type: "Picture Me-
dia", "Video Media", or "Flash Media."

NOTE
If you click Test Configuration (see “Step 6: Test the Data Watcher configuration” 
on page 237) when using media assets, the Data Watcher attempts to obtain the assets, 
but only the paths to the assets will be displayed upon a successful test.

CoolSign International Character Support

This section describes how to use international characters inside of a CoolSign solution. 
There are two ways to display international characters:

• from an external feed
• using the Content Creator
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Displaying International Characters from an External Feed

CoolSign allows you to use an external data feed containing international characters to run 
a data table inside of a player. You can, as in the following example, take an RSS feed 
coming from an international language channel and display it inside of a CoolSign Ad 
Player.

1. Start by launching the CoolSign Network Manager, then click DATA WATCHER in the 
sidebar.

2. Right-click on the root node of your network, and choose CREATE NEW DATA 
WATCHER. 

3. In the Data Watcher Editor window that opens, enter a descriptive name:

4. Choose an appropriate value from the Type menu (in this example, we are choosing 
“URL” for an Internet-based RSS feed). Under URL Data Source Properties, enter the 
URL of your RSS feed into the URL field (in this example, we are using a feed 
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 244



15. Using the Data Watcher Manager 
CoolSign International Character Support
coming from CNN with Arabic content). If you have username and password 
information, or proxy details, enter them as well.

RSS feeds are based on XML. The example below shows XML source coming out of the 
RSS feed used in our example, with certain elements identified. These are used to further 
configure the data watcher: the feed is a <channel>, and a component of the channel is an 
<item>, which has a <title> and <description>:
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<?xml version="1.0" encoding="UTF-8"?>

<rss xmlns:atom="http://www.w3.org/2005/Atom" version="2.0">

<channel>

<title>CNNArabic.com - Top News</title>

<link>http://arabic.cnn.com/rss/</link>

<description>CNNArabic.com delivers up-to-the-minute news and information on the 
latest top stories, entertainment, politics and more.</description>

<language>ar-sa</language>

<copyright>Â© 2009 Cable News Network LP, LLLP.</copyright>

<ttl>10</ttl>

<image>

<title>CNNArabic.com - Top News</title>

<link>http://arabic.cnn.com/rss/</link>

<url>http://arabic.cnn.com/images/cnnarabic.com.logo.rss.gif</url>

<width>144</width>

<height>46</height>

<description>CNNArabic.com delivers up-to-the-minute news and information on the 
latest top stories, entertainment, politics and more.</description>

</image>

<atom10:link xmlns:atom10="http://www.w3.org/2005/Atom" type="applica-
tion/rss+xml" href="http://arabic.cnn.com/rss/cnnarabic_topnews.rss" rel="self"/>

<item>

<title>Ù?ØμØ±: Ø§ØªÙ?Ø§Ù? Ø§Ù?Ø¥Ø®Ù?Ø§Ù? Ø¨ØªØ¯Ø¨Ù?Ø± 
"Ù?Ø¤Ø§Ù?Ø±Ø©" Ø¶Ø¯ Ø§Ù?Ø£Ø²Ù?Ø±</title>

<guid>http://arabic.cnn.com/2012/middle_east/7/2/morsi.alazhar/index.html</guid>

<link>http://arabic.cnn.com/2012/middle_east/7/2/morsi.alazhar/index.html</link>
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5. Click on the Data Parser tab. Choose “XML” in the Parser menu:

6. In the Record Path field under XML Parser Properties, enter rss/channel/item 
(these are the logical segments of the RSS feed).
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7. Under the Field Mapping tab you need to create fields for the various components of 
an RSS <item>, such as <title> and <description>. Click Add Field to display the 
Configure Field Mapping window:

8. To create a field for <title>, enter “title” in the Name field. From the TYPE menu, 
choose INTERNATIONAL TEXT. Enter “title” in the XML Path field. Click OK.

9. Add another field for the <description> component, and complete as in the previous 
step (Name = “description”; Type = “INTERNATIONAL TEXT”; XML Path = 
“description”). Click OK.
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10.At this point, you have created a data table with two fields: “title” and “description”. 

11.To validate the new data table, click Test Configuration. The system will test the new 
data watcher and validate that it can connect to the RSS feed. A new Configuration 
Tester window appears, with the message “Test Finished Successfully”, and 
containing a table of values for “title” and “description”. 

12.Click Save in the Data Watcher - Editor window, then close it. 
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13.In the main Data Watcher window, you now have a new data watcher (in the example 
below, it is called “STANDALONE_ROOT>ARABIC DATAWATCHER”). 

14.Click on “Data Tables”manager under “Dynamic Data” in the sidebar. In the data 
tables window that appears, the new data watcher is listed. Double-click the new data 
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watcher. In the “Edit data” window that appears, you'll see that it has imported the 
international text.

15.Click Cancel to close the window.

16.You can now assign this data to an existing piece of content that contains dynamic 
data fields. Click Content in the sidebar. Double click on the existing content you 
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wish to modify based on the new data watcher. A window appears displaying the 
Content settings.

17.Under the Dynamic Data tab, choose the new data watcher (Arabic data watcher, in 
this example) from the SET DATA TABLE menu. Data from the selected Data Watcher 
should appear in the field below. Click OK to save the new setting.

18.If you now launch the corresponding CoolSign Media Player, you will see it play 
dynamically updated international language content:
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Displaying International Characters using the Content Creator

You can also display international characters in an Ad Player by using the Content Creator 
tool (CCT) to create text elements from a data table or data watcher.

The Content Creator is available separately. Check with your sales person for more infor-
mation.

NOTE
Your PC must be set to use the English language. To verify this, open up the Fonts control 
panel, and click “Text Services and Input Language”. Verify that the Default input language 
is English. If you choose any language other than English, the CCT will not launch. 

1. Launch the CCT.

2. Start a new project. Enter a Name, along with values for Duration, Display type, 
Orientation, resolution as needed:

3. Click OK.

4. In the new Content window, create a canvas. 

5. In the Data Tables panel, click Import:
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6. In the CoolSign Login window that appears, enter your login credentials and specify a 
Network, then click Login:

7. In the “Select data table”, choose the data watcher you created, then click OK:
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8. In the Data Tables panel, you will see the title and description data from the new data 
watcher:

9. Create a field by clicking on the field tool and dragging on the canvas. In the New 
Data Field window that appears, choose a data table field (for example, title) from the 
FIELD menu, then click OK. Add additional fields as needed. Make sure the font is set 
to appear in an appropriate color for the current background.
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The international language content from the data watcher appears on the canvas:

Creating Static Text Elements

In some cases, you may want to input international language text onto a page without using 
a data watcher. Starting from a blank canvas (with no associated data table), normally you 
would use the Text Box tool to create a new text box, and then just input your international 
language text. Unfortunately the text box feature does not support UTF-8 characters. The 
way to get around this is to insert a data table on the fly.
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1. Click the Data Table tool and drag on the canvas to create a new data table object. 
Click New data table, and then enter a name, then click OK:

2. In the settings window that appears, choose INTERNATIONAL TEXT from the Field Type 
menu, then click OK:
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3. The names of the new data table and field appear in the New Data Field window. 
Click OK:

4. Right click in the new field area, and choose EDIT TEXT:

5. Delete the existing value, then type (or paste) your international text, and click OK:

6. Alternatively, you can add a row in the Data Tables panel and input the international 
language text there:

You should now see your international language text in the data table element on the 
canvas.
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Using Exchange as a Resource for Data Watcher

ExchangeReader is a Data Watcher external command that acts as a bridge between 
Microsoft Exchange and CoolSign. It reads events from Exchange and reformats them as 
XML data that the Data Watcher can store in a CoolSign data table.

Installation

ExchangeReader uses “xcopy installation”. Once the ExchangeReader’s file are copied to 
a folder, it may be used. 

ExchangeReader File List

The following files are needed for ExchangeReader to operate:

• ExchangeReader.exe:  the executed program
• config.xml: the user id and password used to access Exchange.

NOTE
The config.xml file secures the user id and password by encrypting them. A section 
below describes how to build a config.xml file with a new user id and password.

Command Line Arguments

ExchangeReader has several options, which are controlled from the command line, when 
running it. The following is the command line format for ExchangeReader:

ExchangeReader [<url> | /file:<filename>] <outputxml> [/date:<date>] 
[/days:<days>] [/loc:<location>] [/log:logPath]

• url points to the calendar to be read in Exchange. The URL uses Exchange’s WebDAV 
support.

• /file indicates that the XML returned from Exchange is stored in a file, rather than in 
Exchange. filename is the path to the file where the Exchange data is stored.

• output.xml is the name of the output file. 
• /date is optional. It indicates the reference date to be used in filtering the Exchange 

data; if not included, the program uses today's date. This option provides a way to filter 
out the events that will not be displayed. 

• /days is optional. It sets the number of days to report. The default is 0, for all. 
• /loc is optional. It sets a location for all entries. This eliminates displaying user errors 

when the calendar entry was created.
• /log is optional. If it is included, the input and output files are copied to a log folder 

named logPath.
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Examples:

ExchangeReader http://msxsrv01/exchange/confroom/calendar/ cal.xml /days:2

This command line points to a calendar for “confroom”, the exchange account for a confer-
ence room. The output is stored in cal.xml; 2 days of entries are included.

Using ExchangeReader with Data Watcher

To use the ExchangeReader with the Data Watcher, set up an External Command with the 
Data Watcher Editor and configure it to run ExchangeReader:

1. Set the name of the data table.

2. Set the type to EXTERNAL COMMAND.

3. Set the Command Path to point to ExchangeReader.

4. Set the Arguments to match the ExchangeReader options you want.

5. Set the Output Path to match the output file specified in the arguments.

The other Data Watcher settings should be handled as usual.
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Creating a New config.xml File

The ExchangeReader keeps the config.xml file encrypted to prevent unauthorized people 
from seeing the user id and password being used to access Exchange. In order to change the 
user id or password, it is necessary to build a new config.xml file. When ExchangeReader 
is run, it will detect that the config.xml file is not encrypted, and automatically encrypt it 
again. The format for the file is:

<config>

<userid>exchuser</userid>

  <password>exchpwd</password>

  <domain>exchdomain</domain>

</config>

NOTE
Any of the settings may be empty if they are not needed.

Once the file has been encrypted, it will appear like this:

<EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element"   
xmlns="http://www.w3.org/2001/04/xmlenc#">

<EncryptionMethod Algorithm=
"http://www.w3.org/2001/04/xmlenc#aes256-cbc" />

<CipherData>

<CipherValue>(some encrypted text here)</CipherValue>

</CipherData>

</EncryptedData>
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XML Format

The Event format includes an entry for each event in the date range. The example below 
shows two entries, but the list of entries is open ended.

<table>

<row>

<SequenceNumber />1</SequenceNumber>

<Event>get your tickets</Event>

<Date>Thursday 12/13</Date>

<Location />

<Time>9:00am-10:30am</Time>

</row>

<row>

<SequenceNumber>2</SequenceNumber>

<Event>travel promotion</Event>

<Date>Friday 12/14</Date>

<Location />

<Time>11:00am-12:00pm</Time>

</row>

</table>

Using SharePoint as a Resource for Data Watcher

SharePointListReader is a Data Watcher external command that acts as a bridge between 
SharePoint web application and CoolSign. It reads items from a SharePoint RSS feed and 
reformats them as XML data that the Data Watcher can store in a CoolSign data table. 
SharePoint RSS feeds make extensive use of HTML elements to structure its data. The 
SharePointListReader parses these elements and reformats them as XML elements in its 
output.
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Installation

SharePointListReader uses xcopy installation. Once the SharePointListReader files are 
copied to a folder, it may be used. 

SharePointListReader File List

The following files are needed for SharePointListReader to operate:

• SharePointListReader.exe:  the executed program
• AuxServices.dll: A helper library that is used by SharePointListReader.
• config.xml: the user id and password used to access SharePoint.
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NOTE
The config.xml file secures the user id and password by encrypting them. A section 
below describes how to build a config.xml file with a new user id and password.

Command Line Arguments

SharePointListReader has the following command line format:

SharePointListReader <url> <outputxml> [/log]

url A URL to a SharePoint RSS feed. 
outputxml The name of the output file.
/log (Optional.)  When you include this option, 

SharePointListReader writes debugging 
log files.

Example

SharePointListReader 
"http://one.planar.com/sitedirectory/sdqa/_layouts/listfeed.aspx?List=
A38%7D" pto.xml

This command reads a list at the given url and stores the RSS feed in a file called pto.xml.

Using SharePointListReader with Data Watcher

To use the SharePointListReader with CoolSign Data Watcher, use the Data Watcher 
Editor to define an external command and configure it to run SharePointListReader.

NOTE
For general instructions on how to configure a Data Watcher, see the "Using the Data 
Watcher Manager" chapter of the CoolSign CoolSign Installation Manual.
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1. In the Data Watcher Editor, enter the name of the data table.

2. Use the TYPE pull-down menu to select the EXTERNAL COMMAND type.

3. Set the Command Path to point to the SharePointListReader executable.

4. In the Arguments field, specify the SharePointListReader command line options 
that you want to include.

5. Set the Output Path to match the output file specified in the Arguments field.

6. Define other Data Watcher settings as needed.

7. When you're done, click Save to save the configuration.

Creating a New Config.xml File

The SharePointListReader keeps the config.xml file encrypted to prevent unauthorized 
people from seeing the user id and password being used to access Exchange. In order to 
change the user id or password, it is necessary to build a new config.xml file. When Share-
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PointListReader is run, it will detect that the config.xml file is not encrypted, and automat-
ically encrypt it again. The format for the file is:

<config>

<userid>exchuser</userid>

  <password>exchpwd</password>

  <domain>exchdomain</domain>

</config>

NOTE
Any of the settings may be empty if they are not needed.

Once the file has been encrypted, it appears like this:

<EncryptedData Type="http://www.w3.org/2001/04/xmlenc#Element"   
xmlns="http://www.w3.org/2001/04/xmlenc#">

<EncryptionMethod Algorithm=
"http://www.w3.org/2001/04/xmlenc#aes256-cbc" />

<CipherData>

<CipherValue>(some encrypted text here)</CipherValue>

</CipherData>

</EncryptedData>

XML Format

The output format of the SharePointListReader includes an entry element for each Share-
Point entry found in the SharePoint RSS feed. The SharePointListReader will name the 
fields using the names that SharePoint has used. In the example below, generic field names 
were used. The example below shows two entries, but the list of entries is open ended.

<sharepointlist>

  <entry>

    <field1>Kevin</field1>

    <field2>7/3/2008 12:00 AM</field2>

  </entry>

  <entry>

    <field1>Forrest</field1>

    <field2>6/26/2008 12:00 AM</field2>

  </entry>

</sharepoint>
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Using Google Calendar as a Resource for Data Watcher

GCReader is a Data Watcher external command that acts as a bridge between the Google 
Calendar web application and CoolSign. It reads events from a Google Calendar and 
reformats them as XML data that the Data Watcher can store in a CoolSign data table.

Installation

GCReader uses xcopy installation. Once the GCReader.exe file is copied to a folder, it 
may be used. 

Command Line Arguments

GCReader has the following command line format:

GCReader [<rssurl /> | /file:<rssfile /> | /ical:<calurl />] <outputxml /> 
[/format:cal | /format:event] [/date:<date />]  [/days:<days 
/>][/log:logPath][/proxy:<address:port>]

rssurl A URL to an RSS feed. Note that with the current implementation of 
Google Calendar, a maximum of 25 entries can be returned via RSS. If 
you expect more data than that, use the /ical option.

/file Indicates that the RSS feed is stored in a file, rather than on a web host. 
rssfile – The path to the file where the RSS data is stored.

/ical Indicates that the source is iCalendar format. 
calurl – The URL to the iCalendar formatted file.

outputxml The name of the output file. The format of this file is controlled by the 
/format parameter.

/format:cal Produces the calendar format xml used by the CoolSign “Google 
Calendar” content.

/format:event Produces the event format xml used by the CoolSign “Events” content. 
/date (Optional.) Indicates the reference date to be used in filtering the Google 

Calendar data. If you don't specify a date, GCReader uses today's date. 
Because Google Calendar returns all data in the calendar (up to the RSS 
limit mentioned above), you can use this option to filter out the events 
that will not be displayed. 
The reference date is controlled by the /format parameter. With 
/format:cal, the date identifies the first week of data; all entries from the 
Sunday of that week will be included. With /format:event, the date 
specifies the first day to be included.

/days (Optional.) The number of days to report. The default is 0 (all).
/log (Optional.) When you include this option, the input and output files are 

copied to a log folder named logPath.
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Examples

The following is the simplest command line. It specifies two options: the URL to the RSS 
feed and the output XML file. It uses defaults for everything else:  calendar format, today’s 
date, all events (from today on), no log.

GCReader 
“http://www.google.com/calendar/feeds/emailaccount.com/public/basi
c” output.xml 

The following command line reads the iCalendar format of the Google Calendar, stores the 
XML in output.xml, uses the event XML format, starting from today’s date, and returns 14 
days of events.

GCReader “ical: 
http://www.google.com/calendar/ical/csdatawatcher%40gmail.com/pu
blic/basic.ics” output.xml /format:event /days:14

Using GCReader with Data Watcher

To use the GCReader with CoolSign Data Watcher, use the Data Watcher Editor to define 
an external command and configure it to run GCReader.

/proxy (Optional) /proxy is optional. It causes HTTP requests to route through 
the proxy at the specified address.
If proxy authentication is required, also use /proxyUser and 
/proxyPassword.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 268



15. Using the Data Watcher Manager 
Using Google Calendar as a Resource for Data Watcher
1. In the Data Watcher Editor, enter the name of the data table.

2. Use the TYPE pull-down menu to select the EXTERNAL COMMAND type.

3. Set the Command Path to point to the GCReader executable.

4. In the Arguments field, specify the GCReader command line options that you want 
to include.

5. Set the Output Path to match the output file specified in the Arguments field.

6. Define other Data Watcher settings as needed. 

7. When you're done, click Save to save the configuration.
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XML Formats

Calendar Format (/format:cal)

The Calendar format is a one-week format that defines the month, along with each day of 
the week (and the corresponding date) are specified. For each day of the week, there are six 
possible event slots:  three in the morning and three in the afternoon.

<Calendar>

<Full-week>

<Month />OCTOBER<Month>

<Day1>14 SUNDAY</Day1>

<Day2>15 MONDAY</Day2>

<Day3>16 TUESDAY</Day3>

<Day4>17 WEDNESDAY</Day4>

<Day5>18 THURSDAY</Day5>

<Day6>19 FRIDAY</Day6>

<Day7>20 SATURDAY</Day7>

<Sun-am1 />

<Sun-am2 /> 

<Sun-am3 /> 

<Sun-pm1 />

<Sun-pm2 />

<Sun-pm3 />

<Mon-am1>9:00 AM - 10:00 AM: Weekly Status Meeting</Mon-
am1>

<Mon-am2>10:00 AM - 11:00 AM: Steering Committee</Mon-
am2>

<Mon-am3 />

<Mon-pm1>12:00 PM - 1:30 PM: Sales Meeting</Mon-pm1>

<Mon-pm2>4:00 PM - 5:00 PM Departmental 
Presentation</Mon-pm2>

<Mon-pm3 />

<Tue-am1 />

<Tue-am2 />

<Tue-am3 />

<Tue-pm1 />

<Tue-pm2 />

<Tue-pm3 />

<Wed-am1 />
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<Wed-am2 />

<Wed-am3 />

<Wed-pm1 />

<Wed-pm2 />

<Wed-pm3 />

<Thu-am1 />

<Thu-am2 />

<Thu-am3 />

<Thu-pm1 />

<Thu-pm2 />

<Thu-pm3 />

<Fri-am1 />

<Fri-am2 />

<Fri-am3 />

<Fri-pm1 />

<Fri-pm2 />

<Fri-pm3 />

<Sat-am1 />

<Sat-am2 />

<Sat-am3 />

<Sat-pm1 />

<Sat-pm2 />

<Sat-pm3 />

</Full-week>

</ Calendar>
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Event Format (/format:event)

The Event format includes an entry for each event in the date range. The following example 
shows two entries, but the list of entries is open-ended.

<table>

<row>

<SequenceNumber />1</SequenceNumber>

<Event>get your tickets</Event>

<Date>Thursday 12/13</Date>

<Location />

<Time>9:00am-10:30am</Time>

</row>

<row>

<SequenceNumber>2</SequenceNumber>

<Event>travel promotion</Event>

<Date>Friday 12/14</Date>

<Location />

<Time>11:00am-12:00pm</Time>

</row>

</table>
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You can use CNM to create new data tables, edit or delete existing data tables, and to edit, 
import, export and print the data within the data tables in your CoolSign network.

Working with Data Tables

You can use CNM to create a new empty data table and define the fields and structure of 
that data table. However, in most cases, you will never need to manually create a data table; 
most data tables are automatically created for you during content import or by the CoolSign 
Data Watcher.

Content that is designed using the CoolSign Content Creator automatically creates a new 
empty data table when the content is imported. Once imported, you can manually add, edit, 
or remove data from the data table, as described in this chapter. 

If you are using the CoolSign Data Watcher to import data from an external data source, a 
data table will be created automatically when the Data Watcher is configured. 

NOTE
You cannot edit the data in a Data Watcher-created data table unless you are logged into 
the system with administrator capabilities.
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To create a new empty data table:

1. From the Data Tables page, do one of the following:
• Choose ACTIONS > NEW DATATABLE.
• Right-click in the grid and choose NEW DATATABLE.

2. In the General tab, enter a name for your new data table.

3. Add one or more fields to the data table. See “Adding Fields to a Data Table” on 
page 275.

4. Set and make use of any desired Security features in the Security tab.
Object ID—An auto-generated Object ID fills the field. It may not be changed.
Audit History—Click to review past activity within this function.
Permissions—Two default classes exist by default—admin User and Everyone 
Group. Permissions for Owner, Read and Write rights are automatically check-marked 
as granted to admin. Only Read and Write are set as granted to Everyone since there 
can be only one Owner. Denying Permissions is simply a matter of clicking the check 
box to clear the mark.
Additional users can be established and eliminated with the Add and Remove buttons.

5. Use the Apply Changes button to apply interim changes—a handy feature if entering 
more than a couple of users or groups.

6. Click OK to save the changes and close.
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Editing an Existing Data Table

You can edit an existing data table to add new fields or edit and delete existing fields.

To edit an existing data table:

1. Select the data table you wish to edit on the Data Tables page.

2. Choose ACTIONS > EDIT DATATABLE STRUCTURE.

3. Or right-click and select EDIT DATATABLE STRUCTURE.

Deleting an Existing Data Table

You can delete an existing data table from your CoolSign network. 

NOTE
You will be warned if you attempt to delete a data table to which content is bound. Deleting 
a data table with bound, scheduled content may cause playback errors that stop the 
content from playing.

WARNING
Deleted data tables cannot be recovered. 

To delete an existing data table:

1. Select the data table you wish to delete on the Data Tables page.

2. Choose EDIT > DELETE or right-click and select DELETE.

Defining a Data Table Structure

After you create a new data table, you can define its field structure.

Adding Fields to a Data Table

Every data table must contain at least one field definition.
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To add a new field to a data table:

1. Click the Add button to open a new Field Properties dialog.

Select the type of field.

Set the default value for 
the new rows.

Set constraints on how data can be
entered into the field.

Enter the name for the field.

2. Enter the name of the new field in the Field Name text box.

3. In the Field Type combobox, select the type to restrict entry to the field. You can 
choose one of the following field types:
Text—Allows any alphanumeric characters, including the letters A-Z (upper and low-
er case) and number 0-9. Used for basic or European text.
Number—Allows numeric entry using a spin edit control.
Boolean—Allows boolean entry of True/False. 
Date & Time—Allows both date and time entry.
Date—Allows date entry using a date/time picker control.
Time—Allows time entry using a time control.
Media—Allows import of an image, movie, or flash media asset.
Long Text—Allows memo-style text entry for long fields.
International Text—Allows text that is not European.

4. In the Default Value text box, enter the default value to use when a new row is 
added to the data table.
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5. Set any desired constraints on what can be entered into the data field:
Use Picklist (Text only)—Displays the text field using a combobox where the user 
can select from a list of predefined values. You can enter one or more predefined val-
ues in the picklist text box (separated by carriage returns).
Allow Editing (Text only)—Allows you to enter custom values in addition to the 
values available from the picklist option. 
Limit Chars (Text only)—Limits the maximum number of characters that can be 
typed into a text field.
Char Mask (Text only)—Restricts which characters can be entered into a text field.
Force Case (Text only)—Forces the case of all characters to be upper or lower case.
Only allow values from (Number only)—Allows setting the minimum and max-
imum value of a number field.
Media Type (Media only)—Sets the type of media that can be imported into a media 
field.
Image Constraint (Media only)—When checked, importing images will display a 
special dialog that can be used to crop and scale the imported image to fit the defined 
resolution.

6. Click OK.

NOTE
The field type and constraints apply only when manually inputting data via the CNM. 
External tools, like the CoolSign Data Watcher, are not constrained by the settings defined 
in this dialog.

Editing Fields in a Data Table

You can edit any existing fields in your data table to change their name, constraints or other 
options.

NOTE
Modifying an existing field does not apply any new constraints to any previously input data 
for that field.
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To edit a field in a data table:

1. Select the field in the Fields grid of the DataTable Property dialog.

2. Click the Edit button to open the Field Property dialog for the selected field.

3. Change any properties as desired.

4. Click OK.

Changing the Ordering of Fields

When manually editing the data for a data table, the available fields are displayed in the 
order they are listed in the Fields grid of the Data Table Properties dialog. You can reorder 
the fields so that they are displayed in a different order.

To reorder fields:

1. Select the field you want to reorder in the Fields grid.

2. Click the Move Up or Move Down arrows to move the field up or down respectively 
in the list.

3. Click OK.
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Deleting Fields from a Data Table

You can delete fields from a data table. 

NOTE
When you delete a field, any existing data in that field is also deleted.

To delete a field from a data table:

1. Select the field in the Fields grid of the DataTable Property dialog.

2. Click the Delete button.

Editing Data in a Data Table

You can use CNM to manually edit data in your data tables. 

Using the Edit Data Dialog

You can edit the data in a CoolSign data table from any of the following dialogs:

• The Edit Data dialog from the Data Tables page.
• The Dynamic Data tab on the Content Properties dialog of dynamic content.
• The Dynamic Data tab on a Schedule Item Properties dialog when scheduling dynamic 

content.

NOTE
Regardless of where you are editing the data, there is only a single instance of the data 
table and your changes will be reflected automatically wherever that data table is being 
used.
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When editing data in any of the above dialogs, you are presented with an identical interface 
that allows you to add new rows, edit or delete existing rows, import media, and export your 
data to a text file.

Click the ... button 
in a media field to 
import a media 
asset into the 
data table.Right-click in any col-

umn header to show 
a popup menu with 
additional options.

Click within a text 
field to directly edit 
the value of the field.

Click to add or delete 
rows from the data table.

To add a new row to a data table:

• Click the Add Row button.

To delete a row from a data table:

1. Click anywhere in the row you want to delete.

2. Click the Delete Row button.

To edit data in a field:

1. Click on the field in the row you want to edit.

2. Enter or modify the data in the field. Any constraints defined in the field are enforced 
as you enter data.

To import media into a media field:

1. Click the field in the row where you want to import media.

2. Click the … (ellipsis) button in the field to display an open file dialog.
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3. Select the file you want to import.

NOTE
Click OK. If you are importing an image and the field has been set to 
constrain the image size, a dialog will be displayed to allow you to resize 
the image to fit the constrained resolution.

Use the zoom in and 
zoom out buttons to 
resize the image or 
spin the mouse wheel.

The green box indicates 
which part of the image 
will be cropped.

Use the arrow 
buttons to pan 
the image.

 

You can double-click on an image media field to open a preview window of the image. 
There is currently no mechanism to preview flash or movie media fields.

Setting the Order of Rows in the Data Table

You can sort the data by clicking on any field header, but the content defines the actual sort 
order in which rows are used. Content can be set to display rows in the order they exist in 
the data table. You can reorder rows in the data table if desired.

To change the order of the rows in a data table:

1. Right-click in any field column header to display the popup menu and choose SHOW 
ORDERING. A special field appears in the grid that displays the ordering index of each 
row.

2. Edit the value in each field to reorder the rows.
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Setting the Activation/expiration Date of Rows

Each row in a data table has an activation and expiration date that defines when it can be 
used in content or enabling expressions. 

NOTE
Rows that have expired will be deleted from the data table 24 hours after the expiration 
date to account for all timezones but will stop being used in content immediately.

To display the activation or expiration date of a row in a data table:

• Right-click in any field column header to display the popup menu and choose SHOW 
ACTIVATES/EXPIRES. 

Importing and Exporting Data

You can import and export data from a data table to a comma-delimited text (CSV) file. 
This is a convenient way to transfer a large complex data table to another CoolSign 
network, back up your data table, or copy the data into another data table.

To export data from a data table to a file:

1. Right-click any column header to display the popup menu and choose EXPORT DATA.

2. Select the folder to which you are exporting data.

3. The export process does the following:
• Creates a subfolder with the name of the data table (datatable_name) in the export 

folder. 
• Creates the file datatable_name/[datatable_name].csv in that subfolder.
• If the data table contains media files, creates a new folder named datat-

able_name/[datatable_name]MediaFiles in the same subfolder as the CSV file. 
All media files will be exported into this folder.

To import data from a file into a data table:

1. Right-click any column header to display the popup menu and choose IMPORT DATA.

2. Select the CSV file you want to import.

3. When prompted, choose whether you want to append the imported data or replace the 
existing data entirely with the new data.

4. If the data table has a media field, you can import the media files along with the CSV 
files. Ensure that the folder [datatable_name]MediaFiles (containing the associated 
media files) is in the same folder as the CSV file. 
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Printing Data

To print the data in a data table:

• Right-click any column header to display the popup menu and choose PRINT DATA.
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A CoolSign network consists of any number of players transfer nodes all connecting 
through a combination of wide and local area networks to the CoolSign Network 
Controller. You can use the Network page of CNM to review your network’s topology, 
check status on each of the nodes, review event logs, and configure various settings and 
properties.

About Nodes

There are three types of nodes in a CoolSign network that together form a network’s 
topology:

Network Controller—The CoolSign Network Controller is the central server and 
database for the entire network. All other nodes connect to the Network Controller. 

There is one Network Controller for a network.

Transfer nodes—Transfer nodes act as data and connection aggregation points in 
your network. While transfer nodes are always optional, they can greatly decrease the 

amount of bandwidth required to transfer content to sites with multiple players and to 
transfer logs and status up from players. Transfer nodes connect directly to the Network 
Controller or to another transfer node.

Players—Players play back content on one or more connected display devices. Player 
connect either directly to the Network Controller or through one or more transfer nodes.

Using the Network Topology Panel

In addition to the standard QuickSet panel and Sites panel, the Network page also contains 
the Network Topology panel in its QuickBar. The Network Topology panel shows the hier-
archical topology of your Network Controller in a collapsible treelist and indicates the 
overall status of a node and the nodes that connected to it.
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You can perform the following actions from the Network Topology panel:

• Click the Network Controller node or a transfer node to show only the nodes that 
connect directly to the clicked node.

• Right-click on a node to show a context-sensitive menu of actions you can perform on 
the node.

NOTE
The Network Topology panel represents the actual network connections of the nodes in 
your network. If you want to modify the topology, you must reconfigure the parent IP 
address of each node by running the Configurator on the actual node PC, or by changing 
the PARENT_URL_PREFIX of the Agent Settings from the node’s Advanced Properties 
dialog. For more information, see “Editing Agent Configuration Settings” on page 298.

Creating and Deleting Nodes

When a new player or transfer node connects to your network for the first time, the node 
automatically appears in the Network page. If the node is a player, a new player also 
appears in the Players Manager grid.
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If you have configured a new node and it does not appear in the Network page, please refer 
to “Troubleshooting” on page 383.

If you have physically removed a node from the network, the node will still be visible on 
the Network page with an offline status. You can delete a node from the system so it no 
longer appears. If you attempt to delete a node that is currently online, you will be warned 
before proceeding. Deleted online nodes will reconnect after a few moments and reappear 
on the Network page but you must retune any deleted Player nodes after they reconnect.

To delete a node:

1. Select the node in the data grid.

2. Choose EDIT > DELETE.

NOTE
You are not permitted to delete the Network Controller node.

Editing Node Properties

You can view and edit a number of important properties for each node in your network on 
the Node Properties dialog. 

To open the Node Properties dialog:

Select the node in the data grid and do one of the following:

• Choose ACTIONS > EDIT NODE PROPERTIES.
• Right-click and choose EDIT NODE PROPERTIES.
• Double-click on the node in the data grid.

Viewing Transfers to a Node

The Transfers tab displays all of the content, software packages, and other items that are 
required for the node. If the item is still being transferred to the node, you can view the 
current progress of the transfer. A full green bar indicates that the item is completely trans-
ferred to the node.

Jump to Players

If you have multiple player nodes, you can use the Jump to Players feature to display a 
specific player node in the Player Manager. Once selected, this node appears in the Player 
Manager along with the filter that was created in the Quicksets dialog.
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To filter on a specific player node:

1. From the Network Manager, highlight the desired player node and select Jump to 
Players.

2. From the Player Manager, configure the player node as desired.

Managing Software

CNM enables you to remotely install and upgrade CoolSign components and drivers from 
the Software tab of the Node Properties dialog. Haivision periodically releases new 
versions of CoolSign software components as CoolSign software packages. You can import 
CoolSign software packages and apply them to nodes to upgrade the software running on 
the node.

NOTE
Software packages are provided as a Windows folder that contains a Package.xml file 
and other files required for the update. Do not attempt to modify or move any of the files in 
the software package folder. Attempting to do so could cause severe errors when applying 
the package.
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Viewing Installed Software Components

The Installed Components grid displays all the CoolSign components installed on the node. 
For certain components like the AdPlayer, Agent, and Watchdog, the grid indicates 
whether the component is currently running or stopped.

NOTE
Components that are installed directly onto a node via the CoolSign installer do not display 
running status until a software package containing that component has been imported into 
CNM and the package is applied to the node.

Importing Software Packages

Before you can apply a software package to a node, you must import the package updates 
into the network controller using the Network Manager. You can manage the available 
software packages on the Software Package Manager dialog.
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To import a software package:

1. Do one of the following to display the Software Package Manager dialog:
• From the Software tab of the Node Properties dialog, click Software Update.
• Choose TOOLS > SOFTWARE Packages.

2. Click Import Software Package.

3. Use the Open Dialog to select the “Package.xml” file from the provided software 
package folder, then click OK. The new software package is imported into your 
network and made available to apply to a node.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 289



17. Managing Nodes 
Managing Software
Deleting Software Packages

If a software package has been superseded by a new version and is no longer applied to any 
nodes, you can delete the package from the Software Package Manager. 

NOTE
Deleting a software package does not uninstall that package from any nodes that it was 
applied to. There is no way to uninstall CoolSign software packages with CNM. 

To delete unused software packages:

1. Select the software package from the Software Package Manager dialog or click 
Select All Unused to automatically select the unused packages.

2. Click Remove Package.

Applying a Software Package to a Node

In order to install a new component or upgrade an existing component on a node, you must 
apply the software package. You can apply software packages directly to a node or you can 
use software inheritance to let the packages automatically be applied from the parent of the 
node. When you apply a package to a node, CoolSign automatically transfers the necessary 
files across your network to the node. Once the entire package is available, the CoolSign 
Watchdog software running on the node shuts down the component being upgraded, 
installs the new component, and then restarts it automatically.

To apply a software package:

1. From the Software tab on the Network Properties dialog, click Software Update.

2. Select the package you want to apply.
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3. Click Apply. While the package is transferring to the node, it shows a status of 
“Pending.” Once the package is installed, the status should change to “Installed.”

TIP
You can watch the transfer status of a software package from the Transfers tab of the 
Network Properties dialog.

NOTE
You can apply a software package to any node even though certain components (for 
example, the AdPlayer component). When you apply a Player-only software package to 
the Network Controller or a Transfer Node, its status is “Applied.” This is useful when you 
enable software inheritance.

About Software Inheritance

You can use software inheritance to cause a node to automatically inherit all the software 
packages applied to its direct parent node. When you turn on Inherit Parent Software 
Packages for a node, any packages applied to the direct parent of that node are also applied 
to the node automatically. You might disable inheritance if you wanted to segment versions 
of the CoolSign software on your network because you want to test a new feature or bug 
fix before rolling out an upgrade to the entire network.

To toggle software inheritance for a node:

• From the Software tab on the Network Properties dialog, check or uncheck  Inherit 
parent software packages as appropriate.

Restarting Software Components

Although the CoolSign software is self-maintaining and will automatically restart if unex-
pected issues occur, there may be situations when you want to remotely restart a software 
component manually.
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To restart a software component from the Software tab:

1. From the Software tab on the Network Properties dialog, select the software in the 
Installed Components grid.

2. Click Restart Component. 

NOTE
You can only restart components for which a software package has been applied to the 
node. You can’t remotely restart components that are installed directly onto a node.

To restart the AdPlayer or Agent from the Network page:

1. Select one or more nodes in the Network page’s data grid.

2. Choose ACTIONS > RESTART AGENT or ACTIONS > RESTART ADPLAYER.

Rebooting a CoolSign Node

When you install CoolSign software, you can configure a daily, weekly, or monthly interval 
on which each node’s PC should be automatically rebooted. While the CoolSign software 
does not require frequent reboots, it’s a common best practice to occasionally reboot the 
Windows operating system. For more information on configuring the automatic reboot, 
refer to the Installing CoolSign documentation.

You can use CNM to remotely force a node to reboot if you are troubleshooting an issue 
that you feel requires a reboot to fix. Rebooted nodes go offline during the reboot process 
and should come back online after a few minutes.

To reboot a node from the Software tab:

• From the Software tab, click Reboot Computer.

To reboot a node from the Network page:

• Select the node and choose ACTIONS > REBOOT COMPUTER.

NOTE
Rebooting the Network Controller node disconnects CNM. You can reconnect after the 
Network Controller has restarted. This might take a few minutes.

About Node Attributes

Attributes are a way to tag unique information about the nodes in your network. You can 
define an attribute and then set the value of the attribute for each node. For example, if you 
define an attribute called ZipCode, you can then enter and track the zip code for each 
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player. When you define an attribute, every player on your network is assigned the attribute, 
using whatever default attribute value you set. 

Node attributes can be defined and set on the Attributes tab of the Network Properties 
dialog.

Defining Attributes

Before you can set an attribute value for a node, you must define the new attribute and 
default value. When you define an attribute, it is automatically set with the default value for 
every node connected to your network.

To define an attribute:

1. From the Attributes tab on the Node Properties dialog, click Define attributes to 
open the Define Attributes dialog.

2. Click Add to open a new Attribute Properties dialog.

3. Enter the attribute name.

4. Enter a default value for the attribute.
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5. If you want to allow users to select from a list of values when setting the attribute, 
check the  Use Picklist box and enter the list of values into the PickList Values 
field.

6. If you want to let users set a value for the attribute that is not in the picklist, check 
Allow user to enter custom values.

7. Click OK.

Setting Attribute Values

Once an attribute is defined, you can set the attribute value for each of the players connected 
to your network. The current attribute values for a player are visible on the Attributes grid 
on the Attributes tab of the Node Properties dialog.

To set an attribute value:

1. Click in the Value column for the attribute you want to set.

2. Enter the value or choose the value from the picklist if available.

3. Click OK or Apply Changes.

Using Attributes for Dynamic Data Localizing

You can use attributes to localize data tables when displaying dynamic content or using 
enabling expression in your content. For more information on using attributes to localize 
dynamic data, see “Localizing Data” on page 211.

About Bandwidth

You can use the Bandwidth tab of the Network Properties dialog to set bandwidth limiting 
and other network-related properties.
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To set bandwidth limiting and other network-related properties:

1. From the Node Properties dialog, click Bandwidth to open the Bandwidth dialog.

From this dialog you can:

•  Enable multicast send/receive functions — set both send and receive from the 
network controller to a transfer node; set the node to receive from the network 
controller and transfer node.

•  Raise alerts when offline — if selected an alert appears on the Home Manager when 
offline.

•  Suspend connection to node — enables you to suspend traffic to/from the node 
other than to turn it back on.

•  Limit bandwidth via unicast upstream send/receive functions — enables you to 
adjust the bandwidth of data transfer through the network (both unicast or multicast).
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2. Apply your desired bandwidth limit settings.

3. Click OK to save your settings.

For more information on bandwidth, see “About Bandwidth” on page 294.

About Event Logs

The Event Logs tab lets you retrieve information, warnings, and errors logged by the 
CoolSign software running on a node. You can use the event logs to help troubleshoot 
problems you might be having with your network or a node.

For more information on troubleshooting your nodes, see “Troubleshooting” on page 383.
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To access the Event Logs tab:

1. From the Node Properties dialog, click Event Logs to open the Event Logs dialog.

2. Select a value from the VIEW RANGE drop-down. This enables you to specify a time 
period for which to display corresponding log entries. You can modify the default 
values in the From and To fields to make the range more specific.

3. Select a value from the FILTER LOGS drop-down. This enables you to specify the level 
of detail to be displayed.

4. Click Retrieve Logs to view log history.

5. Click OK.

Configuring Advanced Properties

The Configure Advanced Properties dialog provides access to a number of advanced 
settings and features for technical configuration and troubleshooting of the nodes in a 
network. You can use the Configure Advanced Properties dialog to:

• Review or change your software configuration and settings.
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• Open a command line interface to the hard drive on a node.
• Send commands directly to the CoolSign Watchdog software.
• Review the currently running processes.

WARNING
The Configure Advanced Properties provides direct access to a number of properties and 
commands that can cause a node to lose connectivity or otherwise stop working. Do not 
attempt to use the Advanced Properties dialog unless you are very familiar with the 
CoolSign software and your network infrastructure.

To configure advanced properties:

• From the General tab of the Node Properties dialog (see “Editing Node Properties” on 
page 286), click Edit Advanced Properties.

About Software Configuration

You can use the Software Configuration tab on the Advanced Properties dialog to review 
and change a number of configuration settings used by the software installed on a node. 
You can also configure how a node raises alerts that appear on the CNM Home page. The 
Software Configuration tab allows you to select three types of configuration files to edit:

• Alerts—Contains settings that affect how and when alerts are raised by the software 
on the node. 

• Agent—Contains settings that affect networking, how often logs are kept and 
uploaded, and other technical properties.

• AdPlayer—Contains settings that affect how the Player software works.

WARNING
In most cases, you should avoid changing the settings for the Agent or AdPlayer unless 
instructed to by CoolSign Technical Support. Incorrect settings can result in loss of 
network connectivity or software failures that require physical access to the PC to repair.

Editing Agent Configuration Settings

While most of the Agent settings should be left alone unless instructed by CoolSign 
Technical Support, there are a few properties that it may be useful to edit under certain 
conditions:

• PARENT_URL_PREFIX—This setting can be used to re-point a node to a different 
parent node. The usual process for re-pointing a node is to reconfigure the node using 
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the CoolSign Configurator software on the node. In the rare case that you need to 
remotely re-point a node, you can change this value to a new IP address. 

WARNING

If you point a node to an invalid parent IP address, you will lose connectivity to that 
node until you physically access the PC to reconfigure.

• PLAY_LOG_MAX_DAYS—Indicates the number of days that playlogs will be 
retained on the player. Normally, playlogs are uploaded frequently and stored in the 
database of the Network Controller. If you have intermittent network connectivity or 
know that a node will be offline, you may want to change this setting so that you don’t 
lose data while the node is offline.

• SEND_EMAIL_FOR_ALERTS—Set this to TRUE if you want to channel alerts to 
an e-mail address in addition to displaying them on the Home page. 

Sending DOS Commands to a Node

You can use the Remote Command tab of the Advanced Properties dialog to remotely 
access the node’s file system and execute standard DOS commands.

To send DOS commands to a node:

Enter a valid DOS command into the command line prompt field and press Enter. 

• If you are executing a remote command (such as dir) that will return results, check the 
 Wait for Finish box.

• If you are executing a remote command that starts a new process (application), verify 
that the Wait for Finish box is not checked. Otherwise, the command request might 
time out.

In addition to standard DOS commands like CD, DIR, ECHO, and so forth; you can enter 
the following special commands:

putfile [destpath]—Allows you to manually upload a file to the current working path on 
the node or to the location set in the destpath argument.

getfile [filepath]—Downloads the file set by the filepath argument and saves it to your 
local hard disk.

cshelp—Provides Help information for CoolSign custom commands.

mget [wildcard]—Retrieves a set of files from the remote file system matching the dos-
formatted wildcard (such as *.txt).
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Sending Watchdog Commands

You can send commands directly to the Watchdog software running on a node. A full list 
of the commands available for the Watchdog can be found in the document “How To Create 
Watchdog Scripts and Software Packages”, available from CoolSign Technical Support.

To send a command to the watchdog:

1. Click Send WatchDog Command.

2. Enter the command and click OK.

Opening the Remote Monitor

The remote monitor is a debugging tool that provides a number of useful features for inves-
tigating the file transfer status and current closure for a node. While the remote monitor is 
currently an internal debugging tool only, it is accessible through the Advanced Properties 
dialog for cases where CoolSign Technical Support might need further information. The 
use of the remote monitor is currently not documented.

To open the remote monitor:

• Click Open Remote Monitor to launch the Remote Monitor application.

Cleaning Up Space on a Node

The CoolSign system self-maintains the available disk space on a node through a garbage-
collection algorithm. When new content is scheduled onto a player, CoolSign will, if neces-
sary, automatically delete old, unused files to make room for the new files. In normal oper-
ation, you should not need to worry about the disk usage on a player node. You can force 
CoolSign to delete any unused content files if you want to reclaim the disk space without 
waiting for the garbage collection.

To force a node to garbage collect unused files:

• Click Force Garbage Collect.

Viewing Running Processes on a Node

You can review the current processes that are running on a node if you want to check to see 
which applications are running and how much CPU and memory they are using.

To view running processes:

1. Navigate to the Process List tab of the Configure Advanced Properties dialog.

2. Click Refresh Process List to update the list.
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CNM provides a number of tools and dashboards to help you monitor the health and status 
of your network. CoolSign supports thousands of players connected to a network. You can 
view either a rollup of the connection, player, and display status of all the nodes on your 
network or drill down to view the individual status of each node. 

About the Home Page

The CNM Home page is the first screen you see when connecting to a CoolSign network. 
The Home page provides a high-level dashboard on the health of your network as well as a 
list of any alerts that may require your attention.

About the status summary

The status summary dashboard provides a high-level rollup of the status of the nodes 
connected to your CoolSign network. You can use this summary to determine at a glance 
if any nodes are offline or if any players are having content or display errors. The dashboard 
also provides a summary of how much data your CoolSign network contains.

Alerts

Alerts are warning or error messages when problems or events occur on your network. Each 
node in your network can raise an alert when it detects some issue requiring your attention. 
For a list of possible alerts, see “Troubleshooting alerts” on page 383.

Each node on your network can be individually configured as to which alerts it raises and 
how long until an alert can be raised again. 
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When an alert is raised on your network, it appears in the Alerts grid on the Home page. 
Additionally, you can set your CNM preferences to display a notification dialog, flash the 
task bar, or play a sound when the alert is raised. 

 Viewing Information about Alerts

Each alert in the grid displays information about where the alert was raised, a description 
of the event, and the time and date when the alert was first and last raised. Depending on 
its configuration, a node may continue to raise alerts repeatedly for an issue until that issue 
is repaired. Instead of filling up your alerts grid with duplicate alerts for the same node and 
issue, each alert shows the first time the alert was raised for the node, the last time the alert 
was raised, and a count of the total number of times the alert was raised.

Jumping to a Node or Player

You can quickly jump to the node or player that raised an alert so you can review its Node 
Properties dialog or other status and settings. Jump to players is accessed via the Network 
Manager. Jump to Node is accessed via the Players Manager.

To jump to the node or player that raised an alert:

• Right-click on the alert and choose Jump to Node or Jump to Players. CNM moves to 
the Networks page or Players page and selects the node or player that raised the alert.

Filtering Alerts

You can filter which alerts are visible in the Alerts grid to hide alerts for which the 
condition which raised the alert is no longer true. For example, if an alert was raised for a 
node because it was offline but now the node is online, you can choose to not view that alert.

To hide alerts for nodes that are fixed:

• Check Offline and display alerts for fixed nodes.

Viewing Detailed Timestamps

You can toggle the Alerts grid between a description of when each alert was first and last 
raised and the exact timestamp. 

To view the exact date and time an alert was first and last raised:

• Check Show detailed timestamps.

Marking Alerts as Read

When an alert first appears in the grid, it is displayed in red. This indicates that this is a new 
alert and is unread. If you want to acknowledge that you have read the alert but not fixed 
the issue resulting in the alert, you can mark the alert as read.
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To mark an alert as read:

• Click the unread alert in the Alerts grid. Read alerts are displayed in black.

Clearing and Deleting Alerts

After you resolve the issue that caused an alert, you can either clear it or delete it. Cleared 
alerts remain in the Alerts grid for 24 hours and are displayed with a line through the alert. 
Clearing alerts is useful if you want other users of your network to see that a problem was 
repaired. 

If you just want to immediately remove an alert, you can delete it.

To clear an alert, do one of the following:

• Check the  Clear Alert checkbox in the Alerts grid.

• Right-click on the alert and choose CLEAR ALERT.
• Select the alert and choose Clear Alert.

To delete an alert, do one of the following:

• Right-click on the alert grid and choose DELETE ALERT.
• Select the alert and choose ACTIONS > DELETE ALERT.

To delete all cleared alerts, do one of the following:

• Choose ACTIONS > DELETE CLEARED ALERTS.
• Right-click on the alert grid and then select DELETE CLEARED ALERTS.

Cleaning Up Old Alerts

Each time you launch CNM, you will be warned if your network contains alerts that are 
older than 30 days. You can clean up the old alerts by deleting them. Alternatively, you can 
manually delete old alerts.

To delete alerts older than 30 days, do one of the following:

• Choose ACTIONS > CLEAN UP OLD ALERTS.
• Right-click on the alert and then select Clean up Old Alerts.

Creating a User Alert

You can raise a user alert (custom) alert to inform, instruct or remind yourself or other users 
of your network.
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To add a user alert:

1. Choose ACTIONS > NEW ALERT or right-click and then select New Alert.

2. Enter a name and description for your alert.

3. Click OK to add the user alert.

Setting Alert Preferences

You can set CNM to warn you of new alerts by displaying a notification dialog, flashing 
the taskbar, or playing a sound.

To change the alert notification preferences:

1. Choose FILE > PREFERENCES.

2. Check one or more methods for how you want to be notified of new alerts.

3. Click OK.

Tasks

There are a number of activities you can perform with CNM that can take a variable amount 
of time to complete depending on the size of the data being transferred, the number of nodes 
affected by the change, and the speed of your network. Instead of forcing you to wait until 
the action has completed to give you feedback, CoolSign creates tasks that let you review 
the progress of the activity on each node that it was applied to.

Tasks are created for the following actions:

• Tuning a player to a new channel.
• Updating a channel used by one or more players.
• Updating content.
• Upgrading software. 

Filtering Tasks

You can filter the tasks grid to display only active and failed tasks or to only display tasks 
that were created due to actions that you performed (as opposed to other users).

To only show tasks that are currently active or have failed:

• Uncheck  Show Completed Tasks.

To only show your tasks:

• Check  Show my tasks only.
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Reviewing the Status of Tasks

You can review the current progress and status of tasks for each node on which the related 
action is applied. Each task has a limited window of time in which to complete. If all nodes 
for a task are not completed by the time the task expires, the task’s status indicates that it 
has failed.

NOTE
A failed task does not necessarily mean that the action for that task didn’t eventually 
complete successfully. It only means that it didn’t complete within the time limit allocated 
for the task. For example, applying a software package to an offline node will most likely 
result in a failed task. But if that node connects at some time in the future, the package 
could then be applied automatically at that time.

To review details of a task:

• Right-click on the task and choose VIEW TASK PROPERTIES.

Setting Preferences for Tasks

You can change some of the default preferences for tasks, including whether to raise alerts 
when the task succeeds or fails and how long it takes for a task to expire. 

To change task preferences:

1. Choose FILE > PREFERENCES to open the Preferences dialog.

2. Set the desired task preferences in the System Task box.

3. Click OK.

About Application Logs

On the Alerts page, the Logs grid displays all the major actions performed on your network 
through use of CNM. You can use these logs to review what changes or actions were 
performed, by whom, and when. By default, the Logs grid only shows the last two days of 
logs. You can edit your preferences to change the number of days in the Logs grid.

To set the number of days of logs shown in the Logs grid:

1. Choose FILE > PREFERENCES to open the Preferences dialog.

2. In the Application Logs box, set the number of days of log to show.

3. Click OK. 
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You can use the scheduling grid to schedule a number of different properties of your 
CoolSign network, including any of the following:

• Dayparting a schedule item within a channel (Schedule Item Properties dialog).
• Volume level of a player (Player Properties dialog).
• Display control for a display connected to a player (Configure Players dialog).
• The hours that a site is open (Site Properties dialog).
• Bandwidth limiting for a node (Network Properties dialog). 

Working with the Schedule Grid

The scheduling grid provides a powerful interface that can be easily used for most common 
scheduling, while also providing advanced features that allow you to build very complex 
schedules quickly.

All scheduling grids share the same interface, save for a context-sensitive popup menu that 
allows you to schedule the specific values available to the property you are scheduling. 

Depending on what you are scheduling, the colors of cells indicate different values for the 
property. For properties like volume and bandwidth limiting, each cell visually displays the 
percentage level of a value (as shown above). By default, clicking a cell or dragging across 
cells toggles the cell value between the minimum or off value and the maximum or on 
value. Right-clicking on a cell or right-click dragging across cells displays a context-
sensitive popup menu to enable you to set any additional value available to that property.

Setting a Cell Value in the Grid

Each cell in the grid has a color that indicates the value of the property at that time. The 
possible values of a schedule grid and the corresponding colors are different for each type 
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of scheduling grid and are discussed in detail in the documentation for the associated 
property dialog.

You can quickly toggle the value of a cell or range of cells between the off and on settings. 
The off and on values of a property differ for each type of scheduling grid. For example, 
the on setting for the volume schedule grid indicates a volume of 100 while the on setting 
for the display control schedule grid indicates that the display’s input is set to CoolSign.

In addition to the off and on settings, some scheduling grids allow you to set additional 
values. For example, the volume scheduling grid lets you set a volume level from 0 to 100 
and the display control scheduling grid lets you set the display to any labeled input.

To toggle cells between off and on:

• Left-click a cell or left-click and drag across one or more cells. All selected cells are 
toggled based upon the first selected cell.

To set the value of a cell:

1. Right-click a cell or right-click and drag across a range of cells.

2. Select or set the value using the VALUE popup menu.

3. Click anywhere off the popup menu to close it.

Using the Zoom in the Scheduling Grid

Each cell in the grid represents a block of time during a day of the week. By default, each 
block represents a full hour during the day. You can use the zoom controls to zoom in and 
out of the scheduling grid to decrease the block of time that a cell represents so you can 
schedule at finer resolutions than on the hour.

To zoom in:

• Click  to zoom into the grid. You can zoom to the following time resolutions: 1 
hour, 30 minutes, 15 minutes, 5 minutes, or 1 minute. 

To zoom out:

• Click  to zoom out of the grid.

Overriding the Recurring Schedule

By default, when you are using the schedule grid, you are creating a recurring schedule that 
will repeat every week. If you want to modify the schedule for a specific week, you can use 
the override week features. For example, you may want to schedule displays to be on for 
extended hours during the week before Christmas at a department store or you may want to 
disable a schedule item from playing on a certain Tuesday in November for some reason. 
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With the scheduling grid override functionality, you can schedule any overrides to the base 
recurring schedule for any future week.

Use the forward and 
back week selector 
buttons to navigate.

Use the week 
selector to jump 
to a week.

Click Override Options to 
display the Override menu.

Use the Override menu to 
clear overrides or jump to an 
existing overridden week.

To select a week to override:

1. Click the Week Selector box to display the Datetime editor.

2. Use the month arrows to change the displayed month.

3. Click Today to jump to the current date.

4. Click Show Base Schedule to return to the base recurring schedule.

5. Click a day to select a week to override.

To navigate through weeks:

• Click the Forward or Back week selector buttons to move one week forward or back 
from the current week.
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To override the schedule for a week:

1. Edit the schedule for an overridden week using the same tools available for editing 
the recurring week as described above.

2. The overridden week is labeled as Overridden Week.

Selecting Overridden Weeks

You can quickly jump to any currently overridden weeks to review or modify the overrides. 
The Override Options menu indicates the number of weeks that are currently overridden.

To jump to an overridden week:

1. Click OVERRIDE OPTIONS to display the Override popup menu.

2. Choose JUMP TO OVERRIDE to display a submenu of any overridden weeks.

3. Choose the overridden week to which you want to jump.

To jump to the next or previous overridden week:

• Hold down the Ctrl key while clicking the Forward or Back week selector buttons. If 
an overridden week is set, the schedule grid will jump to that week.

Clearing Overridden Weeks

You can remove all the overrides applied to a schedule or just the override for a specific 
week.

To clear all overridden weeks:

• Click OVERRIDE OPTIONS and choose CLEAR ALL OVERRIDES.

To clear the override from the currently selected week:

• Click OVERRIDE OPTIONS and choose CLEAR OVERRIDE FOR CURRENT WEEK.
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You can use triggers to cause a piece of content or playlist to instantly play back on one or 
more players when a specified event takes place. In most cases, you will use triggers in 
conjunction with some external application that communicates to CoolSign when the 
trigger should be fired, but you can also fire a trigger manually if needed.

You can use the CoolSign DataLib API to create new applications that fire CoolSign 
triggers for your own custom events. 

• For a discussion of how to use the Data Watcher to fire triggers automatically, see 
“Firing triggers automatically” on page 238.

Types of Triggers

Two types of triggers can be created:

One-shot—One-shot triggers force content to play once when the trigger is fired. This is 
similar to executing a Play Now command on a player.

Recurring—Recurring triggers force content to play repeatedly until the trigger is cleared. 
So long as a recurring trigger is active, no other scheduled items in the channel for a player 
will play. The triggered content will loop repeatedly.

If subsequent recurring triggers are fired before the previous ones are cleared, the player 
will alternate between each active recurring trigger. 

About Payloads

Triggers can include payloads that contain data about the event that fired the trigger. 
Content that is played due to the firing of a trigger with a payload can display that payload 
information as dynamic data when it plays. 

Working with Triggers

You must manually create triggers using the Manage Triggers dialog. The following topics 
cover the actions available from this dialog:

• “Creating Triggers” on page 311.
• “To edit an existing trigger:” on page 313.
• “Manually Firing Triggers” on page 313.
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• “Clearing Triggers” on page 314.

NOTE
You can also manually create triggers through an external application, such as Data 
Watcher (see “The Data Watcher Manager” on page 214 for details).

To open the Manage Triggers dialog:

• Choose TOOLS > TRIGGERS.

Creating Triggers

Triggers are usually created by the external application that fires the triggers. You can 
create your own triggers if you plan to manually fire the trigger or if the external application 
doesn’t create triggers for you.
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To create a new trigger:

1. On the Manage Triggers dialog, click New. A new Trigger Properties dialog appears.

2. Enter a name for your trigger.

3. Select  One Shot or  Recurring to determine how your trigger will play content. 
(See “Types of Triggers” on page 310.)

4. If your trigger is recurring, set the maximum number of instances of the recurring 
trigger that can be active at one time. Any triggers in excess of the limit are queued 
until one of the currently active triggers is cleared.

5. Add any payload field to your trigger. See “Adding Fields to a Data Table” on 
page 281.

6. Click OK.
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Editing Triggers

To edit an existing trigger:

1. On the Manage Triggers dialog, select the trigger that you want to edit, then click 
Edit.

2. When the Trigger Properties dialog appears, make your changes.

3. Click OK (to save) or Cancel (to discard your changes).

Manually Firing Triggers

You can manually fire triggers if you want to directly cause triggered content to play. When 
manually firing a trigger, you can also enter data into any fields that are defined for the 
payload of the trigger. You can only fire a trigger manually if at least one player is playing 
a channel in which that trigger is scheduled.

To manually fire a trigger:

1. Select the trigger on the Manage Triggers dialog.

2. Click Trigger to open a Trigger dialog.
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3. If the trigger is recurring, set an expiration date. You must also manually clear active 
triggers from the Manage Triggers dialog (see “Types of Triggers” on page 310).

4. Enter the values for fields defined as the trigger’s payload. These values are included 
with the trigger so that any content played by the trigger can use them as dynamic 
data.

5. Click Trigger.

Clearing Triggers

The currently active triggers are listed in the Active Triggers grid on the Manage Triggers 
dialog. You can manually clear an active recurring trigger if you want stop content played 
by the trigger.

To clear a trigger:

1. Select the active trigger in the Active Triggers grid.

2. Click Clear.
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Scheduling Triggered Items

Before you can fire a trigger, you must schedule a content item or playlist using the 
Triggered schedule item type in a channel and tune at least one player to that channel. For 
more information on scheduling, Chapter 8, "About Scheduling."
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Security is integrated into the CoolSign system in several different ways. You can control 
who has access to your CoolSign Network, what they can see and do, and what specific 
items they can change. There are built-in features to ensure that once content is brought into 
your CoolSign Network, it cannot be tampered with, and it cannot be used outside of your 
network. And lastly, there are ways that the CoolSign software is protected from unautho-
rized use, which will be worthwhile for you to know about as you look at expanding your 
CoolSign Network.

There are two levels of security access in the CoolSign system: capabilities and permis-
sions. Capabilities determine which pages, within the CNM, the user can access (read) and 
what tasks can be performed. Permissions determine which individual items within CNM 
the user can change (write). 

In order to be able to perform a task with an item in CNM, the user must have the capability 
to access the manager or perform the task, and the user must have the permission to change 
the object. It is important to note that security access control for the CoolSign system has 
been designed to be flexible, so there are a number of ways you can manage access. You 
can use capabilities to manage the general access of users to different managers of the 
system and use permissions to restrict which users can access specific items within a 
manager.

This chapter includes the following topics:

• “Using Windows Domain Security to Connect to CoolSign” on page 316.
• “Managing Users and Groups” on page 319.
• “Setting Object Permissions” on page 326.
• “Security Strategies” on page 328.

Using Windows Domain Security to Connect to CoolSign

If your network uses Windows Vista, Microsoft Windows 7, Windows XP, Windows 
Server 2003 or Windows Server 2008 and has domain accounts set up for the same users 
(and/or groups) who access the CoolSign network, you may be able to streamline the user 
logon process. This is only possible if the domain accounts are in the same domain as the 
CoolSign Network Controller node. You can set up CoolSign user accounts that are linked 
to the Windows domain account. For these users, once the CNM application is launched, 
the user skips the CoolSign log on screen and proceeds directly to the Home page (see 
“About the Home Page” on page 301). 
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• For information on how to link a CoolSign user account to a domain user account, see 
“About Users” on page 320.

Alternatively, if your network uses Windows Vista, Microsoft Windows 7, Windows NT, 
Windows 2000, or Windows XP and has Active Directory groups set up for the same users 
who access the CoolSign network, you can set up CoolSign groups that are linked to Active 
Directory groups. When you do this, CNM checks the user’s Active Directory groups to 
determine the appropriate capabilities.

To enable domain security for CoolSign users:

1. If you are using Active Directory groups, associate CoolSign groups with Active 
Directory groups, as described in “Linking CoolSign Users/groups to Active Direc-
tory Groups” on page 322.

2. Exit CNM.

3. At the CNM login screen, click Edit Networks.
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4. In the Select Network dialog, select the network that you wish to connect to:.

5. In the Edit Network dialog, check the Connect using Domain Account box.

6. Click the Check Network button. If a network is online and available at the specified 
address, its name automatically appears.

NOTE

You cannot add a network that is not currently online. If you are having trouble 
connecting to a valid address, make sure that the Network Controller agent is 
running.

7. Click OK.
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8. Exit CNM again.

NOTE
The next time CNM is launched, it tries to log in using the user domain credentials (as long 
as the domain credentials were properly defined).

To disable domain security for CoolSign users:

1. Press the Ctrl key while double clicking on the CNM shortcut.

2. When the CNM login screen appears, select your desired network.

3. Press Edit to disable domain security for CoolSign users.

Managing Users and Groups

You can manage the users and groups allowed access to your CoolSign network from the 
User and Groups dialog.
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To open the User and Groups dialog:

• Choose TOOLS > USER AND GROUPS.

NOTE
Only the admin user or members of the built-in Administrators group can access the User 
and Groups dialog.

About Users

Users are the individuals who have access to your CoolSign network. A user must enter his 
or her log on credentials when launching CNM. You can assign capabilities and permis-
sions to restrict a user’s access to features or items in your network.

You can manage users from the Users and Group dialog.

To add a new user:

1. From the Users and Groups dialog, click the Users tab (if necessary) to display the 
Users list.

2. Click Add to open a New User dialog.

3. Enter the user’s login name.

4. If you want to link the user account to an existing domain account, enter the domain 
name. For more information on linking accounts to a domain, see “Linking CoolSign 
Accounts to a Domain User Account” on page 325.

5. Click Set Password.

6. In the Set Password dialog, enter a password for the new user account.

7. Click OK to close the Set Password dialog.
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8. If you want to restrict access to any features or manager pages for this user, click the 
Capabilities tab and uncheck the appropriate capabilities. (For a description of the 
capabilities listed here, see “Capabilities” on page 324.)

NOTE

As shown here, you can choose whether to display the capabilities that are 
specifically assigned to the user (“User’s own”), the capabilities inherited from the 
group to which the user belongs (see “To assign group capabilities to a user:” on 
page 322), or the full set of all capabilities for this user (“All”). 

9. Click OK.

To edit the properties of a user:

1. Select the user in the User and Groups dialog.

2. Click Edit to open the User Properties dialog.

3. You can change the capabilities of the user or assign a new password.
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About Groups

Groups contain users as members. Both capabilities and permissions can be assigned to 
either users or groups. When you assign permission or capabilities to a group, all the users 
in that group receive those security settings as well.

You can manage groups from the Users and Groups dialog.

To create a new group:

1. From the Users and Groups dialog, click the Groups tab to display the Groups list.

2. Click Add to open a New Group dialog.

3. Enter a name for the group.

4. For each user you want to assign to the group, select the user in the Users list and 
click the left arrow button.

5. If you want to restrict access to any features or manager pages for the members of this 
group, click the Capabilities tab and uncheck the appropriate capabilities.

6. Click OK.

To assign group capabilities to a user:

1. Select the user in the User and Groups dialog.

2. Click Edit to open the User Properties dialog.

3. In the Available Groups list, select the group whose capabilities you want the user to 
inherit, then click the left arrow button.

4. In the Member Of list box, right-click to select the group, then click Use Group 
Capabilities.

5. In the Capabilities tab, verify that you have assigned the desired capabilities to this 
user.

6. Click OK.

Linking CoolSign Users/groups to Active Directory Groups

If your network uses Windows Vista, Microsoft Windows 7, Windows XP, Windows 
Server 2003 or Windows Server 2008 and has Active Directory groups set up for the same 
users/groups who access the CoolSign network, you may be able to streamline the process 
of assigning capabilities. You can set up CoolSign users/groups that are linked to Active 
Directory groups. When you do this, CNM checks the user’s Active Directory groups to 
determine the appropriate capabilities.
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To link a CoolSign group to an Active Directory group:

NOTE
Before you can link CoolSign users/groups to domain groups, you must first set up Active 
Directory groups on your domain controller.

1. From the Users and Groups dialog, click the Users or Groups tab to display the 
Users/Groups list. 

2. Select the CoolSign users/group that you want to link to an Active Directory group. 
Then click Edit. (Alternatively, click Add to create a new CoolSign users/group.)

3. In the User/Group Properties dialog, choose the Active Directory users/group name 
from the Domain Group combo box. The combo box lists all users/groups in the 
current domain.

4. Now you can set the capabilities for the CoolSign users/group. Click Capabilities, 
then enable or disable capabilities as needed. When you’re done, click OK.

All users/groups in the Active Directory group now have the capabilities that you assign to 
the linked CoolSign group.

Linking a Domain User to a CoolSign Group

If Active Directory Groups have already been created and correctly linked to their corre-
sponding CoolSign Groups correctly (see above), it is possible to maintain CoolSign users 
directly using Active Directory.

To link a domain user to a CoolSign group:

1. Create a Domain User in Active Directory (for example, johndoe@qadomain.com)

2. Make the new user a member of an Active Directory Group that is linked to a 
CoolSign Group.

This user must be granted read/write permissions on the startup volume.

3. Log in to Windows using the newly created user domain credentials.

4. Launch CoolSign Network Manager.

5. Enable the “Connect using Domain account” option (see “To enable domain security 
for CoolSign users:” on page 317).

6. Restart CNM.

CNM should be able to connect to the Network Controller using the domain account 
credentials (without the need to create a user on CoolSign and map it to its corresponding 
domain account), provided the following conditions are met:

• The Domain account user credentials are set up properly.
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• The user is logged into Windows as the domain user (for example, 
“johndoe@qadomain.com” in the example above).

• Both the machines running the NC and CNM are in the same domain as the Domain 
Controller (“qadomain” in the example above).

About Special Groups

Your CoolSign network includes two special groups that cannot be deleted: Administrators 
and Everyone. 

• Any members of the Administrators group automatically receive all capabilities and 
full read/write permissions on every object. 

• All users are automatically members of the Everyone group and cannot be removed 
from that group. Members of the Everyone group will automatically receive both read 
and write access to every object in your network unless you specifically restrict access.

Capabilities

Capabilities are used to control who has access to managers and tasks in the CoolSign 
system. There are capabilities to access each of the manager pages within CNM, capabili-
ties to edit the items in these managers, and capabilities for specific tasks, such as 
creating/modifying triggers, importing software updates, and clearing alerts. See the 
following table.

Table 21-1 List of Available Capabilities  

Capability What It Allows a User to Do

Access Channel Manager Use channel management functionality
Access Content Manager Use content management functionality
Access Data Table Manager Use data table management functionality
Access Data Watcher Manager Use data watcher management functionality
Access Home Page Use home page functionality
Access Network Manager Use node management functionality
Access Player Manager Use node management functionality
Access PlayList Manager Use playlist management functionality
Alerts Clear alerts
Attributes Define node attributes
Edit Data Table Edit data in data tables
Product Keys Ability to import product keys
QuickSets Ability to edit quick sets
Security Ability to edit security information
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Capabilities can be assigned to either users or groups (or both, but this should be carefully 
thought out in order to work well). For example, if you want a user to be able to see the 
items within the Content Manager, you can assign the Access Content Manager capability 
to this user. Another way to do this would be to create a group that has the Access Content 
Manager capability and make the user a member of this group.

Initial Account and Password

When your CoolSign Network is initially installed, it comes with one user account already 
created. The name for this account is admin, and the password is password. The Admin 
account is a member of the Administrators group. When you first log in to your network, 
you should immediately create new user accounts and change the password for the admin 
account.

Password Management

Passwords can be assigned by any user who is a member of the Administrators group. This 
capability does not allow the user to view current passwords, only to create new ones.

For information on how to change a password for a user, see “About Users” on page 320.

Linking CoolSign Accounts to a Domain User Account

If your network uses Windows Vista, Microsoft Windows 7, Windows NT, Windows 2000, 
or Windows XP and has domain accounts set up for the same users who access the 
CoolSign network, you may be able to streamline the user logon process. This is only 
possible if the domain accounts are in the same domain as the CoolSign Network Controller 
node. You can set up CoolSign user accounts that are linked to the Windows domain 
account. For these users, once the CNM application is launched, the user skips the CoolSign 
logon screen and proceeds directly to the Home Manager.

Software package Import software packages
Tasks Edit tasks
Triggers Create and modify triggers
Write content Edit content
Write Data Watcher Manager Edit Data Watcher configurations
Write Data Table Edit design of data tables
Write Network Manager Edit network node properties
Write Schedule Edit schedules

Table 21-1 List of Available Capabilities  (Cont.)

Capability What It Allows a User to Do
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For information on how to link a CoolSign user account to a domain user account, see 
“About Users” on page 320.

Setting Object Permissions

Permissions are typically used to assign or change read and write access to any item in 
CNM. These items include individual content, channels, data tables, playlists, and nodes. 
With read access, a user can see an item; with write access, a user can edit or change an 
item. Some items in the CoolSign network, such as software packages and players, have 
permissions but cannot be changed by a user.

Permissions are incorporated into the CoolSign system to allow for more precise security 
control of specific items. Similar to capabilities, permissions can be assigned to either users 
or groups.

When a new item is created or imported, the user creating or importing it is made the owner 
of the item and automatically has read and write permissions. After an item is created, its 
owner can modify the asset’s permissions for groups or individual users. By default, every 
user is a member of the Everyone group and, as such, is assigned read and write permissions 
to an item at the time of creation.

In order to change the owner of an object, the user needs to be a member of the Adminis-
trators group.

About the Security Tab

You manage permissions on an item from the Security tab on the item’s properties dialog. 
You can use the Security tab to review the item’s creation and modification history, and 
add or remove permissions to read/write the item to users and/or groups.
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To add a new user or group to the permissions list:

1. Click Add.

2. Select a user or group from the User and Groups dialog.

3. Click OK.

To modify write permissions for a user or group:

1. Select the user or group in the Group or User names list.

2. Check or uncheck Write in the Permissions list.

NOTE
CoolSign 4 does not support restricting Read access to an item. All users must have Read 
access to every item.
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To assign a new user to an item:

1. Select the user you want to assign as owner of the item in the Group or User names 
list.

2. Check Owner in the Permissions checkbox. 

3. Confirm that you want to assign ownership to a new user by clicking OK.

NOTE
Only members of the Administrators group can assign new ownership of an object.

Security Strategies

This section is designed to outline a few options on how you may want to manage the 
security access to your CoolSign network.

Scenario 1:  All users have all permissions and capabilities

In this situation, a few users need permissions for all items in CNM, and there is no need to 
restrict the access of managers or items using capabilities and permissions.

The first thing to do is to make all users members of the Administrators group, thus giving 
all users both read and write permissions for all items. Then create a CoolSign account for 
each user, and assign each user to the Administrators group.

Scenario 2:  Managing only capabilities by user

In this situation, a few users need permissions for all items in CNM, and there is no need to 
restrict the access of items using permissions. However, you want to control capabilities by 
user.

When a new user is created, the user is automatically a member of the Everyone group. If 
you want to manage capabilities by user, remove all capabilities from the Everyone group, 
so that new users have no default capabilities. Then create a CoolSign account for each user 
and assign the appropriate capabilities to each user during this process.

Scenario 3:  Managing only capabilities through groups

In this situation, a few or many users need permissions for all items in CNM, and there is 
no need to restrict the access of items using permissions. However, you want to control 
capabilities by groups.
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Next, create groups based upon different functions within your company. For each group, 
you would assign the appropriate capabilities. Then you would set up accounts for each 
user. The last step would be to assign the appropriate users to each group. 

NOTE
When you create a new user, make sure that all capabilities are unchecked (removed).

Scenario 4:  Managing capabilities and permissions by groups

Your organization may want to use permissions to restrict access to a few critical items. If 
this is your objective, you will need to do some planning to determine what groups must be 
created to manage permissions and capabilities for your system. Be aware that this scenario 
will require extra work to be performed by each user every time an item is created or 
imported.

For each of the manager pages in CNM, you must determine which groups will have 
viewing and editing capabilities, and which ones will have write permissions (you can have 
different groups with write permissions for similar items). All of these groups should be 
defined before any items are created or imported into the CoolSign system. In this scenario, 
only users who need permissions for all items should be members of the Administrators 
group.

Once the groups are defined, the next step is to assign users to the appropriate groups.

Every time a new item is created or imported, the user who is doing this must add the appro-
priate group(s) to the permissions list for the item; this is not done automatically. This 
ensures that all present and future members of the group will have the appropriate write 
permissions to the item by default. As new members are added to groups, they will auto-
matically inherit the current write permissions for the group.

Restricting user access to an item requires that an appropriate user edit that item to remove 
the write permissions for that specific user.

Scenario 5:  Managing multi-tenancy capabilities and permissions

Some customers desire to own and operate one server and then rent out parts of it to 
customers of their own. To ensure proper security, user accounts, sub-domains, pass 
phrases, users, and groups need to be setup so one tenant can’t gain access to another 
tenant’s information. “Multi-Tenancy” on page 84 of the CoolSign Installation Manual for 
details about creating domains, sub-domains and permissions.

Content Security

CoolSign uses a hashing algorithm to store a unique signature for each file imported into 
the network. CoolSign uses this signature to ensure that the content files being played on a 
player are identical to the ones that were originally imported. Any attempt to modify a 
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content file, or in the rare case that the file becomes corrupted, will result in a player status 
error and the content will not play.
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The Watchdog has a rich capability to deliver, update and maintain software that runs on 
CoolSign nodes. This software typically is installed to support CoolSign itself, but it can 
also be used to distribute and install arbitrary programs. This section details the process that 
the watchdog uses for installing and updating these programs using a custom script.

Watchdog Installation Script

The installation script is a set of commands that instruct the watchdog how to install and 
rollback each component. Since this is the only way that the watchdog can do an update, 
each script must contain the commands necessary to make the changes for updating a 
component.

While a script is executing, the watchdog suspends all ‘watching’ operations it currently is 
performing. Consequently, you can kill programs, copy files, and update/replace compo-
nents using a script without worrying that the watchdog will try to restart the programs 
while they are being updated.

Three different scripts are required for a complete installation that allows rollback of 
installed components if an error occurs: 

• PrepareInstall.txt
• Install.txt
• UndoInstall.txt

PrepareInstall.txt

Contains instructions to move files that will be destroyed during the install into a temporary 
directory. Then, if a problem occurs in the next step, the installation can be undone. The 
installer first searches for this file and executes all commands in it before moving on to the 
install.txt file. If any errors occur during this script, the installation is aborted.
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Install.txt

Contains instructions to actually do the installation by moving, deleting, registering and 
otherwise manipulating files on the system. If any command in this script fails, the next 
script, UndoInstall.txt, is executed. Otherwise, that script is ignored.

NOTE
If you are updating a piece of software that is currently running on the system, it is up to 
this script to first kill that program before trying to replace it or any dll it depends on. The 
system will not allow replacement of running program files.

UndoInstall.txt

Contains instructions to completely undo the installation. This script depends on the first 
script, PrepareInstall.txt, having been run successfully. It will take files from the 
temporary directory and move them back into their original positions.

It is up to the author of an installation to create these scripts. The system will make no 
assumptions about steps it must perform to do an installation. 

IMPORTANT
The above scripts support the launching of JavaScript through the below-described 
ExecWRC() function. You will find that most, if not all, of the CoolSign installation 
scripts use this functionality to off-load much of the installation process into a single 
generic Install.js script file. Aside from installations, scripting is also useful for 
everyday commands from the operator to the watchdog using the remote command 
functionality in the advance node options. 

Also, to build the packages themselves, a command-line driven program called Release-
Builder is employed. This tool is called in the last step of our make scripts so that every 
time we make a new version of the CoolSign software, a new software delivery package is 
made. The description of the maintenance of these files and their use to distribute arbitrary 
programs is described in the “How to Create Custom CoolSign Packages with Your Own 
Program” file. 

Comment and Command Lines

Each line of the script can either be a comment line or a command line. Comment lines start 
with a ‘#’ symbol — everything after ‘#’ is ignored. You can place blanks before the ‘#’ 
symbol if you want (in other words, comments can also be indented). You cannot have a 
comment on the same line as a command.
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Command lines instruct the watchdog to perform some action on files in the component’s 
folder or elsewhere on the system. The default directory for commands is the component 
directory, so any paths in the command can be done relative to it, e.g. if you have 
csnode.exe in the component directory you can refer to its path as ‘csnode.exe’ without 
having to have any more of an explicit path.

Macros

Any command line can have embedded macros to refer to the locations of programs that 
the watchdog is controlling. Macros stand in for the name, path, or directory of an installa-
tion component. They are defined for the watchdog in the xwatch.ini script using the 
“Name” parameter within a “Task Program” section. For example, the following section 
would setup a macro called “Agent”:

Task program

Command C:\Program Files\CoolSign\Agent\csnode.exe

Name Agent

Heartbeat C:\Program Files\Agent\heartbeats\Agent

In the more recent version of the configuration files, as of Watchdog version 2.0.03.0000, 
the ‘task program’ section is expressed in XML. In that type of configuration file, the 
<NAME> tag within the <WATCH_PROGRAM> section holds the macro name.

When using the macros in the install.txt script, they look like this: ${MacroName}, in 
other words, a dollar sign followed by the name of the macro enclosed in curly braces with 
no spaces on either side of the name. The macro name itself should also not contain spaces. 
They are not case sensitive, for example, ${AGENT} and ${Agent} will both mean the 
same thing in the scripts. Every time a “Name” command is used in the xwatch.ini script, 
3 macros are created (in the following, we assume that “Name Agent” is in the task program 
area:

• ${Agent} = The entire path of the program to which it relates (for example: 
“C:\Program Files\CoolSign\Agent\csnode.exe”). 

• ${Agent -Directory} refers to the directory in which the executable is located 
(for example, “C:\Program Files\CoolSign\Agent”).

• ${Agent -Program} refers to the program name only (for example, 
“csnode.exe”).

Any of these macros can be used in the installation scripts. Remember that when you use 
them in installation scripts you should always quote the parameter so that the possible 
embedded spaces are properly interpreted, e.g. “${Agent-Directory}”.
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As a convenience, the following macros are pre-defined:

Macro Description

${Windows} The system32 directory within the windows directory 
(for example, c:\winnt\system32).

${Windows-Directory} The windows directory on the system (for example, 
C:\WinNT).

${CoolSign-Directory} The CoolSign folder in which all 2.0 software is 
installed (for example, c:\program 
files\CoolSign).

${Watchdog} The full path of the watchdog program.

${Watchdog-Directory} The directory containing the watchdog program

${Watchdog-Program} The filename of the watchdog program (in other 
words, xwatch.exe).

${Install-Directory} The directory from which your installation is being 
run. If you have programs to execute in your install, 
having this directory is required to fully path the 
location of the program you want to run.

Commands

The following commands are the meat of the installation script. Each line does something 
to accomplish the required update task. In the following, all parameters are represented by 
identifiers in square brackets (for example, <parameter>). In using the commands, the 
brackets are left out. Quotes should be used for any parameter that might contain spaces (for 
example, macros that refer to things in the “Program Files” directory.

Cd <directory>

Change directory. This changes the directory for any subsequent command. Initially, all 
commands have a home directory equal to where the installation package is placed. If you 
must change directory, you should only make relative directory changes since you do not 
know the directory name in which you will be running. For example, if you have put some 
install files in subdirectories you can do the following to get to them

# First CD to our subdirectory

Cd subdirectory

# Then perform commands that depend on files in this directory, e.g.

Copy myFile c:\winnt\expectedFileLocation

# Then we CD back to where we were (..)

Cd ..
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Copy <path1> <path2>

Copy a file to a location. Typically, this is used to replace files that are being updated, so 
they actually will replace existing files with new versions that are in the update component. 
As mentioned above, the default path for copies is the component directory, so the file in 
‘path1’ typically does not have a directory designated. ‘cp’ also works for this command. 
<path2> can either be a path to a file or a directory.

NOTE
Be sure and put quotes around the path1 and path2 parameters if there are spaces in the 
name, for example, “c:\program files\coolsign\agent”, or “${Agent-
Directory}\file.txt”.

CopyIfExists <path1> <path2>

Just like the above command, but it will not fail if <path1> does not exist. This is most 
useful in the PrepareInstall or UndoInstall scripts when we are not sure of the current 
state of the installation. 

Delete <path>

Delete the named file. (‘rm’ can also be used for this function.) If the <path> doesn’t exist, 
this command doesn’t fail because effectively, the file is already gone and thus meets the 
requirements of the command.

Display <on or off>

Force any connected displays to be ON or OFF. This is mostly useful if you are running an 
install or other type of script that will potentially expose the Windows desktop. You can 
pause the watchdog (with ‘set pause’) and use the command, ‘display off’, to make sure 
that all the displays are off during your operation. There is no need to run a ‘display on’ 
command afterwards as the watchdog resumes its normal operations when your script exits, 
and thus will set the displays to the correct ON/OFF setting by itself. 

TIP
This command can be either ‘Display’ or ‘Displays’ for purposes of readability.

Execute <program> <parameters>

Execute an arbitrary program. The <program> must be a complete path to the program to 
run. The next line of the installation script will execute while your program runs. It is 
possible to run the program from the installation directory if that is where it is located as 
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long as it exits during installation. Any parameters are passed to the program as they are 
specified in the script (unless they contain macros in which case those are substituted first). 
If the path to the program contains spaces, you should place quotes around it.

ExecW <program> <parameters>

Execute an arbitrary program and wait for it to complete before moving on to the next step 
of the script. Otherwise, it works the same as Execute.

ExecWRC <program> <parameters>

Execute an arbitrary program, wait for it to complete, and examine the return code before 
moving on to the next step of the script. If the return code is non-zero, the watchdog will 
fail the script and will not execute any more commands. Otherwise, it works the same as 
Execute.

ExecTimeout <timeoutSeconds> <program> <parameters>

Execute an arbitrary program, wait “timeoutSeconds” for it to complete, and examine the 
return code before moving on to the next step of the script. If the program exits by itself 
before the timeout is reached, then the script will move on at that point. This feature is to 
prevent executed programs from hanging or taking longer than expected and thus holding 
up the watchdog from doing anything else. Otherwise, it works the same as Execute.

Kill <program>

Kills the indicated program. The program name must be the actual name of the program and 
not a path to the program. So typically, you would use the ${Name-Program} macro in 
your script (for example, ${Agent-Program}). Due to the fact that a program cannot be 
updated if it is running, this action should be performed any time a program or a program’s 
component needs to be updated. 

NOTE
As mentioned earlier, if watchdog is controlling the program being killed, it will be 
automatically restarted after the update has been completed because the watchdog will be 
unpaused.

New in version 2.0.03.0000: instead of naming a specific <program> above, you can put 
‘all’ to instruct the watchdog to kill all the programs that it has started.

New in Version 2.1.00.0002:

The following are optional parameters that must precede the <program> in the command 
line:

/harsh—Forces a harsh kill; in other words, doesn’t wait for program to exit.
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/now—The same as ‘harsh.’

/nice—Allows the application to stop itself (this is the default). This option is useful 
if you want your script to be obvious that you are shutting down a program nicely.

/timeout xxx—For a ‘nice’ kill, wait nnn seconds before switching to a harsh kill. 
This parameter defaults to 7 minutes.

These parameters can be used for any script command. This includes watchdog commands 
sent via the CNM, within files, and also for any software installation scripts. 

MkDir <path>

Make a new directory given the passed path. The path will be considered to be relative to 
the component’s installation directory unless you put a drive letter designation (e.g. c:\) at 
the head of the path. ‘md’ also works for this command.

NOTE
The “..” directive will not work to move up a directory, so you cannot include this in your 
path specification (for example, ..\..\myNewDir).

Move <file> <path>

Move a file from its current location to another location (‘mv’ can also be used for this 
command). As with the copy command, <file> is the name of the file to move (and must be 
a complete path if not in the current directory), and <path> is the path where the file is to 
go, it can be a full pathname or a destination directory.

MoveIfExists <file> <path>

Just like the above ‘Move’ command, but this one will not fail if the source file <file> does 
not exist.

Pause

Pauses the watchdog’s scanning of the program tasks. This is automatically done during 
installation scripts, but must be manually done in any other type of script. This command 
supersedes the previous ‘set pause’ command used in older scripting versions (although 
that command is still supported). To turn the processing back on, use ‘Unpause’ or ‘Set 
pause=0’.

Reboot

Reboot the machine. Of course, this should only be done if it is absolutely necessary.
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Register <dllpath>

Register a .dll or .ax file with the system. This is the same as calling RegSvr32.exe on 
that program. You must give the full path to the file you are registering. This implies that 
the DLL you’re registering has already been copied to its destination before the registration 
occurs because all files will be deleted from the installation directory after the update has 
completed.

RegisterIfExists <dllpath>

Works the same as ‘Register’, but does not fail if the <dllpath> does not exist. 

Restart

Restart the watchdog program. ‘config’ or ‘set bounce’ can also be used for this command.

Unpause

Restart the watchdog’s scanning of its program tasks. This command is unnecessary in 
installation scripts as the watchdog will automatically be unpaused once the script has been 
completed, but it necessary in other scripts when you have paused the watchdog with 
‘Pause’ or ‘Set Pause’. This command is equivalent to the old script command ‘set pause=
0’.

Unregister <dllpath>

Un-register a .dll or .ax file with the system. This is the same as calling RegSvr32.exe /U 
on that program. You must give the full path to the file you are un-registering. 

NOTE
If the DLL is present and is already unregistered, this command will not fail.

UnregisterIfExists <dllpath>

The same as the ‘Unregister’ command, but it does not fail if <dllpath> does not exist.

Examples:

1. Replace the Agent program (assumes that the ‘Name Agent’ line is in the task pro-
gram area for the agent.
Kill ${Agent-Program}

Copy “${Agent-Program}”  “${Agent}”
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2. On a typical system, these commands would translate into:
Kill csnode.exe

Copy ”csnode.exe” ”c:\Program Files\CoolSign\Agent\csnode.exe”

3. Replace the Elecard filters for the AdPlayer :
# First kill the AdPlayer since we’re messing with its filters

Kill $(AdPlayer-Program}

# Unregister the filters

#   Note: The ${Windows} macro points to the system32 directory

Unregister “${Windows}\mpgdec.ax”

Unregister “${Windows}\mlcom.ax”

Unregister “${Windows}\mpeg2dmx.ax”

# Get rid of the existing filters

Delete c:\winnt\system32\mpgdec.ax

Delete c:\winnt\system32\mlcom.ax

Delete c:\winnt\system32\mpeg2dmx.ax

# Copy over new filters (assumes we run from install directory)

Copy mpgdec.ax c:\winnt\system32\mpgdec.ax

Copy mlcom.ax c:\winnt\system32\mlcom.ax

Copy mpeg2dmx.ax c:\winnt\system32\mpeg2dmx.ax

# Register the filters

Register c:\winnt\system32\mpgdec.ax

Register c:\winnt\system32\mlcom.ax

Register c:\winnt\system32\mpeg2dmx.ax

Replacing the Watchdog Itself

Since the watchdog is the program that is executing the update scripts, it cannot itself be 
updated while the installation scripts are being run. So, a special update method is required 
to update the watchdog. We will use the same method as in the 1.5 release where we place 
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an xwatch.exe.new file into the watchdog directory and do a ‘restart’ to get the watchdog 
to restart itself. The script would look like this.

Copy “${Watchdog-Program}” “${Watchdog}.new”

Restart

NOTE
The ${Watchdog} macros are automatically created when watchdog starts up. The last 
part of the line appends the .new characters to the full pathname of the watchdog 
program, so we get what we require, in other words, “xwatch.exe.new”.

Assumed Watchdog Configuration

In order for the software updates to work properly, the watchdog must be configured to 
‘watch’ (listen) for software updates and other commands. To do this, you add one more 
line to the xwatch.ini file. This line is the ‘agent’ command. The command argument is 
the path to the agent directory where it will get software updates and commands.

An example of the completed ‘Agent’ section follows:

Agent  ..\Agent

NOTE
Commands can still be received by the old method of putting them into a file called 
c:\watchdogcommand.txt. If you do not want that additional functionality, you can 
leave that line out of the xwatch.ini file.
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Creating the Update Image

There are two steps in the creation of an image to be used to make offline updates: 

1. Modify an existing channel or create a new channel in CoolSign Network Manager.

2. Use the Offline Update Imager application to create an image file (or files) with the 
channel information and the content needed for the update.

Step 1: Modify an Existing Channel or Create a New Channel

Log into CoolSign Network Manager (CNM) and make all of the changes to the Content or 
Channel that you want to distribute to offline players. The changes can include using the 
Channel Manager to modifying an existing channel, creating a new channel, 
adding/deleting content, and/or using the Content Manager to modify the settings of 
content.

Step 2: Create the Offline Update Image.

1. Launch the Offline Update Imager application.

The first time you use this, you will have to select the Edit Networks button.
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2. In the Select Network dialog, click the Refresh button, and select the network 
containing the offline players/nodes.

After selecting Login, the application will disappear for a few seconds.

3. Click OK, and then click Login. After a few seconds, the Select Nodes tab will 
appear.

4. Select the node(s) that you want to include in the image and click Next.
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5. Select export item(s) that you want to include with the update image and click Next.

The only content you must include is that which is new or has had changes made to it 
(including changes to the assets or properties). You may not want to include unneces-
sary content in order to keep the size of the update smaller. A smaller update image 
will allow the update to be applied faster and may be necessary in order to fit on some 
media.
You may also export CoolSign Software Packages along with the content in the image 
by clicking the Include Packages check box.

6. Select the media type that you will be using to distribute the update. This selection 
will cause the Offline Update Imager to automatically break the update files into easy-
to-manage chunks, if necessary. For example, if you are using CDs and the update 
you are distributing is greater than 680 MB, this application will break the update into 
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chunks that will fit onto multiple CDs. In this dialog, you will also need to specify 
where you want the application to put the update imager files.

7. Click Next when all of these settings are complete.
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8. In the Create Image tab, verify what will be in the Offline Update image and click 
Finish to create the image.

Copying the Update Image

Once the Offline Update Imager Wizard has finished creating the image files, they must be 
copied to some form of writable media (such as a CD, DVD, or USB thumb drive) for distri-
bution. The following instructions demonstrate how to copy image file to CDs, but apply 
to other media as well.

Update Distributed on One CD

The Offline Update application will create a folder entitled OfflineUpdateImage. Copy the 
contents of this folder to the highest-level directory of a blank CD. This directory structure 
will allow the application to automatically launch when inserted into a CD drive.
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The top level of the CD should look similar to what is shown below:

The autorun.inf file allows the update application to automatically run when the CD is 
inserted into the offline node.

If the update image is too large to fit on one CD, inside the OfflineUpdateImage folder you 
will find two or more sub-folders named media1, media2, etc. Copy the contents of each of 
these folders to the highest-level directory of each CD (media1 to the first CD, media2 to 
the second CD, and so on). This directory structure will allow the application to automati-
cally launch when the first CD is inserted into the offline node to be updated.

You must be sure to label these CDs using the corresponding folder names (media1, 
media2, etc.), as the CDs will need to be used in a very specific order.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 346



23. Using the Offline Update Imager 
Updating Offline CoolSign Nodes
The top level of the CD should look similar to what is shown below:

The autorun.inf file allows the update application to automatically run when 
the CD is inserted into the offline node.

Updating Offline CoolSign Nodes

This section describes how to update Players from a Transfer node and from a Player node.

NOTE
Every channel is created for a specific format. This update process will only allow you to 
update players that have the same format as the channel being updated.
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Updating from a Transfer Node

IMPORTANT
Before you start the update process, you will need to make sure the CoolSign 
WatchDog is currently running.

This process will update the schedule and content on a Transfer node and all Player nodes 
that are downstream from it. It will not work if there are other Transfer nodes downstream 
from the Transfer node being updated.

1. Insert the first CD (or other media) into the Transfer node. The update process should 
begin automatically (e.g. if CDs are being used, it should begin about five to ten sec-
onds after the CD is inserted into the drive, depending on the speed of the drive). If 
the update process does not automatically start, double-click the file startupdateim-
age.bat on the CD or double-click on the coolsign.offlineupdate.updater.applica-
tion.exe on the stored media.

2. Follow the instructions as they appear.

The application registers the necessary dlls, copies files to a temporary directory, and 
launches the update application.
During the update process, you will see a few progress updates:

Once the process is completed and, you will see the following message:

The WatchDog will restart the AdPlayer (if applicable) and the Agent. 

Updating from a Player Node

To perform an update on a Player node, follow the same process described above.
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Troubleshooting Updates

As the updater progresses through the update process, it logs every action and issue. If an 
update does not go as expected and you need additional information, it is recommended that 
you review the CoolSign syslog file(s): 

C:\ProgramData\CoolSign\Agent\logmgr\system\logs\<year>\<month>\
<day>\ 
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This section provides instructions for creating a custom display entry in CoolSign for non-
supported displays connected to Player nodes.

Introduction

CoolSign allows you to remotely manage the displays (monitors) associated with any 
networked Player nodes. For instance, you can turn a display on or off, switch inputs, and 
disable panel buttons. 

For this to work, the specific display must have a profile created within CoolSign. A profile 
is an XML file that contains the information that CoolSign (more specifically, the 
Watchdog application) will use to control the display.

A certain number of display profiles are pre-defined. You can use the CoolSign Custom 
Display Control Editor to create new profiles for your displays. 

NOTE
The Custom Display Control Editor can be used to configure any display capable of being 
controlled via serial (RS-232) commands. As of CoolSign 5.1, this includes monitors that 
support hexadecimal commands.

Install the Custom Display Control Editor

1. Download the Custom Display Control Editor installer — available from the Haivi-
sion Download Center (CustomDisplayXmlEditorInstaller.msi) — onto the networked 
player to which the custom display will be connected.

2. Run the installer and follow the steps displayed in the installation wizard.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 350



24. Using the Custom Display Control Editor 
Introduction
3. Connect the display to be profiled to the PC running the Custom Display Control 
Editor using the proper serial cable (refer to the user manual for the display).

4. Power up the display and verify that it functions properly.

5. On the PC, quit any other applications that may use the COM port to which the 
display is connected.

Create a Custom Display Control XML File

1. From the Start menu, open the Custom Display Control Editor (Program Files > 
CoolSign > CoolSign Display Control Editor).
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2. In the Display Information tab, enter the display and serial port settings. Refer to the 
display user manual.

3. If you are configuring the display to be controlled via hexadecimal commands, 
choose Use Hex from the Options menu.

4. In the Inputs tab, list all inputs, separated by commas.
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5. In the Set Power tab, enter the power commands for this display.

6. To insert a control code into a command, click Add Control Code. Select the code and 
click OK.
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7. In the Set Input tab, enter the input commands for this display. 

8. In the Query Input tab, enter the query input commands for this display.
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9. In the Panel Display tab, enter the panel display commands.

10.To test all of the serial commands that you've defined, click Test All Commands. 
When the dialog appears, select the display ID and request delay, then click Run.
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11.After the test concludes, click Close.

12.On the Player node to which the custom display will be connected, save the file (File 
> Save As) with the name the file “CustomDisplay.xml” to the following folder:
C:\ProgramData\CoolSign\Watchdog
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Control the Custom Display from CNM

The XML file you created for your custom display contains the information needed to 
control the display. But you must also edit the ManufacturersModels.xml file so that you 
can subsequently control the custom display from CoolSign Manager or the Configurator.

The ManufacturersModels.xml file is installed by default in the AppResources folder:

C:\Program Files\CoolSign\CoolSign Manager\AppResources

To add a custom display from a new manufacturer, do the following:

1. Create a new entry in the Manufacturers (first) section of the 
ManufacturersModels.xml file. For example:
- <Manufacturers_x0024_>

<Manufacturer>CustomDisplay</Manufacturer>

</Manufacturers_x0024_>

2. In the Models (second) section of the file, create an entry for the model, using the 
characteristics defined in the display’s user manual. In the example below, the 
manufacturer is “DisplayTech” and the model is “Z2009”:
<Models_x0024_>

    <Manufacturer>CustomDisplay</Manufacturer>

    <Model>320MP-3</Model>

    <Type>LCD</Type>

    <Calibration>No</Calibration>

    <Inputs>HDMI1, PC, DVI, AV </Inputs>

    <RecommendedX>1920</RecommendedX>

    <RecommendedY>1080</RecommendedY>

    <RecommendedRefresh>60</RecommendedRefresh>

    <SupportsDaisyChaining>False</SupportsDaisyChaining>

    <SupportsPanelDisabling>False</SupportsPanelDisabling>

  </Models_x0024_>

3. Save the updated file to the AppResources folder. 

4. Restart CoolSign Manager. You will be able to add and edit your newly created 
custom display.

NOTE
A networked Player is limited to one type of custom display at a time.
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This section provides an overview of what is required to play back Flash-based content in 
CoolSign. 

Preparing Flash Files

To play back Flash-based content in CoolSign, you must convert any SWF file you wish to 
use into the CoolSign content format. 

To prepare a Flash file for use with CoolSign, do the following:

1. Design your content in Adobe Flash. Include the following line of code in your 
ActionScript:
var msg:String = 

String(flash.external.ExternalInterface.call("ExpandDataSlotString", 
"$(GetDataTableAsXml)"));

This line of code retrieves the CoolSign data table that the content is bound to (or rath-
er, will be bound to at the time of playback). The data table is retrieved as an XML 
string, with elements for each row and field within the data table. For example, if you 
know that your CoolSign data table will contain a City field and a Temperature field, 
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you can expect to receive the data in the following format:
<table>

<row>

<__oid>0aca630b-ba6a-42e4-9109-a0409bae4a09</__oid>

<__seqnum>0</__seqnum>

<City>Portland</City>

<Temperature>67</Temperature>

</row>

<row>

<__oid>9b7f630b-ba6a-42e4-9109-a040910e4910</__oid>

<__seqnum>1</__seqnum>

<City>Beaverton</City>

<Temperature>69</Temperature>

</row>

...etc...

</table>

The __oid field represents a unique identifier for the row. 
The __seqnum field represents the order of the rows within the table.

NOTE

When viewing your Flash content outside of the CoolSign system (for example, from 
within the Adobe Flash designer or from a browser), this line of code will return the 
value “null”.

2. Start CoolSign Content Creator and create a new project.
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 359



A. Using Flash-based Content 
Preparing Flash Files
3. In the General tab of the Project Settings dialog, specify the title, layout, and 
dimensions for the new project:

4. In the Data Tables window, create or import the table structure that your content will 
use. The names that you assign to your data table fields determine the structure of the 
XML you can access from Flash ActionScript. For the example in Step 1, you would 
create two data table fields named City and Temperature, since that is what you 
designed your Flash content to expect.

5. Select the menu item ASSETS > IMPORT FILE and import your completed Flash content 
into CoolSign Content Creator. 
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6. Center and size the Flash asset to fill the Media Window.

7. If your Flash content is script-driven (as opposed to linear timeline-based), enable the 
Timeless property on the Flash asset.

8. Save the project to a folder on disk, and then close CoolSign Content Creator. 

9. Navigate to the project folder (on disk) and open the file Control.xml, using a text 
editor such as Notepad.

10.In the file Control.xml, find this line: 
</ControlInfo>

Paste the following code immediately after it. 
   <DataSlot>

      <DefaultExpression>=GetDataTableAsXml();

function GetDataTableAsXml()

{

        // load the xml values from the data table rows

        var myXml = "";

        

        for (i = 0; i &lt; myTable.Size; i++)

        {

           myXml = myXml + myTable.Row(i).AsXML;

        }

        

        return "&lt;table&gt;" + myXml + "&lt;/table&gt;";

}</DefaultExpression>

      <LogValue>False</LogValue>

      <Name>GetDataTableAsXml</Name>

      <Type>Text</Type>

      <UserProperties>

         <RowIndex>1</RowIndex>

      </UserProperties>

   </DataSlot>

11.Save and close the file. The content is now ready to be deployed using the CoolSign 
Network Manager.
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ActionScript Methods

The following methods can be invoked from ActionScript:

function CoolSignVersion() : String

Returns the name and version of the CoolSign Media Player.

var csVersion:String = String(ExternalInterface.call("CoolsignVersion"));

function GetScriptName() : String

Returns the name of the current media script.

var scriptName:String = String(ExternalInterface.call("GetScriptName"));

function GetScriptDuration() : Number

Returns the time of the current script in seconds. This value can range from 0 to GetScript-
Duration();

var scriptTime:Number = 
Number(ExternalInterface.call("GetScriptTime"));

function GetScriptTime() : Number

Returns the time of the current media script in seconds. This value can range from 0 to 
GetScriptDuration().

var scriptDur:Number = 
Number(ExternalInterface.call("GetScriptDuration"));

function ExpandDataSlotString (str:String) : String

Returns a string in which each data slot reference is replaced with the current value of the 
data slot. A data slot reference is encoded as “$(dataslotname)”. For example, the line

ExpandDataSlotString("Hello $(Name), you're in $(City)!") 

might return "Hello Bob, you're in New York!"

var msg:String = String(ExternalInterface.call("ExpandDataSlotString", 
"Hello $(Name)"));

function GetAttribute (str:String) : String

Returns a string that contains the value of the specified attribute. 

var msg:String = String(ExternalInterface.call("GetAttribute", 
"MyAttribute"));
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function GetDataTableFilename (tblOID:String, tblFilename:String) : 
String

Returns the path to a file that belongs to the given data table, usually a media file. The file 
should be considered read-only; the media player checks for changes and will not use a file 
if it has been tampered with.

var tblOID:String;  // get the oid of the table from the table?s XML

var tblFilename;    // this is the name of a file that you found in the table

var path:String = String(ExternalInterface.call("GetDataTableFileName", 
tblOID, tblFilename));

function AddRowToDataTable (params:String) : Boolean

Adds a new row to a data table. This request is sent to the Network Controller and executed 
there. If the local Agent isn’t currently connected, the requests are queued and sent once a 
connection is established. A return value of TRUE only means that the request was queued, 
not that the row was successfully added.

var added:Boolean = Boolean(ExternalInterface.call("AddRow", params));
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The params parameter is some XML that contains all the parameters to use when adding 
the row to the data table. Here is what the XML looks like:

<req>

  <DataTableID>OID</DataTableID>

  <DataTableName>SomeName</DataTableName>

  <ShouldAutoCreate>true</ShouldAutoCreate>

  <DataTableComment>some comment</DataTableComment>

  <ActivationDate>2008-01-01T00:00:00.000</ActivationDate>

  <ExpirationDate>2008-01-01T08:00:00.000</ExpirationDate>

  <RelativeActivation>0</RelativeActivation>

  <RelativeExpiration>0</RelativeExpiration>

  <BumpTableVersion>true</BumpTableVersion>

  <SequenceNumber>0</SequenceNumber>

  <Data>

    <Field>

      <Name>Person</Name>

      <Value>Tom</Value>

      <Type>String</Type>

    </Field>

    <Field>

      <Name>Score</Name>

      <Value>975</Value>

      <Type>Number</Type>

    </Field>

  </Data>

</req>

DataTableID — Required: Yes    Default: n/a

The OID of the data table to update. You must specify either DataTableID or DataTable-
Name, but not both.

DataTableName — Required: Yes    Default: n/a

The name of the data table to update. You must specify either DataTableID or DataTable-
Name, but not both.

ShouldAutoCreate — Required: No    Default: False

If TRUE, then if the data table specified by DataTableName doesn’t exist it will be 
created. This can only be used when you include the DataTableName parameter. The 
structure of the table is determined by the field information for the row that you are trying 
to insert.
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DataTableComment — Required: No    Default: “Auto-created table”

If the data table is created by this call, this parameter specifies the value to use as the 
comment.

ActivationDate — Required: No    Default: “1600-01-01T00:00:00.000”

Specifies the activation date for the data row, in the following format: “YYYY-MM-
DDTHH:MM:SS.FFF”. The default value means that the row is immediately active. 

ExpirationDate — Required: No    Default: “1600-01-01T00:00:00.000”

Specifies the expiration date for the data row “YYYY-MM-DDTHH:MM:SS.FFF”. The 
default value means that the row never expires. 

RelativeActivation — Required: No    Default: n/a

Specifies the activation date as the number of seconds from now (now being the time that 
the row is actually created in the database). This value cannot be used with the Activation-
Date parameter.

RelativeExpiration — Required: No    Default: n/a

Specifies the expiration date as the number of seconds from now (now being the time that 
the row is actually created in the database). This value cannot be used with the Expira-
tionDate parameter.

BumpTableVersion — Required: No    Default: True

If TRUE, the version of the data table is incremented when the row is added. Incrementing 
the version number of the data table makes the new row visible to the media engine, so if 
you are adding multiple rows and don’t want them to become visible until all the rows are 
added, then you would set this parameter to FALSE for all the rows except for the last row 
you add; when adding the last row, you would set this parameter to TRUE.

SequenceNumber — Required: No    Default: 0

An arbitrary number that can be used to sort the rows in the data table.

Data — Required: Yes    Default: n/a

The Data section of the XML specifies the values to assign to each field of the row. It 
contains three parameters: Name, Value and Type. The Type field is only used when auto-
creating the data table and must be one of the following: Text, Number, Boolean, Date, 
Time. 
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function LocalPropertyGet () : String

function LocalPropertyGetAll () : String

function LocalPropertySet (name:String, value:String) : Boolean

function LocalPropertyIsSet (name:String) : Boolean

function LocalPropertyDelete (name:String) : Boolean

function LocalPropertyDeleteAll () : Number

Local properties are private to a single piece of content. In fact, they are local to a single 
instance of a piece of content; if a piece of content is in a schedule twice, each instance has 
its own set of local properties. 

var myValue:String = String(ExternalInterface.call("LocalPropertyGet", 
"MyProperty"));

var myProps:String = 
String(ExternalInterface.call("LocalPropertyGetAll"));

var wasSet:Boolean = Boolean(ExternalInterface.call("LocalPropertySet", 
"MyAttribute", ?Hello?));

var isSet:Boolean = Boolean(ExternalInterface.call("LocalPropertyIsSet", 
"MyAttribute"));

var wasSet:Boolean = 
Boolean(ExternalInterface.call("LocalPropertyDelete", "MyAttribute"));

var count:Number = 
Number(ExternalInterface.call("LocalPropertyDeleteAll"));
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function GlobalPropertyGet (name:String) : String

function GlobalPropertyGetAll () : String

function GlobalPropertySet (name:String, value:String) : Boolean

function GlobalPropertyIsSet (name:String) : Boolean

function GlobalPropertyDelete (name:String) : Boolean

function GlobalPropertyDeleteAll () : Number

Global properties are identical to local properties but are shared by all pieces of content. 

var myValue:String = String(ExternalInterface.call("GlobalPropertyGet", 
"MyProperty"));

var myProps:String = 
String(ExternalInterface.call("GlobalPropertyGetAll"));

var wasSet:Boolean = Boolean(ExternalInterface.call("GlobalPropertySet", 
"MyAttribute", ?Hello?));

var isSet:Boolean = Boolean(ExternalInterface.call("GlobalPropertyIsSet", 
"MyAttribute"));

var wasSet:Boolean = 
Boolean(ExternalInterface.call("GlobalPropertyDelete", "MyAttribute"));

var count:Number = 
Number(ExternalInterface.call("GlobalPropertyDeleteAll"));
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function EvalLogGet (clearLog:Boolean) : String

function EvalLogAdd (msg:String) : Boolean

function EvalLogClear() : Boolean

function EvalLogGetEnabled () : Boolean

function EvalLogSetEnabled (enabled:Boolean) : Boolean

The Eval log is used for debugging content. Messages written to the Eval log can be 
retrieved by the host application and shown to the user. 

var messages:String = String(ExternalInterface.call("EvalLogGet", true));

var msgAdded:Boolean = Boolean(ExternalInterface.call("EvalLogAdd", 
"Some message"));

var bTrue:Boolean = Boolean(ExternalInterface.call("EvalLogClear"));

var isEnabled:Boolean = 
Boolean(ExternalInterface.call("EvalLogGetEnabled"));

var bTrue:Boolean = Boolean(ExternalInterface.call("EvalLogSetEnabled", 
true));

function WriteToSystemLog (level:String, msgID:String, msg:String) : 
Boolean

Returns TRUE if the message was written to the system log. The system log is used to help 
debug issues that happen in the field.

level — The log level of the message: “Severe”, “Error”, “Warning”, “Info”, “Debug” or 
“Trace”.

msgID — Message IDs are used to track specific events without having to parse the 
message itself. Using message IDs allows you to change the text of the message and still 
allow tools and tech support to search for that event.

Message IDs should be globally unique and normally take the format <prefix><number>, 
where the <prefix> uniquely designates a particular customer and <number> is a value used 
to keep the message ID unique; for example, “Nike1001”. Spaces are not allowed in 
message IDs.

Most messages are not assigned an ID and are reported with “” as the message ID. When 
you supply a message ID, the message is also written to the application log. The application 
log is then uploaded so that it is viewable by the CoolSign operator. Since this creates 
network traffic, only very important messages should be written to the application log. You 
can override this behavior by prefixing an underscore to the message ID. For example, 
“Nike1001” is written to both the application and system logs, but “_Nike1001” is written 
to just the system log.
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msg — The message itself. This can be any arbitrary text, but it is best to include specific 
information. Generic messages are not useful when trying to track down problems.

ExternalInterface.call("WriteToSystemLog", "Info", "", "Something 
interesting happened");

function ReportError (msg:String) : Boolean

Returns TRUE if the error was properly reported. The error message is viewable by the 
CoolSign operator. After an error is reported, the AdPlayer will select another piece of 
content to play. 

ExternalInterface.call("ReportError", "I don?t want to play ***");
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Vistar Media (www.vistarmedia.com) operates a marketplace for digital place-based 
advertising. Vistar Media’s platform automates the delivery of ads from buyers to digital 
signage networks. This enable advertisers to connect seamlessly to ad networks to sell their 
ads — Vistar Media effectively acts as a broker between ad sellers and ad buyers. 

The CoolSign Vistar Content feature gives CoolSign network operators the ability to 
schedule ad content purchased through Vistar Media — an increasingly popular solution 
for filling spare capacity in a pipeline.

A CoolSign administrator can schedule a piece of Vistar content, such that individual 
players in the CoolSign network grab ads for specified time slots, play them back, and then 
report the playback to Vistar Media. 

NOTE
Vistar content requires that sites have longitude and latitude information defined. Sites 
that are created automatically for new players do not contain any information other than 
the site’s name. To set geographic information for a site, see “Editing Site Properties” on 
page 203.

Adding Vistar content

Adding Vistar content is straightforward. You need only specify your Vistar Media account 
credentials, and then block out sections of your schedule to be filled by Vistar Media 
“plays”. As with any content in CoolSign, Vistar content must be added to the system 
before it can be scheduled or played on the CoolSign players connected to your network. 
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To add Vistar content to a CoolSign network:

1. Choose CREATE VISTAR content from the ACTIONS menu:

2. In the dialog box that appears, enter the information required to identify the Vistar 
content:

Content Name — The content’s name is used wherever the content is referred to, 
including play logs and scheduled items.
Server URL — The URL of the server hosting the Vistar content. 
Network ID — A unique identifier provided by Vistar Media Inc. 
API Key — A unique identifier provided by Vistar Media Inc. 

3. Click Test Connection to verify that the connection to the Vistar server is good. If an 
error message appears, check the settings and try again.

4. Click OK. The new Vistar content item appears on the Content page.
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5. Right click on the new content and choose EDIT CONTENT PROPERTIES:
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6. In the Content Properties window, specify the properties of the new Vistar content as 
necessary (see “Using the Content Properties Dialog” on page 112): 

NOTE

The Vistar version of the Content Properties page has one new tab (Vistar), but does 
not have the Assets tab that appears on the Content Properties page for standard 
CoolSign content.

7. Click OK. The new Vistar content is now available to be used in your CoolSign 
network. For information on how to duplicate, modify, or delete Vistar content items, 
see “Working with Content” on page 100.
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To add Vistar content to a channel:

1. Open the Channel Manager and find or create a channel to which you wish to add the 
Vistar content (see “Working with Channels” on page 135:)

2. Open the channel:

NOTE

While this example shows the addition of an in rotation item, Vistar content can also 
be added to a schedule as a timed, recurring, or triggered item. For information on 
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adding content, see “Adding Items to a Channel” on page 139.

3. Click Add in-rotation item. The content picker window appears:

4. Select the Vistar content you wish to add to the channel, and then click OK. The Vistar 
content appears in the channel’s In rotation items list:
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5. Double-click the Vistar item to open the Schedule Item Properties window:

6. Specify the scheduling properties as needed (see “About the Channel Properties 
Dialog” on page 138).

NOTE

If, for example, you have a 15-minute segment of Vistar content, but 2 hours of free 
space in the schedule, you can make eight copies of Vistar content to fill the empty 
block in the schedule.

7. Click OK. At the specified times, the designated players will connect to the Vistar 
server, download the content, then play it on screen. Once done, the players will send 
an acknowledgement back to the Vistar server, confirming that the ad content has 
been played.

NOTE

Exchanges of content and confirmation take place directly between the CoolSign 
Players and the Vistar Media Server. The CoolSign Network Manager is not involved.

For more information, see “Adding and Editing an In-Rotation Schedule Item” on 
page 142.
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There are two ways to acquire streaming content:

• Direct (via Furnace v6.3)
• URL (via Makito)

Before you stream content you must configure your Furnace or Makito device to work with 
CoolSign.

Configuring Furnace for CoolSign

To configure CoolSign to allow access to streaming content from Furnace, you will need 
admin access to the Furnace server. The first step is to log in to the Furnace portal Web 
interface and create a CoolSign user with administrative permissions. 

IMPORTANT
Before you continue, you will need to obtain the IP address and access credentials for 
the Furnace server that will be connected to CoolSign. The Furnace server should 
have a trusted SSL certificate (not installed by default). Without it, users will encounter 
CoolSign warning messages, and the thumbnails for linked videos may not be 
displayed.

To configure a Furnace device:

1. In a new browser tab or window, browse to the IP Address of your Furnace server.
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2. Sign in with an admin username and password: 

3. On the VF Admin page, click the General > Configuration link.In the row labelled 
Select REST API version choose 2.0 (Authentication Enabled). In the row labelled 
Conditional Access Method choose NONE. Click Save Configuration. 

4. Click the Credential Manager link. Create a credential with a valid expiration date. 
This credential will be used to authenticate Furnace on your CoolSign server. Click 
Submit:
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 378



C. Configuring Devices to Stream Content 
Configuring Furnace for CoolSign
5. Under the Groups tab, click the Modify link corresponding to a group to which you 
would like to add the new credential (the credentials MUST be added to a group that 
has ADMIN permissions):

6. Click the checkbox corresponding to the new credential, then click Add Selected:

7. Click the Group Permissions link, then navigate to the Permissions page for the 
group you modified in Step 6. Make sure that All Permissions is checked:

NOTE

Having a specific CoolSign credential will allow you to revoke that credential, if 
needed, without affecting other active credentialed applications. The CoolSign 
credential must be created with a valid expiration date, and can be added to any 
Group that has the All Permissions enabled (i.e. Furnace Admin users). For more 
information, refer to “Configuring Group Permissions” and “Managing API 
Credentials” in Chapter 2 of the Furnace Administration Guide.

8. Click the Credential Manager link, then click the Modify link corresponding to the 
credential you created in Step 4. to view the CoolSign credentials. You will need 
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 379



C. Configuring Devices to Stream Content 
Configuring Furnace for CoolSign
some of the information displayed here to complete the configuration on the CoolSign 
server:

Tagging Assets in Furnace

CoolSign can recognize video assets on the Furnace server and make them available as 
content to add to CoolSign channels. While all assets on the Furnace server are accessible 
to CoolSign, you can associate specific videos with corresponding channels by tagging 
them with a channel name.

To tag assets in Furnace:

1. In CoolSign, identify the channel name.

2. Launch VF Editor on the Furnace server. 

3. Load an asset you wish to tag:

4. In the Editor, choose the Metadata tab:
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5. Click on tab 5. Type the CoolSign channel name, then press the Enter key.

6. Click Done then Save the asset.

For more information on adding metadata in Furnace, see VF Editor - Digitizing and 
Managing Assets in the Furnace Administration Guide.

For more information on how to set up an output stream, please refer to the Furnace product 
documentation available from the Haivision Download Center (www.haivision.com/down-
load-center).

Configuring Makito Devices

Playing Encoder Streams in CoolSign

This section provides instructions for configuring Haivision’s Makito and Barracuda H.264 
encoders to stream to a CoolSign Player. 
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Encoder Setup

For information on how to set up an output stream, please refer to the Makito or Barracuda 
user documentation available from the Haivision Download Center (www.haivi-
sion.com/download-center).

• Follow the instructions in the Makito/Barracuda Quick Start Guide to power on the 
unit and log in to the encoder’s Web Interface.

• Refer to the Makito/Barracuda User’s Guide or the online help (available from the 
encoder’s Web Interface) for instructions on how to configure a Makito or Barracuda 
encoder to provide a stream to a CoolSign network.

IMPORTANT
The Makito device should be on the same subnet as the player.
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Troubleshooting alerts

The Home page displays alerts that are raised by the nodes in your CoolSign network. This 
section lists some of the more common alerts and steps to troubleshoot.

Node offline 

The CoolSign node is no longer communicating with the Network Controller. 

Abnormal software restart

Either the CoolSign Agent or AdPlayer components have been restarted multiple times 
within a short period of time. This may indicate severe issues with the CoolSign node or 
software configuration. You can troubleshoot this issue by doing any of the following:

• Ensure that no one has been physically accessing the PC for maintenance or other 
reasons. 

• Review the Home page application logs to check if a user has remotely issued restart 
software component commands.

• Review the event logs for the node to determine if additional information regarding the 
software restart is available. For more information on event logs, see “About Event 
Logs” on page 296.

Unexpected reboot

The CoolSign PC has rebooted multiple times within the previous 24 hours. This may 
indicate issues with the CoolSign software or hardware problems. You can troubleshoot 
this issue by doing any of the following:

• Check that no one is physically rebooting the PC or working on the power at the 
location.

• Review the Home page application logs to check if a user has remotely rebooted the 
node.

• Review the event logs for the node to determine if additional information regarding the 
node reboot is available. 
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Not enough free space on disk

The available disk space on the hard drive of a CoolSign PC has fallen below the configured 
low disk space threshold. CoolSign automatically attempts to free up disk space by deleting 
any unused files. You can troubleshoot this issue with any of the following actions:

• Check that you haven’t scheduled more content than you have total disk space. You 
can check the total required disk space for each piece of content from the Content 
Properties dialog, and you can check the total required disk space for a channel from 
the Channel Properties dialog. If the total disk space required by a channel is too large, 
you may need to unschedule some content or upgrade your hard disk.

• Remove any other non-CoolSign applications or files that may be installed on the PC.
• Force the node to garbage collect. See“Cleaning Up Space on a Node” on page 300.
• Manually clean up the CoolSign log folders. You can delete any local log files by 

manually deleting the LogMgr folder in the CoolSign Agent folder by using the remote 
console command on the Advanced Node Properties dialog.

Display error

A serial-controlled display has reported an error or is no longer communicating with the 
CoolSign node. For more information, see “Troubleshooting display errors” on page 386.

Task succeeded/Task timed out

These alerts are raised when a task succeeds or fails within the configured time limit. For 
more information on tasks and configuration, see “Tasks” on page 304.

Troubleshooting player errors

CNM provides a number of tools to help you troubleshoot problems with your players.

Understanding Region Status

You can view the status of a player or player region in the Region Status column of the 
Players page or on the Player Properties dialog.

The status of a player can be any of the following values:
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OK—No issues have been reported and the player or region is playing its tuned 
channel correctly.

Content Error—One or more of the content items scheduled on the player or 
region reported an error during playback. For more information, refer to “Trouble-
shooting display errors” on page 386.

Offline—The entire player node is currently offline and not connected to the 
network.  

Initializing...—The player or region has just been created and is still starting up. 
This status should be transitory. If a player reports the Initializing status for more 
than a few minutes, there may be other issues with its configuration that are 

preventing it from starting. 

Paused (Display off)—Occurs when any or all of the displays connected to a 
player have been set or scheduled to OFF using the Display control. 

Paused (Display set to X input)—All the displays connected to a player are set 
or scheduled to a non-CoolSign input.

No Channel—Either a new player has not yet been tuned to a channel, or the 
channel a player was tuned to has been deleted.

Empty Channel—The channel that the player is tuned to has no scheduled items. 

No Active Scheduled Items—The channel has items but none of the items are 
currently active due to pending activation, expiration, or disabling.

Unknown—No status is reported by the player. Please try restarting the player 
remotely.

No Product Key—The player does not have a valid product key. See “About 
Product Keys” on page 80.

Unsupported Resolution—A player is configured to a video output resolution 
that is not supported by the video card. Refer to “Configuring Players and Devices” 
on page 190.

Fatal Error—A player encountered a severe error that prevents it from starting up 
successfully. Fatal errors can be a result of improperly installed software, decoders 
or video drivers. In most cases, if rebooting the player does not clear a fatal error, you 

must reinstall the CoolSign software onto the player.

NOTE
Review the event logs for detailed information on the errors. It doesn't guarantee that all 
the errors have an event log entry; however, most will. For more information on event logs, 
see “About Event Logs” on page 302.
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Understanding display status

You can view the status of any display devices being serial-controlled by CoolSign in the 
Display Status column of the Players page or on the Display Properties dialog for a display.

The Display Status of a player can be any of the following values:

(blank)—This player is not configured with any display control. The player cannot 
retrieve status from any connected display devices.

Display OK—The display device is reporting an OK status to the player and is set 
to the configured CoolSign input.

Display OK (Set input is XXX)—The display device is reporting an OK status 
and its display control has been directly set to the indicated input from the Display 
Properties dialog.

Display OK (Scheduled input is XXX)—The display device is reporting an OK 
status and the current input is set to the indicated input as defined in the display’s 
input schedule.

Waiting for status on new display—Newly configured displays will report this 
status until the display device first reports its status to the player.

No Connection—Indicates that the display device configured for this player is not 
reporting any status to the player. Refer to the following discussion, “Trouble-
shooting display errors” on page 386.

Unknown (Offline)—The player is currently offline and the current display status 
cannot be determined.

[Error status]—Any other status values are reported directly from the display 
device and are dependent on the error messages for that device.

Troubleshooting display errors

Unfortunately, providing an exhaustive resource on troubleshooting every possible make, 
model, and configuration of display device is beyond the scope of this document. If you are 
getting a No Connection display status for a display you believe to be connected, you 
should check the following conditions:

• Confirm that the display properties match the actual display device. Both the brand and 
model must match the actual device exactly. 

• Confirm that the display is configured to use the correct COM port.
• Verify the display is receiving power and shows a signal with the OSD.
• Check that the serial cable is securely connected to both the player PC and the display 

device.
• Verify that the serial cable is not defective by using it on another player that is already 

working or by doing a continuity check on all pins.
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If you are receiving a display-specific error status, please check with the manufacturer’s 
documentation provided with your display device.

Reviewing audit history for an item

When troubleshooting problems with your CoolSign network, it can be useful to review 
exactly what actions were performed on an item. The item audit history lists every change 
made to an item, when the change was made, and which user made the change. You can 
review the audit history for the following items in your network:

• Content
• Audio
• Data Tables
• Channels
• Playlists
• Nodes
• Triggers

To review the audit history for an item:

1. Open the properties dialog for the item you want to review.

2. On the Security tab, click Audit History to open the Audit History dialog.
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3. Click in the Data column to view which fields were modified on the object.
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E.Keyboard Shortcuts

CoolSign Configurator

While using the CoolSign Configurator, you can perform many tasks from the keyboard. 
Refer to the following table:

Table E-1 Configurator Keyboard Shortcuts  

To do this . . . Press . . . 

Go to the next field TAB

Open a drop-down menu ALT-

Move through a pull-down menu Use the arrow keys

Select an item from a pull-down 
menu

ENTER

Advance to the next screen ALT-N

Go back to a previous screen ALT-B

Save configuration settings ALT-S (for player nodes, only available on 
Displays screen)

Add a player node ALT-A (only available on the Player Node: 
Player information screen)

Delete the selected player node ALT-D (only available on the Player Node: 
Player information screen)

Add a display ALT-A (only available on the Player Node: 
Displays screen)

Delete the selected display ALT-D (only available on the Player Node: 
Displays screen)
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Ad Player
Ad Player 

The following keyboard commands are available when the AdPlayer window is in the front 
of all other windows on a screen.

Table E-2 AdPlayer Keyboard Shortcuts  

To do this . . . Press . . . 

Toggle the cursor V

Toggle the taskbar T

Toggle calibration mode C

Toggle FPS display F (not available on legacy machines while video 
is running)

Capture the screen image CTRL-S (the image file is located at 
AdPlayer\Thumbnail.jpg). Not available 
on legacy machines while video is running.

Capture the screen image, 
scaled to 1/4 of  
the original size

CTRL-SHIFT-S (the image file is located at 
AdPlayer\Thumbnail.jpg). Not available 
on legacy machines while video is running.
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F.  Warranty Information

Haivision Network Video One (1) Year Limited Warranty

Haivision warrants its hardware products against defects in materials and workmanship 
under normal use for a period of ONE (1) YEAR from the date of equipment shipment 
(“Warranty Period”). If a hardware defect arises and a valid claim is received within the 
Warranty Period, at its option and to the extent permitted by law, Haivision will either (1) 
repair the hardware defect at no charge, or (2) exchange the product with a product that is 
new or equivalent to new in performance and reliability and is at least functionally equiv-
alent to the original product. A replacement product or part assumes the remaining warranty 
of the original product or ninety (90) days from the date of replacement or repair, whichever 
is longer. When a product or part is exchanged, any replacement item becomes your 
property and the replaced item becomes Haivision’s property. 

EXCLUSIONS AND LIMITATIONS

This Limited Warranty applies only to hardware products manufactured by or for Haivision 
that can be identified by the “Haivision” trademark, trade name, or logo affixed to them. 
The Limited Warranty does not apply to any non-Haivision hardware products or any 
software, even if packaged or sold with Haivision hardware. Manufacturers, suppliers, or 
publishers, other than Haivision, may provide their own warranties to the end user 
purchaser, but Haivision, in so far as permitted by law, provides their products “as is”. 

Haivision does not warrant that the operation of the product will be uninterrupted or error-
free. Haivision does not guarantee that any error or other non-conformance can or will be 
corrected or that the product will operate in all environments and with all systems and 
equipment. Haivision is not responsible for damage arising from failure to follow instruc-
tions relating to the product’s use. 

This warranty does not apply: 

1. to cosmetic damage, including but not limited to scratches, dents and broken plastic 
on ports; 

2. to damage caused by accident, abuse, misuse, flood, fire, earthquake or other external 
causes; 

3. to damage caused by operating the product outside the permitted or intended uses 
described by Haivision; 

4. to a product or part that has been modified to alter functionality or capability without 
the written permission of Haivision; or 
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5. if any Haivision serial number has been removed or defaced.

TO THE EXTENT PERMITTED BY LAW, THIS WARRANTY AND REMEDIES 
PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRAN-
TIES, REMEDIES AND CONDITIONS, WHETHER ORAL OR WRITTEN, STATU-
TORY, EXPRESS OR IMPLIED. AS PERMITTED BY APPLICABLE LAW, 
HAIVISION SPECIFICALLY DISCLAIMS ANY AND ALL STATUTORY OR 
IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
WARRANTIES AGAINST HIDDEN OR LATENT DEFECTS. IF HAIVISION 
CANNOT LAWFULLY DISCLAIM STATUTORY OR IMPLIED WARRANTIES 
THEN TO THE EXTENT PERMITTED BY LAW, ALL SUCH WARRANTIES SHALL 
BE LIMITED IN DURATION TO THE DURATION OF THIS EXPRESS WARRANTY 
AND TO REPAIR OR REPLACEMENT SERVICE AS DETERMINED BY HAIVISION 
IN ITS SOLE DISCRETION. No Haivision reseller, agent, or employee is authorized to 
make any modification, extension, or addition to this warranty. If any term is held to be 
illegal or unenforceable, the legality or enforceability of the remaining terms shall not be 
affected or impaired.

EXCEPT AS PROVIDED IN THIS WARRANTY AND TO THE EXTENT PERMITTED 
BY LAW, HAIVISION IS NOT RESPONSIBLE FOR DIRECT, SPECIAL, INCI-
DENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY BREACH 
OF WARRANTY OR CONDITION, OR UNDER ANY OTHER LEGAL THEORY, 
INCLUDING BUT NOT LIMITED TO LOSS OF USE; LOSS OF REVENUE; LOSS OF 
ACTUAL OR ANTICIPATED PROFITS (INCLUDING LOSS OF PROFITS ON 
CONTRACTS); LOSS OF THE USE OF MONEY; LOSS OF ANTICIPATED 
SAVINGS; LOSS OF BUSINESS; LOSS OF OPPORTUNITY; LOSS OF GOODWILL; 
LOSS OF REPUTATION; LOSS OF, DAMAGE TO OR CORRUPTION OF DATA; OR 
ANY INDIRECT OR CONSEQUENTIAL LOSS OR DAMAGE HOWSOEVER 
CAUSED INCLUDING THE REPLACEMENT OF EQUIPMENT AND PROPERTY, 
ANY COSTS OF RECOVERING, PROGRAMMING, OR REPRODUCING ANY 
PROGRAM OR DATA STORED OR USED WITH HAIVISION PRODUCTS AND 
ANY FAILURE TO MAINTAIN THE CONFIDENTIALITY OF DATA STORED ON 
THE PRODUCT. THE FOREGOING LIMITATION SHALL NOT APPLY TO DEATH 
OR PERSONAL INJURY CLAIMS, OR ANY STATUTORY LIABILITY FOR INTEN-
TIONAL AND GROSS NEGLIGENT ACTS AND/OR OMISSIONS. 

OBTAINING WARRANTY SERVICE

Before requesting warranty service, please refer to the documentation accompanying this 
hardware product and the Haivision Support Portal http://support.haivision.com. If the 
product is still not functioning properly after making use of these resources, please contact 
Haivision or Authorized Reseller using the information provided in the documentation. 
When calling, Haivision or Authorized Reseller will help determine whether your product 
requires service and, if it does, will inform you how Haivision will provide it. You must 
assist in diagnosing issues with your product and follow Haivision’s warranty processes. 

Haivision may provide warranty service by providing a return material authorization 
(“RMA”) to allow you to return the product in accordance with instructions provided by 
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Haivision or Authorized Reseller. You are fully responsible for delivering the product to 
Haivision as instructed, and Haivision is responsible for returning the product if it is found 
to be defective. Your product or a replacement product will be returned to you configured 
as your product was when originally purchased, subject to applicable updates. Returned 
products which are found by Haivision to be not defective, out-of-warranty or otherwise 
ineligible for warranty service will be shipped back to you at your expense. All replaced 
products and parts, whether under warranty or not, become the property of Haivision. 
Haivision may require a completed pre-authorized form as security for the retail price of 
the replacement product. If you fail to return the replaced product as instructed, Haivision 
will invoice for the pre-authorized amount. 

APPLICABLE LAW

This Limited Warranty is governed by and construed under the laws of the Province of 
Quebec, Canada.

This Limited Hardware Warranty may be subject to Haivision’s change at any time without 
prior notice.

Haivision Network Video End User Software License Agreement

READ BEFORE USING

THE SOFTWARE PROGRAMS ARE PROTECTED BY NATIONAL AND INTERNA-
TIONAL COPYRIGHT LAWS AND TREATIES. READ THE TERMS OF THE 
FOLLOWING END USER (SOFTWARE) LICENSE AGREEMENT (“AGREEMENT”) 
CAREFULLY BEFORE USING THE PRODUCT. BY USING THE PRODUCT, YOU 
CONFIRM YOUR ACCEPTANCE OF THIS AGREEMENT. IF YOU DO NOT AGREE 
TO THESE TERMS, HAIVISION IS UNWILLING TO LICENSE THE LICENSED 
SOFTWARE TO YOU AND YOU ARE NOT AUTHORIZED TO INSTALL OR USE 
THE LICENSED SOFTWARES.

1. DEFINITIONS

1.1      Entitlement. The collective set of applicable documents authorized by Haivi-
sion Systems Inc. or its affiliate Haivision Network Video (collectively “Haivision) 
evidencing your obligation to pay associated fees (if any) for the license, associated 
Services, and the authorized scope of use of Licensed Software under this Agreement.
1.2      You (or Your). The individual or legal entity specified in the Entitlement, or for 
evaluation purposes, the entity performing the evaluation.
1.3      License Fee. License Fee shall mean the consideration paid to Haivision for use 
of the Licensed Software. The License Fee is part of the price paid for the relevant 
Product.
1.4      Licensed Software. Licensed Software shall mean the executable version of 
Haivision’s computer software, program or code, in object code format (specifically 
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excluding source code), together with any related material including, but not limited to 
the Reference Manuals or database schemas provided for use in connection with the 
Licensed Software and including, without limitation, all Upgrades through the date of 
installation.
1.5      Reference Manuals. Reference Manuals shall mean the most current version of 
the documentation for use in connection with the Licensed Software provided by 
Haivision to You.
1.6      Updates. Updates shall mean any periodic software releases, additions, fixes, 
and enhancements thereto, release notes for the Licensed Software and related Refer-
ence Manuals, (other than those defined elsewhere in this section as Upgrades) which 
have no value apart from their operation as part of the Licensed Software and which 
add minor new functions to the Licensed Software, but none so significant as to war-
rant classification as an Upgrade, which may be provided by Haivision to fix critical 
or non-critical problems in the Licensed Software on a scheduled, general release ba-
sis. Updates to the Licensed Software (“Version”) are denoted by number changes to 
the right of the decimal point for a version and revision number (for example going 
from 2.0.0 to 2.1.3).
1.7      Upgrades. Upgrades shall mean any modification to the Licensed Software 
made by Haivision, which are so significant, in Haivision’s sole discretion, as to war-
rant their exclusion under the current license grant for the Licensed Software. Up-
grades of Licensed Software are denoted by number changes to the left of the decimal 
point for a release number (for example going from 2.0 to 3.0).

2. RIGHTS GRANTED, RESTRICTIONS AND SUPPORT

2.1      License to Use.
           (a)      Subject to the terms and conditions set forth herein and subject to the 
terms of your Entitlement, Haivision hereby grants to You a non-exclusive, personal, 
limited and nontransferable right and license to use the Licensed Software in accor-
dance with the terms of this Agreement. This license is granted to You and not, by im-
plication or otherwise, to any parent, subsidiary or affiliate of Yours without 
Haivision’s specific prior written consent. This license is for the limited use of the Li-
censed Software by You for the purpose of creating, managing, distributing and view-
ing IP Video assets. This license does not grant to You the right to use any Licensed 
Software in connection with any public broadcasting or broadcasting for home or res-
idential purposes, or any license for content whatsoever. The license and rights granted 
to You in this Section (2.) do not include the right to sublicense to distributors, resellers 
and other third parties any of the rights granted to You in this Section (2.). All rights 
not expressly granted You in this Agreement are reserved to Haivision and no implied 
license results from this license.
2.2      Restrictions.
                  (a)      Reproduction. You shall not copy, distribute, reproduce, use or allow 
access to any of the Licensed Software, except as explicitly permitted under this 
Agreement. You shall not modify, adapt, translate, export, prepare derivative works 
from, decompile, reverse engineer, disassemble or otherwise attempt to derive source 
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code from the Licensed Software or any internal data files generated by the Licensed 
Software, or use the Licensed Software embedded in any third party hardware or soft-
ware. You shall also not use the Licensed Software in an attempt to, or in conjunction 
with, any device, program or service designed to circumvent technological measures 
employed to control access to, or the rights in other work protected by copyright laws. 
You shall not remove, modify, replace or obscure Haivision’s copyright and patent no-
tices, trademarks or other proprietary rights notices affixed to or contained within any 
Licensed Software. No right is granted hereunder for any third party who obtains ac-
cess to any Licensed Software through You to use the Licensed Software to perform 
services for third parties. 
                  (b)      Ownership. The Licensed Software is conditionally licensed and not 
sold. As between the parties, Haivision and/or its licensors owns and shall retain all 
right, title and interest in and to all of the Licensed Software, including all copyrights, 
patents, trade secret rights, trademarks and other intellectual property rights therein, 
and nothing in this Agreement shall be deemed to transfer to You any ownership or 
title to the Licensed Software. You agree that it will not remove, alter or otherwise ob-
scure any proprietary rights notices appearing in the Licensed Software. All Haivision 
technical data and computer software is commercial in nature and developed solely at 
private expense.

3. TERM AND TERMINATION

3.1      Term. The license and service term are set forth in your Entitlement(s). Addi-
tionally, this Agreement may be terminated without cause by You upon thirty (30) days 
written notice to Haivision.
3.2      Termination for Breach. Your rights under this Agreement will terminate im-
mediately without notice from Haivision if You materially breach it or take any action 
in derogation of Haivision’s rights to Software. Haivision may terminate this Agree-
ment should any Software become, or in Haivision’s reasonable opinion likely to be-
come, the subject of a claim of intellectual property infringement or trade secret 
misappropriation.
3.3      Termination; Effect; Survival. Upon the termination of this Agreement for any 
reason: (a) all license rights granted hereunder shall terminate; (b) You shall immedi-
ately pay to Haivision all amounts due and outstanding as of the date of such termina-
tion or expiration; and (c) You shall return to Haivision all Licensed Software and all 
Haivision Confidential Information not otherwise required under the terms of this 
Agreement or certify that all such Licensed Software and Confidential Information 
have been destroyed. Notwithstanding any termination of this Agreement, the follow-
ing provisions of this Agreement shall survive for the relevant period of time set forth 
therein, if any: Sections 2.2, 4.1, 4.2, and 6.

4. REPRESENTATIONS, DISCLAIMER AND LIMITATION OF LIABILITY

4.1      Haivision Warranty.
                   (a)      Haivision warrants that the Licensed Software will operate 
substantially in accordance with the Reference Manuals provided for a term of 
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ninety (90) days (the “Warranty Period”) after its delivery date. As Your sole 
and exclusive remedy for any breach of this warranty, Haivision will use its 
commercially reasonable efforts to correct any failure of the Licensed Soft-
ware to operate substantially in accordance with the Reference Manuals which 
is not the result of any improper or unauthorized operation of the License Soft-
ware and that is timely reported by You to Haivision in writing within the War-
ranty Period, provided that in lieu of initiating commercially reasonable efforts 
to correct any such breach, Haivision may, in its absolute discretion, either (i) 
replace the Licensed Software with other software or technology which sub-
stantially conforms to the Reference Manuals or (ii) refund to You a portion 
of the fee paid for the relevant Product, whereupon this Agreement shall ter-
minate. This warranty shall immediately terminate if You or any third party 
makes or attempts to make any modification of any kind whatsoever to the Li-
censed Software.
                   (b)      All proprietary Hardware, if any, will be subject to the then 
current warranty terms of Haivision. All non-proprietary Hardware, if any, is 
sold “AS IS”; however, to the extent that Haivision has the legal right to do so, 
Haivision hereby transfers to You any and all warranties made by Haivision's 
vendors to Haivision with respect to such non-proprietary Hardware which 
was sold by Haivision or the Reseller to You, provided that You expressly ac-
knowledge and agree that Haivision disclaims any and all liability in connec-
tion with any such non-proprietary Hardware, as set forth in Section 4.2(b) of 
this Agreement.

Warranty Disclaimers.

4.2      Warranty Disclaimers.
                   (a)      THE EXPRESS WARRANTIES SET FORTH IN SEC-
TION 4.1(a) ABOVE IN RESPECT OF THE LICENSED SOFTWARE ARE 
IN LIEU OF ALL OTHER WARRANTIES, WHETHER EXPRESS OR IM-
PLIED, OR STATUTORY, REGARDING THE LICENSED SOFTWARE, 
OR ITS OPERATION, FUNCTIONALITY, PERFORMANCE, MER-
CHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE, IN-
CLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT 
OF THIRD PARTY RIGHTS (ALL OF WHICH ARE DISCLAIMED). 
HaiVision does not warrant that any of the Licensed Software will meet all of 
YOUR needs or requirements, or that the use of any of the Licensed Software 
will be uninterrupted or error-free, OR THAT ALL ERRORS WILL BE DE-
TECTED OR CORRECTED.
                   (b)      THE EXPRESS WARRANTIES SET FORTH IN HAIVI-
SION’S WARRANTY TERMS IN RESPECT OF HAIVISION PROPRI-
ETARY HARDWARE ARE IN LIEU OF ALL OTHER WARRANTIES, 
WHETHER EXPRESS OR IMPLIED, OR STATUTORY, REGARDING 
ANY SUCH PROPRIETARY HARDWARE, OR ITS OPERATION, FUNC-
TIONALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS 
FOR ANY PARTICULAR PURPOSE, INCLUDING ANY IMPLIED WAR-
RANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
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PURPOSE. ALL NON-PROPRIETARY HARDWARE SOLD BY HAIVI-
SION OR THE RESELLER TO YOU IS SOLD “AS IS” EXCEPT FOR 
HAIVISION’S AGREEMENT TO TRANSFER TO YOU ANY WARRAN-
TY GIVEN TO IT BY ANY VENDOR FROM WHOM SUCH HARDWARE 
WAS PURCHASED FOR RESALE TO YOU HEREUNDER IN ACCOR-
DANCE WITH THE PROVISIONS OF SECTION 4.1(b), AND HAIVISION 
DISCLAIMS ALL OTHER WARRANTIES, WHETHER EXPRESS OR IM-
PLIED, OR STATUTORY, REGARDING ANY SUCH NON-PROPRI-
ETARY HARDWARE, OR ITS OPERATION, FUNCTIONALITY, 
PERFORMANCE, MERCHANTABILITY OR FITNESS FOR A PARTIC-
ULAR PURPOSE, INCLUDING ANY IMPLIED WARRANTIES OF MER-
CHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

4.2      Liability Limitation.
                  (a)      IN NO EVENT SHALL HAIVISION OR ITS OFFICERS, 
EMPLOYEES, AGENTS, REPRESENTATIVES, MEMBERS OF HAIVI-
SION, NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CRE-
ATION, PRODUCTION OR DELIVERY OF THE LICENSED 
SOFTWARE, BE LIABLE TO YOU, YOUR CUSTOMERS OR TO ANY 
OTHER THIRD PARTY FOR CONSEQUENTIAL, INDIRECT, INCIDEN-
TAL OR SPECIAL DAMAGES, LOST PROFITS, LOSS OF USE, INTER-
RUPTION OF BUSINESS OR FOR ANY DAMAGES FOR ANY BREACH 
OF THE TERMS OF THIS AGREEMENT OR FOR LOST OR CORRUPT-
ED DATA ARISING FROM ANY CLAIM OR ACTION HEREUNDER, 
BASED ON CONTRACT, TORT OR OTHER LEGAL THEORY AND 
WHETHER OR NOT SUCH PARTY HAS BEEN ADVISED OF THE POS-
SIBILITY OF SUCH DAMAGES. HAIVISION SHALL NOT BE LIABLE 
FOR DAMAGES FOR ANY CAUSE WHATSOEVER IN AN AMOUNT IN 
EXCESS OF THE FEE PAID TO HAIVISION BY YOU FOR THE RELE-
VANT PRODUCT.

5. INDEMNIFICATION

5.1      Indemnification by Haivision.
                   (a)      Haivision shall indemnify and hold You harmless against 
any and all actions, claims, losses, damages, liabilities, awards, costs and ex-
penses (including reasonable attorneys’ fees) (“Claims”) arising out of i) any 
accusation or purported violation of any third person’s US and copyright, 
trademark, patent rights or trade secrets, proprietary information on account of 
Your use of the Licensed Software when used in accordance with the terms of 
this Agreement, or (ii) relating to or arising out of any negligence or wilful 
misconduct on the part of Haivision or any breach by Haivision of the terms 
of this Agreement or any Maintenance and Support Agreement, or applicable 
law. You shall promptly notify Haivision in writing of any such Claim and 
promptly tender the control of the defense and settlement of any such Claim to 
Haivision. Haivision shall thereafter undertake the defense of any such Claim 
using counsel of its choice. You shall cooperate with Haivision, in defending 
or settling such Claim at the expense of Haivision; provided that Haivision 
CoolSign Network Manager User’s Guide, Version 5.1, Issue 01 397



F. Warranty Information 
Haivision Network Video End User Software License Agreement
shall not settle any Claim against You which would require the payment of 
money by You without the prior written consent of You, which consent shall 
not be unreasonably withheld. You shall have the right to consult and provide 
input into the defense with counsel of its choice at its own expense. Haivision 
shall not reimburse You for any expenses incurred by You without the prior 
written approval of Haivision, which approval shall not be unreasonably with-
held.
                   (b)      If any Licensed Software is, or in the opinion of Haivision 
may become, the subject of any Claim for infringement, then Haivision may, 
or if it is adjudicatively determined that any of the Licensed Software infringes 
in the manner described above (except to the extent that any translation, mod-
ification, addition or deletion or combination by You is the sole source of such 
Claim), then Haivision shall, at its option, either (i) procure for You the right 
to continue use of the Licensed Software for the term hereof, (ii) replace or 
modify the Licensed Software with other suitable and reasonably equivalent 
products so that the Licensed Software becomes non-infringing, or (iii) termi-
nate this Agreement and refund to You a portion of the fee paid for the relevant 
Product.
                   (c)      Haivision shall have no liability for: (i) the use of other than 
the then current release of the Licensed Software; (ii) the use of the Licensed 
Software other than as set forth in its accompanying documentation and as per-
mitted herein; (iii) the modification of any of the Licensed Software by any 
party other than Haivision; or (iv) any infringement arising from the use of any 
Licensed Software by You after Haivision has issued a written notice to You 
requiring You to cease using such Licensed Software when Haivision exercis-
es its option to terminate the License pursuant to Section 3.2 (collectively, 
“Exclusions”). SECTION 5.1 STATES HAIVISION’S ENTIRE OBLIGA-
TION WITH RESPECT TO ANY CLAIM REGARDING THE INTELLEC-
TUAL PROPERTY RIGHTS OF ANY THIRD PARTY.

5.2      Indemnification by You. You shall indemnify and hold Haivision harmless 
against any and all Claims directly or indirectly arising out of, or in any manner what-
soever associated or connected with Your performance, purported performance or non-
performance of its rights and obligations under this Agreement, and against any and all 
Claims incurred by or on behalf of any of the foregoing in the investigation or defense 
of any and all such Claims.

6. OTHER PROVISIONS

6.1      Export and Other Restrictions. This Agreement, and all Your rights and Your 
obligations under this Agreement, are subject to all applicable Canadian and U.S. Gov-
ernment laws and regulations relating to exports including, but not limited to, the U.S. 
Department of Commerce Export Administration Regulations and all administrative 
acts of the U.S. Government thereunder. In the event the Licensed Software or the 
Hardware is exported from the United States or re-exported from a foreign destination, 
You shall ensure that the distribution and export/re-export of the Licensed Software or 
the Hardware is in compliance with all laws, regulations, orders, or other restrictions 
of the U.S. Export Administration Regulations. You agree that neither it nor any of its 
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Affiliates will export/re-export any Licensed Software, Hardware, technical data, pro-
cess, Products, or service, directly or indirectly, to any country for which the Canadian 
government or United States government (or any agency thereof) requires an export 
license, other governmental approval, or letter of assurance, without first obtaining 
such license, approval or letter.
6.2      Publicity. Neither party shall make or authorize or permit any other person to 
make any announcement or other like statement concerning this Agreement or the sub-
ject matter, terms or conditions hereof, without the other party’s prior written consent.
6.3      Transfer and Assignment. Haivision may assign, sublicense, or transfer this 
Agreement and/or any or all of its rights or obligations hereunder. You may not assign, 
transfer or delegate any of its rights or obligations hereunder (whether by operation of 
law or otherwise) without the prior written consent of Haivision. Any unauthorized as-
signment, transfer or delegation by You shall be null and void. No other Person shall 
have or acquire any right under or by virtue of this Agreement.
6.4      Waiver and Amendment. No modification, amendment or waiver of any provi-
sion of this Agreement shall be effective. No failure or delay by either party in exer-
cising any right, power or remedy under this Agreement, except as specifically 
provided herein, shall operate as a waiver of any such right, power or remedy. Without 
limiting the foregoing, any terms and conditions of the Entitlement or similar materials 
submitted by either party to the other shall be of no force or effect.
6.5      Enforcement by Third Party. For any Licensed Software licensed by Haivision 
from other suppliers, the applicable supplier is a third party beneficiary of this Agree-
ment with the right to enforce directly the obligations set forth in this Agreement 
against You.
6.6      Governing Law. This Agreement shall be governed by and construed in accor-
dance with the laws of the Province of Québec, Canada and the Laws of Canada appli-
cable therein (excluding any conflict of laws rule or principle, foreign or domestic).
6.7      Severability. If any provision of this Agreement is held by a court of competent 
jurisdiction to be contrary to law, such provision shall be changed and interpreted so 
as to best accomplish the objectives of the original provision to the fullest extent al-
lowed by law and the remaining provisions of this Agreement shall remain in full force 
and effect.
6.8      Force Majeure. Neither party shall be liable to the other party for any failure or 
delay in performance to the extent that such delay or failure is caused by fire, flood, 
explosion, war, terrorism, embargo, government requirement, labor problems, export 
controls, failure of utilities, civil or military authority, act of God, act or omission of 
carriers or other similar causes beyond its control. If any such event of force majeure 
occurs, the party delayed or unable to perform shall give immediate notice to the other 
party, and the party affected by the other's delay or inability to perform may elect, at 
its sole discretion, to terminate this Agreement or resume performance once the con-
dition ceases, with an option in the affected party to extend the period of this Agree-
ment up to the length of time the condition endured. Unless written notice is given 
within 30 calendar days after the affected party is notified of the condition, the latter 
option shall be deemed selected. During an event of force majeure, the affected party 
shall exercise reasonable effort to mitigate the effect of the event of force majeure.
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F. Warranty Information 
Haivision Network Video End User Software License Agreement
If you have questions, please contact Haivision Systems Inc., 4445 Garand, Montréal, 
Québec, H4R 2H9 Canada.
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